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PREFACE

Every effort has been made to ensure that the information in this document is complete,
accurate, and up-to-date. The manufacturer assumes no responsibility for the results of
errors beyond its control. The manufacturer also cannot guarantee that changes in software
and equipment made by other manufacturers and referred to in this guide will not affect
the applicability of the information in it. Mention of software products manufactured by
other companies does not necessarily constitute endorsement by the manufacturer.

While all reasonable efforts have been made to make this document as accurate and helpful
as possible, we make no warranty of any kind, expressed or implied, as to the accuracy or
completeness of the information contained herein.

The most up-to-date drivers and manuals are available from:
http:/ /www.okiprintingsolutions.com

© 2012 Oki Data Corporation All rights reserved.

OKI is a registered trademark of Oki Electric Industry Co., Ltd.

Energy Star is a trademark of the United States Environmental Protection Agency.
Microsoft, MS-DOS and Windows are registered trademarks of Microsoft Corporation.
Apple, Macintosh, Mac and Mac OS are registered trademarks of Apple Inc.

Other product names and brand names are registered trademarks or trademarks of their
proprietors.

AirPrint™
AirPrint logo™
iPad®

iPhone®
iPod®

iPod touch®

iPad, iPhone, iPod, and iPod touch are trademarks of Apple Inc., registered in
the U.S. and other countries. AirPrint and the AirPrint logo are trademarks of
Apple Inc.
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NOTES, CAUTIONS AND WARNINGS

NOTE
A note provides additional information to supplement the main text.

CAUTION!

A caution provides additional information which, if ignored, may
result in equipment malfunction or damage.

A warning provides additional information which, if ignored, may
result in a risk of personal injury.
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ABOUT THIS GUIDE

NOTE
Images used in this manual may include optional features that your product
does not have installed.

DOCUMENTATION SUITE

This guide is part of a suite of online and printed documentation provided to help you
become familiar with your product and to make the best use of its many powerful features.
The documentation is summarised below for reference and is found on the manuals DVD
unless indicated otherwise:

>

Installation Safety booklet: provides information for safe use of your product.

This is a paper document that is packaged with the product and should be read before
setting up your machine.

Set-up guide: describes how to unpack, connect and turn on your product.
This is a paper document that is packaged with the product.

User’s Guide: helps you become familiar with your product and make the best use
of its many features. Also included are guidelines for troubleshooting and
maintenance to ensure that it performs at its best. Additionally, information is
provided for adding optional accessories as your printing needs evolve.

Configuration Guide: provides machine, fax and network configuration
information.

Printing Guide: helps you become familiar with the many features of the driver
software supplied with your product.

Barcode Printing Guide: helps you become familiar with your product’s built in
barcode printing feature.

Security Guide: helps you become familiar with your product’s security features.

Installation Guides: accompany consumable items and optional accessories to
describe how to install them.

These are paper documents that are packaged with the consumables and optional
accessories.

On-line Help: on-line information accessible from the printer driver and utility
software.

PURPOSE OF THIS GUIDE

The purpose of this guide is to provide you with in-depth information on how configure the
network, scan and fax for your machine.
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ON-LINE USAGE

This guide is intended to be read on screen using Adobe Reader. Use the navigation and
viewing tools provided in Adobe Reader.

There are many cross-references within this book, each highlighted as blue text. When you
click on a cross-reference the display will instantly jump to the part of the manual
containing the referenced material.

By using the @ button in Adobe Reader, you can navigate directly back to where you were
before.

You can access specific information in two ways:

> In the list of bookmarks down the left hand side of your screen, click on the topic of
interest to jump to the required topic. (If the bookmarks are not available, use the
"Contents" on page 3.)

> In the list of bookmarks, click on Index to jump to the Index. (If the bookmarks are
not available, use the "Contents" on page 3.) Find the term of interest in the
alphabetically arranged index and click on the associated page number to jump to
the page containing the term.

PRINTING PAGES

The whole manual, individual pages, or sections may be printed. The procedure is:
1. From the toolbar, select File > Print (or press the Ctrl + P keys).
2. Choose which pages you wish to print:

(a) All pages, (1), for the entire manual.

(b) Current page, (2), for the page at which you are looking.

Print 2]
~ Printer
Nome: [ | Eroperies
Status:  Ready I Reverse pages
Type: I~ Print as image
Where:  LPTI I~ Printto file
~Pint Rang Capies and Adjusiments
1 — < ai228 pages £ 5electedpages/granhic Nurmber of copies: =]
2— .r Current page
33— Pages from:[1 to [226 F Shiink oversized pagesto paper size
- )
Print [Evenand Odd Pages ¥ Expand small pages 1o paper size
M Autocrotate and center pages
¥ Camments
~ PostScript Optio Erovien P —
PrintMethod: | Language Level 3 = T e
¥ Optimize for Speed 1158 ;
I Download Asian Fonts I Save Printer Memony s
Color Managed:  On printer -
Units: Inches  Zoom: 141.4%

(c) Pages from and to, (3), for the range of pages you specify by entering their
page numbers.

(d) Click OK.
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CONFIGURING THE NETWORK SETTINGS

Functions such as Scan To E-mail, Scan To Shared Folder and Internet Fax enable you to
send scanned data to a computer via the network connection. To use them, you need to
set up your machine and the computer to which you want to send scanned data.

First check your computer settings and fill in the information in the Your Value column of
the "Setup Information Form," on page 9. Then, configure your machine and the computer
using the information in Your Value.

NOTE
Be sure to set up the network connection before continuing. Refer to the Setup
Guide supplied with the machine.

Table 1: Setup Information Form

) [o 8 ITEM EXAMPLE YOUR VALUE
Common Setup Information
A-1 Administrator password for your machine | aaaaaa
A-2 IP address of your machine 192.168.0.2
Setup Information Required for Scan To Email and Internet Fax
B-1 Email address for your machine mc562@test.com
(Up to 80 characters)
B-2 SMTP server address smtp.test.com
B-3 POP3 server address pop3.test.com
B-4 Receive Settings
B-5 Authentication method SMTP
B-6 SMTP user ID OKIMC562
B-7 SMTP password okimc562
B-8 POP user ID user
B-9 POP password okimc562
B-10 Name of the email destination User
B-11 Email address of the email destination user@test.com
Setup Information Required for Scan To Shared Folder
C-1 Name of the destination computer PC1
C-2 User name to log into the destination mc562
computer (Up to 32 characters)
C-3 Password to log into the destination mc562
computer (Up to 32 characters)
Cc-4 Profile name to register the settings Sales
(Up to 16 characters)
C-5 Shared folder name on the destination SalesDev
computer (Up to 64 characters)
C-6 File name of the scanned data ScanData
(Up to 64 characters)
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CHECKING THE COMMON SETUP INFORMATION

Check the common setup information for Scan To E-mail, Scan To Shared Folder and
Internet Fax, and fill in the corresponding column in the "Setup Information Form," on
page 9.

Administrator password

Enter the administrator password of your machine in the "Setup Information Form," on page 9.

NOTE
The default administrator password is “"aaaaaa”.

Passwords are case sensitive.

IP address of your machine
1. Press the SETTING key on the control panel.

2. Using the Down arrow key, scroll to view Information and press OK.

-

Network Scan Destination

Store Document Settings .

View Information [

w
Easy Setup

3. Using the Down arrow key, scroll to Network and press OK.

4. Note the IpPv4 address in the "Setup Information Form," on page 9.

CONNECTING USING WIRELESS LAN (MC342dw, MC362w, MC562w,
MC562dw, ES5462dw MFP, MPS2731mc ONLY)

CONFIGURING AUTOMATICALLY USING PUSH-BUTTON METHOD
Use the WPS (push button) function to set the wireless LAN.
1. Log in as the administrator.

2. Press the ¥ to select Network Menu, and then press the P .

Admin Setup
ry

-
Network Menu
Management

User Install

3. Pressthe ¥ to select Network Setup, and then press the P .

ddmin Setup/Netwark Menu

Hetwork Setup [ 3

-

Mail Server Setup
LDAP Server Setting

Secure Protocol Server Setting
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Press the ¥ to select Wireless Setting, and then press the ».

4.
ddmin SetupfNetwork MenufWetwork Setup
Network Setting [ 2
Wireless Setting M
Factory Defaults
5. Press the ¥ to select Automatic setup (WPS), and then press the P .
Bllireless Setting
Set the wireless communications.
Automatic setup (WPS) >
Wireless Network Selection v
feturn to @ menu
6. Pressthe ¥ to select WPS-PBC, and then press OK.

Bllirelezs Setting

Select the WPS implementation method.

WPS-PBC b

WPS-PIN

®Previouz mahlet

7. Press the 4 to select Yes, and then press OK.

Execute push-button method?

MEMO
> If Yes is selected in step 7, Running pushbutton method... is displayed

in the screen.

Running pushbutton method...

> If No is selected, the screen returns to that from step 6.
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8. Start the WPS push button for wireless AP after clicking Yes in step 7.

NOTE
> Panel operations cannot be performed during WPS execution.

> When WPS connection successful is displayed, this equipment is
connected to the wireless LAN.

> Alternatively, if WPS push button for wireless AP is started first, start the
WPS push button on this equipment.

WPS connection successful.
Wired communications disabled.

MEMO

> If Timeout is displayed, it is possible that the wireless AP of the connection
destination could not be found within the time limit. Select Yes again in step
7 within 2 minutes of starting WPS push button for wireless AP.

> If Overlap is displayed, WPS-push button is being executed on 2 or more
wireless AP. Please wait for a short time and then retry.

CONFIGURING AUTOMATICALLY USING PIN METHOD

1. Log in as the administrator.

2. Press the ¥ to select Network Menu, and then press the b .

s

Hetwork Menu M
Management

User Install

3. Press the ¥ to select Network Setup, and then press the ».

ddmin SetupdMetwork Menu

Hetwork Setup [ 3

-

Mail Server Setup
LDAP Server Setting

Secure Protocol Server Setting
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4. Press the ¥ to select Wireless Setting, and then press the ».

fletwork Menufetwo

Network Setting [ 2

- - v
Wireless Setting

Factory Defaults

5. Press the ¥ to select Automatic setup (WPS), and then press the ».

Bllirelezs Setting

Set the wireless communications.

Wireless Network Selection M

Automatic setup (WPS) [ 2 H

Feturn to @ menu

6. Press the ¥ to select WPS-PIN, and then press OK.

Blilireless Setting

Select the WPS implementation method.

WPS-PBC .

WPS-PIN o

®EPrevious @ ext

7. Press the 4« to select Yes, and then press OK.

Implementing PIN method?
PIN code: 75366407

MEMO
> If Yes is selected in step 7, Implementing PIN method... is displayed in
the screen.

Implementing PIN method...
PIN code: 75366407

> If No is selected, the screen returns to that from step 6. Each time the
confirmation screen is displayed, the PIN code is automatically generated
and changed.
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8. Enter the displayed 8 character PIN code to the wireless AP, and start WPS-PIN for
the wireless AP.

NOTE
> Panel operations cannot be performed during WPS execution.

> When WPS connection successful is displayed, this equipment is
connected to the wireless LAN.

> Alternatively, if WPS-PIN for wireless AP is started first, start the WPS-PIN
on this equipment.

WPS connection successful.
Wired communications disabled.

MEMO

If Timeout is displayed, it is possible that the wireless AP of the connection
destination could not be found within the time limit. After entering the PIN
code from this equipment into the wireless AP and starting WPS-PIN, select
Yes in step 7 again within 2 minutes.

CONFIGURING WIRELESS NETWORK SELECTION

1. Log in as the administrator.

2. Press the V¥ to select Network Menu, and then press the P .

Admin Setup
ry

e
Network Menu
Management

User Install

3. Pressthe V¥ to select Network Setup, and then press the P .

Hetwork Setup [ 3

-

Mail Server Setup
LDAP Server Setting

Secure Protocol Server Setting
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Press the ¥ to select Wireless Setting, and then press the ».

4.
Hetwork Setting -
Wireless Setting M
Factory Defaults
5. Pressthe V¥ to select Wireless Network Selection, and then press the ».
Blilireless Setting
Set the wireless communications.
Automatic setup (WPS) .
Wireless Metwork Selection [
w

Feturn to & menu

6. The product starts to search the wireless access point.

Scanning ...

A list of access points found by the search will be displayed. Select the access point

7.
you wish to connect to using the A V¥ keys, then press OK.

Blilireless Setting

Select the wireless network.

AirMac-123 > H

ABCDEFG-7890

®EPrevious @BEnter
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8.

Enter the security password of the selected access point.
(1) With WEP

Enter the WEP key will be displayed. Enter the encryption key using the A ¥V P
4 keys, and press OK.

Enter the WEP kew. 026
B./\v-+a
q w r t vyu
a d fTghj
v b nm

Go to Section 9
(2) With WPA-PSK or WPA2-PSK

Enter the Pre-shared key will be displayed. Enter the encryption key using the A
V¥V P> 4 keys, and press OK.

Enter the Pre-shared Key. /64
L |
E. /

qw e
a

£ = | -

Go to Section 9
(3) With WPA-EAP or WPA2-EAP

Configure settings from Web Page.

To make this setting, make the
changes from the web page.

TR T il T A

(4) With Disable

The password input screen will not be displayed. Go to Section 9.

In the confirmation screen, please check the contents on the confirmation screen,
select Yes, and press OK.

Use this setting to connect to
wireless communications?

SSID: 1b4k
Security: WEP
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10. Connection successful will be displayed once you have successfully connected to the
wireless LAN.

Connection successful.
Wired communications disabled.

MEMO
> If unable to connect to a wireless LAN, Connection failed will be displayed
and you will be returned to the Wireless Settings screen in Section 5.

CONFIGURING MANUALLY

1. Log in as the administrator.

2. Press the ¥ to select Network Menu, and then press the ».

w
Network Menu

Management

User Install

3. Pressthe V¥ to select Network Setup, and then press the .

fdmin Setup/Netwark Menu

Network Setup 2
w

Mail Server Setup
LDAP Server Setting

Secure Protocol Server Setting

4. Press the V¥ to select Wireless Setting, and then press the P.

ddmin SetupfMetwork MenudMetwork Setup

Hetwork Setting [ 3
b

Wireless Setting
Factory Defaults
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5. Press the ¥ to select Wireless Network Selection, and then press the ».

Set the wireless communications.

Automatic setup (WPS) .
Wireless Hetwork Selection [

Return to @ menu

6. The product starts to search the wireless access point.

Scanning ...

7. Alist of access points found by the search will be displayed. With the OK key, select
Manual Setup, which will be displayed at the very bottom.

Bllireles

Select the wireless network.

ABCDEFG-7890 .
Manual Setup [ 3

®EPreviouz @mEnter

8. Press the ¥ to select SSID, and then press the P.

Bllirelezs Setting

Enter the S5ID.

®EPreviouz amhlext

MEMO

> When the OK button is pressed, the screen switches to the security settings
screen in step 5 without switching to the screen in step 6. If the SSID is not
set, a warning screen is displayed.

9. Enter the SSID name (within 1-32 characters) of the wireless AP that you want to connect to.
After entering the SSID, move the cursor to the Done field and press OK.

Enter the 5510 032
€ 11 +u
qwertyu

asdfghj
zxcvybnm
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10.

11.

In the security settings screen, select the same security setting as the wireless AP
that you want to connect to.

Bllirelezs Setting

Set the security.

o —

WEP

®Previouz @mEnter

Bllirelezs Setting

Set the security.

WPA-PSK H

WPAZ-PSK

®Previouz @mEnter

MEMO
> The default is Disable.

> Depending on the model of wireless AP, mixed WPA-PSK/WPA2-PSK may be
supported. In this case, we recommend using WPA2-PSK.

NOTE
Security settings (WPA-EAP/WPA2-EAP) using an authentication server are
also supported, but this can only be set from the Web. For details, see the

Advanced section of the User Manual.

Depending on the security setting selected in step 8, execute the settings from
either (1) or (2) below. If Disable is selected, proceed to step 10. (For security
reasons, we do not recommend setting Disable.)

(1) When WEP is selected:
a) Press the P on the WEP KEY input screen.

Dllirelezs Setting

Enter the WEP key.

®EPreviouz mhlext

MEMO
Nothing is set by default. If the WEP KEY is already set, it is displayed using

"*" symbols. When the OK button is pressed, the screen switches to the
screen in step 10 without switching to the screen in step b). If the right button
is pressed to switch to the screen in step b) when a WEP KEY is set, the set

KEY is cleared.
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NOTE
There is not setting for the WEP KEY index. The WEP KEY index
communications with the wireless AP as 1.

b) Enter the same KEY as the WEP KEY set for the wireless AP that you want to connect to.
After entering the WEP KEY, move the cursor to the Done field and press OK.

Enter the WEF kew. 0f26
B./\v-+# = )
quwertyu
asdfgh i
zxcybnm
MEMO
After entering the KEY, the key is displayed as "*" symbols for security
reasons.

(2) When WPA-PSK or WPA2-PSK is selected:

a) Press the ¥ to select the encryption type, and then press OK.

Bllirelezs Setting

Set the encryption type.

* TKIP

AES M

®Previouz @mEnter

MEMO
e The default is TKIP.

e Depending on the model of wireless AP, the mixed TKIP/AES may be
supported. In this case, we recommend using AES.

b) Press the P on the Pre-shared KEY input screen.

Blilireless Setting

Enter the Pre—shared Key.

®EPrevious @mEnter

MEMO

Nothing is set by default. If a Pre-shared KEY is already set, "*" is displayed.
When the OK button is pressed, the screen switches to that shown in step 10
without switching to the screen shown in step c). If the right button is pressed
to switch to step c) when a Pre-shared KEY is set, the set KEY is cleared.
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¢) Enter the same KEY as the Pre-shared KEY set for the wireless AP that you want

to connect to.
After entering the Pre-shared KEY, move the cursor to the Done field and press

OK.

Enter the Pre-shared Kew. 0564
B./\v-+# =
qwer t yu
asdfohj
Zxcvybnonm

MEMO

After entering the KEY, the key is displayed as "*" symbols for security

reasons

12. 1In the confirmation screen, check the entered SSID and selected security settings.
If there are no problems, press the 4« to select Yes, and then press OK.

Use this setting to connect to
wireless communications?
551D: default

Security: WPA-PSK(TKIP)

13. If Yes is selected in step 10, Searching for connection... is displayed in the
screen.

Searching for connection...

When Connection successful is displayed, this equipment is connected to the
wireless LAN.

Connection successful.
Wired communications disabled.

MEMO

If Timeout is displayed, the connection destination wireless AP may not have
been found within the specified time. Check the SSID, security settings, and
KEY settings, and retry.
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RECONNECT TO THE WIRELESS LAN

When the wireless is enabled, restart the wireless function. If a problem has occurred in
the wireless AP communication or performance, the wireless function can be restarted.

(If the wired is enabled, the wireless function is enabled with the configured wireless
settings.)

1. Log in as the administrator.

2. Press the V¥ to select Network Menu, and then press the P .

Sdmin Setup

s

w
Network Menu

Management

User Install

3. Pressthe ¥ to select Network Setup, and then press the P .

fdmin Setup/Netwark Menu

Network Setup [ 2
w

Mail Server Setup
LDAP Server Setting

Secure Protocol Server Setting

B

Press the ¥ to select Wireless Setting, and then press the ».

fdmin SetupfNetwark MenudMetwork Setup

Network Setting [ 2
w

Wireless Setting
Factory Defaults

5. Press the ¥ to select Wireless reconnection, and then press OK.

Fs

Wireless reconnection [

Return to @ menu

Manual Setup |i|
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6. Press the « to select Yes, and then press OK.

Reconnect wireless communications?

7. When Yes is selected in step 6, Searching for connection... is displayed in the
screen.

Searching for connection...

After this, Connection successful is displayed, and the wireless LAN can be used on
this equipment.

Connection successful.
Wired communications disabled.

MEMO

If A Timeout occurred. is displayed, the connection destination wireless AP
may not have been found within the required time. The SSID, security
settings, and KEY need to be configured to match the wireless AP settings.
Check each of the settings. For details on each of the setting items, see "Using
the wireless LAN".

SWITCHING FROM WIRELESS TO WIRED

The network connection can be switched from wireless to wired.

1. Log in as the administrator.

2. Press the ¥ to select Network Menu, and then press the ».

Admin Setup
s

b
Network Menu
Management

User Install
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3. Pressthe ¥ to select Network Setup, and then press the ».

fdmin Setup/Netwark Menu

Network Setup B

-

Mail Server Setup
LDAP Server Setting

Secure Protocol Server Setting

4. Press the ¥ to select Enabling Wired Communications, and then press OK.

fdmin SetupfNetwark MenudMetwork Setup

Network Setting

Wireless Setting e

Enabling Wired Communications [ 3

b
Factory Defaults

5. Press the 4 to select Yes, and then press OK.

Enable wired communications?

SETTING UP SCAN TO E-MAIL AND INTERNET FAX

The Scan To E-mail and Internet Fax functions enable you to send scanned images as a file
attachment in an E-mail to the specified E-mail address on the network. To use these
functions, set up the E-mail setting for your machine.

CHECKING THE E-MAIL SETTINGS OF THE COMPUTER

If a network administrator specifies the values such as a mail server account, password and
email address for your machine, note them in the "Setup Information Form," on page 9,
otherwise follow the procedure below.

NOTE
The procedure below uses Windows Live Mail on Windows 7. If you are using
different email software, refer to the manual for the email software.

Click Start > Windows Live Mail.
From the drop-down menu, select Tools > Accounts.

If the menu bar is not displayed, click the Menus icon and then select Show menu
bar.

3. Select the default mail account and then click Properties.
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4. On the General tab, note the Name and E-mail address in the "Setup Information
Form," on page 9.

-
) pop3testcom Properties @

General |Senrers I Connection I Security I Mvanced|

Mail Accourt

=M Type the name by which you would like to refer to these
; | servers. Forexample: "Work" or "Windows Live
Hotmail".

User Information

Name: Uszer B-9
Crganization:

E-mail address:  user@testcom B-10
Reply address

Include this account when receiving mail or synchronizing

[

5. Click the Server tab, and then note each of the settings as shown:
f, pop3.testcom Properties @‘

| General | Servers |Cnnnedinr1 I Security I Advanced |

Server Information

My incoming mail serverisa POP2 senver.
Incoming mail (POP3):  pop3testcom B-3
Cutgoing mail (SMTF):  smtptestcom B-2

Incoming Mail Server

E-mail usemame: uger B-7

Password: B-8
Remember password
@ Log on using clear text authertication

(@) Log on using secure password authentication
(@ Log on using authenticated POP (APOP)

Outgoing Mail Server

Wy server requires authentication

o) G ) o)

If My server requires authentication is selected, enter "SMTP".
If it is not selected, enter “"POP".
6. Select My server requires authentication and then click Settings.

7. Refer to the Outgoing Mail Server dialog box, and note the settings in the "Setup

Information Form," on page 9.
rDutgﬂingMaMSeNer - Iﬁ‘

Logon Irformation
(@ Use same settings as my incoming mail server
() Log on using

B-5

B-6

Remember password

Log on using Secure Password Authentication

If Use the same settings as my incoming mail server is selected, enter the same
values as above.

If Log on using is selected, note the Account name and Password.
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SETTING THE E-MAIL ADDRESS FOR YOUR MACHINE

Enter an E-mail address to be used by your machine in the "Setup Information Form," on
page 9.

> If the E-mail address for your machine is specified by the network administrator,
enter the email address in B-1.

> If you are using an Internet Service Provider, obtain an E-mail address for your
machine from the provider and then enter the E-mail address in B-1.

> If the E-mail address for your machine is neither specified nor obtained, determine
the E-mail address according to the value you entered in authentication method:

> If authentication method is "SMTP”, determine an E-mail address and enter it
in B-1.

> If authentication method is "POP”, enter the same E-mail address as B-12 in
B-1.

NOTE

If you want your machine to receive E-mail, you must obtain an E-mail
address for your machine from a network administrator or your Internet
Service Provider.
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CONFIGURING YOUR MACHINE FOR SCAN TO E-MAIL AND INTERNET FAX

Set up your machine for Scan To E-mail and Internet Fax using the information in the
"Setup Information Form," on page 9.

1.

10.

11.

12,
13.

14.
15.

16.
17.

18.
19.

20.
21.

Press the SETTING button on the control panel.
Using the Down arrow key, scroll to Easy Setup and press OK.

Using the arrow keys and on-screen keypad, enter the Administrator password.
Highlight Enter and press OK.

NOTE
The default password is "aaaaaa”.

Using the Down arrow key, scroll to E-mail Setting and then press the Right
arrow key.

Press the Right arrow key, then enter the SMTP server address (B-2) using the
arrow keys and on-screen keypad.

Highlight Enter and then press OK.

Press the Right arrow key, then enter the E-mail address for your machine (B-
1) using the arrow keys and on-screen keypad.

Highlight Enter and then press OK.

Select a protocol for the Receive Settings (B-4) by using the Up or Down arrow
keys and then press OK.

Select an authentication method (B-5) by using the Up or Down arrow keys and
then press OK.

Press the Right arrow key, then enter the SMTP user ID (B-6) using the arrow
keys and on-screen keypad.

Highlight Enter and then press OK.

Press the Right arrow key, then enter the SMTP password (B-7) using the arrow
keys and on-screen keypad.

Highlight Enter and then press OK.

Press the Right arrow key, then enter the POP-3 server address (B-3) using the
arrow keys and on-screen keypad.

Highlight Enter and then press OK.

Press the Right arrow key, then enter the POP-3 user ID (B-8) using the arrow
keys and on-screen keypad.

Highlight Enter and then press OK.

Press the Right arrow key, then enter the POP password (B-9) using the arrow
keys and on-screen keypad.

Highlight Enter and then press OK.
When the setup menu screen is displayed, press OK.

The setup for Scan To E-mail and Internet Fax is complete.
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SETTING UP SCAN TO SHARED FOLDER

The Scan To Shared Folder function enables you to send and save scanned images to the
“shared folder” of a computer on the network. To use this function, register your machine
on the computer as a user and create a shared folder, and then create a profile on your
machine to register the settings for the computer.

NOTE
Before starting the setup, get permission from the network administrator to
create a shared folder on the computer by following the procedure below.

The CIFS protocol is used in this procedure.

CHECKING THE NAME OF THE COMPUTER
Check the name of the computer following the procedure below, and fill in C-1 of the "Setup
Information Form," on page 9.

Windows 8, Windows Server 2012, Windows 7, Windows Server 2008 R2, Windows Server
2008 and Vista

NOTE
The procedure below uses Windows 7 as an example. The display may differ
depending on the operating system.

1. Click Start > Control Panel.
2. Select System and Security.
For Windows Server 2008 and Windows Vista, select System and Maintenance.
3. Click System > See the name of this computer.
4, Note the Computer name in C-1.

o i e |
@‘\:j;v‘:m » Control Panel » System and Security » System - |~‘,| ‘ Search Control Panel pel |
® -
Cantrol Pan=! Hogl View basic information about your computer
) Device Manager Windows edition
) Remote settings Windows 7 Ultimate
) System protection Copyright © 2009 Microsoft Corporation. Al rights reserved.

‘35' Advanced system settings

m

System

Rating: m Windows Experience Index

Processor: Intel(R) Core(TM)2 CPU 6300 @1.86GHz 187 GHz
Installed memory (RAM):  4.00 GB (3.25 GB usable)

System type: 32-bit Operating System

Pen and Touch: MNe Pen or Touch Input is available for this Display

Computer name, domain, and workgroup settings

See also _
Computer name: 200611-002 o Chiapgpe st c-1

Action Center

Windows Update

Full computer name: 200611-002
Computer description:

Workgroup: MC-4TH

Perfarmance Information and
Toals

5. Close the window.
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Windows Server 2003 and Windows XP
1. For Windows Server 2003, click Start > Control Panel > System.

For Windows XP, click Start > Control Panel > Performance and Maintenance >
System.

2. Select the Computer Name tab and then click Change.
3. Note the Computer name in C-1.

4. Click Cancel to close the window.
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DETERMINING THE NAMES OF THE ITEMS REQUIRED FOR SCAN TO SHARED FOLDER

Determine the names of the following items and fill in C-2 to C-6 on the "Setup Information
Form," on page 9.

>

>
>
>
>

User name to log into the destination computer (C-2)
Password to log into the destination computer (C-3)

Profile name to register the settings on your machine (C-4)
Shared folder name on the destination computer (C-5)

File name of the scanned data (C-6)

CONFIGURING THE COMPUTER FOR SCAN TO SHARED FOLDER

Register your machine on the computer as a user and then set up a shared folder to which
scanned images are sent and saved.

NOTE
If the computer is in a domain, the procedure of adding a user account may
be different to the procedure below.

Refer to Windows help.

Windows 8, Windows Server 2012, Windows 7, Windows Server 2008 R2, Windows 2008
and Windows Vista

W N

NOTE
The procedure below uses Windows 7 as an example. The display may differ
depending on the operating system.

Click Start > Control Panel.
Select Add or remove user accounts.
Select Create a new account.

Enter the user name (C-2) in the text box.

@-v-vljz <« User Accounts » Manage Accounts » Create New Account - |4y ‘ | Search Control Panel gl

Name the account and choose an account type

This name will appear on the Welcome screen and on the Start menu.
C-2 mc562

@) Standard user
Standard account users can use most software and change system settings that do not affect other users or
the security of the computer.

) Administrator
Administrators have complete access to the computer and can make any desired changes. Based on
notification settings, administrators may be asked to provide their password or confirmation before
making changes that affect other users,

‘We recommend that you protect every account with a strong password.

Why is a standard account recommended?

Create Account ] | Cancel

Ensure that Standard user is selected, and then click Create Account.
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6. Click the icon of the user account created in step 5.
7. Select Create a password.

8. Enter the password (C-3) in New password and Confirm for new password,
and then click Create password.

4 =T ~

Search Control Panel yel |

@U'HE‘ <« User Accounts » Manage Accounts » Change an Account v Create Password - |$¢‘

Create a password for me562's account

| mc562
Standard user

You are creating a password for me562.

If you do this, mc562 will lose all EFS-encrypted files, personal certificates and stored passwords for Web
sites or network resources.

To aveid lesing data in the future, ask me362 to make a password reset floppy disk.

C-3 New password

Confirm new password
If the password contains capital letters, they must be typed the same way every time.
How to create a strong password

Type a password hint

The password hint will be visible to everyone who uses this computer.

What is a password hint?
[ Create password Cancel

L

9. Close the control panel.
10. Create a new folder on the computer with the shared folder name entered in C-5.

NOTE
It is recommended that you create a folder in the local drive, not on the
desktop or "My Documents”.

11. Right-click the folder created in step 10 and select Properties.

12. Select the Sharing tab and then click Share.
| . SalesDev Properties @1

| General | Sharing |Securi1y I Previous Versions | Customize |

Metwork File and Folder Sharing

SalesDev
| ) NotShared

Networle Path:
Mot Shared

Advanced Sharing

Set custom permissions, create multiple shares, and set other
advanced sharing options.

'5'Advanced Sharing...

Passward Protection

People must have a user account and password for this
computer to access shared folders.

Ta change this setting, use the Network and Sharing Center
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13. Select the user account created in step 5 from the drop down box, then click Add.
[ =)

N, 2% File Sharing

Choose people to share with

Type a name and then click Add, or click the arrow to find someone.

(= S
MName Permission Level
2 0Kl Owner

I'm having trouble sharing

h

14. Select the user added in step 13 and select the permission level, then click Share.
- .

(NS |23 File Sharing

Choose people to share with

Type a name and then click Add, or click the arrow to find someone.

- Add
MName Permission Level
2 oKl Owner
2 mc562 Read/Write » H

I'm having trouble sharing

15. Click Done.
16. Click Advanced Sharing on the Sharing tab.
17. Click Permissions.

r ~
Advanced Sharing M

[#] Share this folder

Settings

Share name:

[SalesDev -

Limit the number of simultaneous users to: 0 =

Comments:
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18. Select the user added in step 13 and select the Allow check box for Full Control,

then click OK.
-
| . Permissions for SalesDev &J
Share Permissions
Group or user names:
52, Everyone
54, Administrators (200611-002\Administrators)
Permissions for Everyone Allow Deny
Ful Cortrol =
Change ¥ =
Read B
Leam about access control and permissions
(OK | D_cancel | [ #eply

19. Close the folder’s property dialog box.

NOTE
Create a profile to complete the setup for Scan To Shared Folder. Refer to
"Creating a profile for Scan to Shared Folder" on page 35.

Windows Server 2003

1. Click Start > Administrative Tools > Server Management.
2. Click Users.
3. Select Add a user.
4. Enter the user name (C-2) in the First name text box and then click Next.
5. Enter the password (C-3) in Password and Confirm password.
6. Select the Cannot change password and then click Next.
7. Click Finish.
8. Click Close.
9. Create a new folder on the computer with the shared folder name entered in C-5.
NOTE
It is recommended that you create a folder in the local drive, not on the
desktop or "My Documents”.
10. Right-click the folder created in step 9, and then select Sharing and Security.
11. On the Sharing tab, select Share this folder and then click Permissions.
12. Click Add.
13. Enter the user name (C-2) and then click Check Names.
14. Check that the user name (C-2) is displayed, and then click OK.
15. Select the Allow check box for Full Control, and then click OK.
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16.

Windows XP
1. Click Start > Control Panel.
2. Double-click User Accounts.
3. Select Create a new account.
4. Enter the user name (C-2) in the text box and click Next.
5. Select Limited and click Create Account.
6. Click the icon of the user account created in step 5.
7. Select Create a password.
8. Enter the password (C-3) in Type a new password and Type the new
password again to confirm, and then click Create Password.
9. Close the control panel.
10. Create a new folder on the computer with the shared folder name entered in C-5.
NOTE
It is recommended that you create a folder in the local drive, not on the
desktop or "My Documents”.
11. Right-click the folder created in step 10, and then select Sharing and Security.
12. Click If you understand the security risks but want to share files without
running the wizard, click here..
NOTE
If a pop-up screen displays, select Share this folder and click Permissions.
Proceed to step 15.
13. Select Share this folder in Windows Firewall, and then click OK.
14. Select the Share this folder on the network and Allow network users to
change my files check box, and then click OK.
15. Select the Allow check box for Full Control, and then click OK.

Close the folder’s property dialog box.

NOTE
Create a profile to complete the setup for Scan To Shared Folder. Refer to
"Creating a profile for Scan to Shared Folder" on page 35.

NOTE
Create a profile to complete the setup for Scan To Shared Folder. Refer to
"Creating a profile for Scan to Shared Folder" on page 35.
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MANAGING PROFILES

CREATING A PROFILE FOR SCAN TO SHARED FOLDER

Register the information you configured on the computer as a profile. It is necessary when
you perform Scan To Shared Folder with the computer.

1. Press the SETTING button on the control panel to prompt the Setting screen.
2 Using the Down arrow key, scroll to profile and press OK.
3. Select the desired profile number.
4 Press the Right arrow key to prompt the Operation Menu screen.
From here you can register or sort profiles.

5. When registering a new profile, press the Right arrow key to prompt the profile
screen.

6. Ensure profile Name: is highlighted then press the Right arrow key.

7. Using the arrow keys and on-screen keypad, enter the information in C-4.

NOTE
MC562dn/MC562w/MC562dw/ES5462 MFP/ES5462dw MFP/MPS2731mc only:
You can also use the gwerty keyboard to enter details.

8. Using the arrow keys, highlight Enter and press OK.
9. Using the Down arrow key, scroll to Target URL then press the Right arrow key.

10. Using the arrow keys and on-screen keypad, enter the name of the destination
computer (C-1) and the shared folder name (C-5) as "\ \name of the
destination computer\shared folder name”.

11. Using the arrow keys, highlight Enter and press OK.
12. Using the Down arrow key, scroll to user Name then press the Right arrow key.

13. Using the arrow keys and on-screen keypad, enter a suitable user name (C-2).

NOTE
If domain management is done, enter "user nhame@domain name”.

14. Using the arrow keys, highlight Enter and press OK.

15. Using the Down arrow key, scroll to password then press the Right arrow key.
16. Using the arrow keys and on-screen keypad, enter a suitable password (C-3).
17. Using the arrow keys, highlight Enter and press OK.

18. Using the Down arrow key, scroll to File Name then press the Right arrow key.

19. Using the arrow keys and on-screen keypad, enter a suitable file name (C-6).

NOTE
You can enter up to 64 characters.

By adding "#n” to the end of the file name, a serial number is automatically
assigned to the end of the name of sent files.

By adding “#d” to the end of the file name, a date is automatically assigned
to the end of the name of sent files.

20. Using the arrow keys, highlight Enter and press OK.
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21. Configure other items if necessary, for example:
\\PC1\SalesDev

22. Press OK to register the settings and save the profile entry.

The setup for Scan To Shared Folder is complete.

DELETING A NETWORK PROFILE

To delete a network profile:

1. Press the SETTING button on the control panel to prompt the Setting screen.
Using the Down arrow key, scroll to profile List and press OK.

Select the desired profile number.

Ensure Delete is highlighted then press the Right arrow key.

w ks wN

At the prompt:
> press OK to continue deleting the profile entry,
or...

> use the Right arrow key to highlight no, then press OK to cancel.
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MANAGING THE ADDRESS BOOK

SETTING SENDER AND REPLY TO E-MAIL ADDRESSES (FROM/REPLY TO)

You can set the E-mail address from which E-mails are sent and the address to which
responses are sent.

1.
2.
3.

©® N O U R

10.

11.
12,

Press the SETTING button.
Using the Down arrow key, scroll to Admin Setup and then press OK.

Using the arrow keys and on-screen keyboard, enter the administrator password.

NOTE
The default password is “"aaaaaa”.

MC562dn/MC562w/MC562dw/ES5462 MFP/ES5462dw MFP/MPS2731mc only:
You can also use the gwerty keyboard to enter details.

Select Enter and then press OK.

Using the Down arrow key, scroll to Scanner Setup and then press OK.
Using the Down arrow key, scroll to E-mail Setup and then press OK.
Using the Down arrow key, scroll to From/Reply to and then press OK.
Using the Down arrow key, scroll to E-mail Sender ID and then press OK.

Using the on-screen keyboard, enter the E-mail address up to 80 characters.

NOTE
MC562dn/MC562w/MC562dw/ES5462 MFP/ES5462dw MFP/MPS2731mc only:
You can also use the gwerty keyboard to enter details.

Select Enter and then press OK.

NOTE
You can select E-mail addresses from the address book.

Using the Down arrow key, scroll to close and then press OK.
Press the RESET/LOGOUT button.
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CREATING E-MAIL TEMPLATES

You can create up to five E-mail templates with various subject lines and body text.

Registering a subject
1. Press the SETTING button.
2. Using the Down arrow key, scroll to Admin Setup and then press OK.

3. Using the arrow keys and on-screen keyboard, enter the administrator password.

NOTE
The default password is "aaaaaa”.

MC562dn/MC562w/MC562dw/ES5462 MFP/ES5462dw MFP/MPS2731mc only:
You can also use the gwerty keyboard to enter details.

Select enter and then press OK.

Using the Down arrow key, scroll to Scanner Setup and then press OK.
Using the Down arrow key, scroll to E-mail Setup and then press OK.
Using the Down arrow key, scroll to Template and then press OK.

Make sure that Edit Subject is selected and then press OK.

 © N wn bk

Using the Down arrow key, select a template entry number and then press OK.

10. Using the on-screen keyboard, enter the subject up to 80 characters.

NOTE
MC562dn/MC562w/MC562dw/ES5462 MFP/ES5462dw MFP/MPS2731mc only:
You can also use the gwerty keyboard to enter details.

11. Select Enter and then press OK.

Registering body text
1. Follow steps 1 to 7 in "Registering a subject" on page 38.
2. Using the Down arrow key, scroll to Edit Body and then press OK.

3. Using the on-screen keyboard, enter the body text up to 256 characters.

NOTE
MC562dn/MC562w/MC562dw/ES5462 MFP/ES5462dw MFP/MPS2731mc only:
You can also use the qwerty keyboard to enter details.

4, Select Enter and then press OK.
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ADDING AN E-MAIL ADDRESS ENTRY TO THE ADDRESS BOOK

The machine can hold up to 100 E-mail addresses in the address book. To assign a new
E-mail address to the address book:

1. Press the SETTING button on the control panel.

Using the Down arrow key, scroll to Address Book and press OK.

Press OK to select E-mail Address.

Using the arrow keys, scroll to the required entry position and press OK.
Press OK to select Register.

Press the Right arrow key to select Name.

N o U hwhnN

Using the keypad or arrows keys and the on-screen keypad, type in the name.

NOTE
The maximum length of name is 16 characters.

If you do not enter a name, this column remains blank.

8. Highlight Enter and press OK.
9. Using the Down arrow key, scroll to E-mail Address and press the Right arrow key.

10. Using the keypad or arrows keys and the on-screen keypad, type in the new E-mail
address.

NOTE
The maximum length of address is 80 characters.

11. Highlight Enter and press OK.

12. If required, use the arrow keys and scroll to Group No. then press the Right arrow
key.

13. Using the arrow keys, select the group number to assign the E-mail address to and
press OK.

The check box is selected. You can select multiple entries.
14. Press the Right arrow key to complete.
15. Press OK to confirm.
16. Press OK once more to add your entry to the address book.

17. Press the Left arrow key to exit the menu.

DELETING AN E-MAIL ADDRESS ENTRY FROM THE ADDRESS BOOK

To delete an E-mail address entry from the address book:

Press the SETTING button on the control panel.

Using the Down arrow key, scroll to Address Book and press OK.

Press OK to select E-mail Address.

Using the arrow keys, scroll to the required entry position and press OK.
Using the arrow keys, scroll to Delete and press OK.

At the prompt select ves to continue or select No to cancel the operation.
Press OK.

Press the Left arrow key to exit the menu.

@ N kR WM
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MODIFYING AN E-MAIL ADDRESS ENTRY FROM THE ADDRESS BOOK

To edit an E-mail address entry from the address book:

Press the SETTING button on the control panel.

Using the Down arrow key, scroll to Address Book and press OK.

Press OK to select E-mail Address.

Using the arrow keys, scroll to the required entry position and press OK.

Press OK to select Edit.

o0 hWNR

Modify the Name, E-mail Address and/or Group No. details as required then press
OK.

7. Press the Left arrow key to exit the menu.

SORTING E-MAIL ADDRESSES IN THE ADDRESS BOOK
To sort E-mail addresses in the address book:
1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Address Book and press OK to enter the
address book.

3. Select E-mail Address and press OK to enter E-mail adress list.
4, Press OK to show the operation menu.
5. Using the arrow keys, scroll to Sort By Name Or Sort By Number, and press OK.

Then the addresses will be sorted depending on the selection.

SEARCHING AN E-MAIL ADDRESS ENTRY IN THE ADDRESS BOOK
To search an E-mail address entry in the address book:
1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Address Book and press OK to enter the
address book.

Select E-mail Address and press OK to enter E-mail adress list.
Press OK to show the operation menu.

Using the arrow keys, scroll to search, and press OK to enter the input window.

& 0 kW

Using the on-screen keyboard to enter the key word for searching.

NOTE
MC562dn/MC562w/MC562dw/ES5462 MFP/ES5462dw MFP/MPS2731mc only:
You can also use the qwerty keyboard to enter details.

7. After key word inputing, select Enter and press OK.

The entries will be sort by name, and the matched entry will have focus.
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ADDING A GROUP ENTRY TO THE ADDRESS BOOK

The machine can hold up to 20 group addresses. To add a new group address to the address
book:

1. Press the SETTING button on the control panel.

Using the Down arrow key, scroll to Address Book and press OK.

Using the Down arrow key, scroll to E-mail Group and press OK.

Using the arrow keys, scroll to the required entry position and press OK.
Press OK to select Register.

Press the Right arrow key to select Name.
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Using the keypad or arrows keys and the on-screen keypad, type in the name.

NOTE
The maximum length of name is 16 characters.

8. Highlight Enter and press OK.
9, Using the Down arrow key, scroll to Address No. and press the Right arrow key.

10. Using the arrow keys, select the destination to assign the E-mail group to and press
OK.

The check box is selected. You can select multiple entries.
11. Press the Right arrow key to complete.
12. Press OK to confirm.
13. Press OK once more to add your entry to the address book.

14. Press the Left arrow key to exit the menu.

DELETING A GROUP ADDRESS ENTRY FROM THE ADDRESS BOOK

To delete a group address entry from the address book:

Press the SETTING button on the control panel.

Using the Down arrow key, scroll to Address Book and press OK.

Using the Down arrow key, scroll to E-mail Group and press OK.

Using the arrow keys, scroll to the required entry position and press OK.
Using the arrow keys, scroll to Delete and press OK.

At the prompt select vyes to continue or select No to cancel the operation.
Press OK.

Press the Left arrow key to exit the menu.
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MODIFYING A GROUP ADDRESS ENTRY FROM THE ADDRESS BOOK

To edit a group address entry from the address book:

Non R WNR

Press the SETTING button on the control panel.

Using the Down arrow key, scroll to Address Book and press OK.

Using the Down arrow key, scroll to E-mail Group and press OK.

Using the arrow keys, scroll to the required entry position and press OK.
Press OK to select Edit.

Modify the Name and/or Address No. details as required then press OK.

Press the Left arrow key to exit the menu.

SORTING GROUP ADDRESS ENTRIES IN THE ADDRESS BOOK

To sort group address entries in the address book:

1.
2.

Press the SETTING button on the control panel.

Using the Down arrow key, scroll to Address Book and press OK to enter the
address book.

Select E-mail Group and press OK to enter E-mail group list.
Press OK to show the operation menu.
Using the arrow keys, scroll to Sort By Name Or Sort By Number, and press OK.

Then the groups will be sorted depending on the selection.

SEARCHING A GROUP ADDRESS ENTRY IN THE ADDRESS BOOK

To search a group address entry in the address book:

1.
2.

I .

Press the SETTING button on the control panel.

Using the Down arrow key, scroll to Address Book and press OK to enter the
address book.

Select E-mail Group and press OK to enter E-mail group list.
Press OK to show the operation menu.
Using the arrow keys, scroll to Search, and press OK to enter the input window.

Using the on-screen keyboard to enter the key word for searching.

NOTE
MC562dn/MC562w/MC562dw/ES5462 MFP/ES5462dw MFP/MPS2731mc only:
You can also use the gwerty keyboard to enter details.

After key word inputing, select Enter and press OK.

The groups will be sort by name, and the matched entry will have focus.
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CONFIGURING THE SCAN TO COMPUTER AND REMOTE SCAN

USING DRIVERS AND SOFTWARE

This section explains how to use the scanner driver and utilities. They allow you to scan
documents and change settings easily on your computer.

UsING TWAIN DRIVER

MEMO
The explanations in this section use PaperPort in Windows and Adobe
Photoshop CS3 in Mac OS X as an example.

In this section, procedures using Remote Scan with USB connection are
described. For how to connect to the network and start to scan by Scan To
Computer, refer to the User's Guide.

NOTE
To use this function, applications supporting TWAIN (PaperPort or Adobe
Photoshop CS3, etc.) should be installed in your computer.

REFERENCE
For details on how to start a scan job, refer to the User's Guide.

Starting a Scan Job (for Windows)

1. Place your document with text face up in the ADF or face down on the document glass.

NOTE
When the "PC Scan Mode" is set to Manual Scan Mode or Secure Scan Mode,
implement steps 2 and 3.

Press the SCAN key.

Press the ¥ to select Remote Scan and then press OK.

Start PaperPort on your computer.
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Click Select and then select the scanner driver of the machine.
A window appears.
6. Click the Scan.
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7. Click the scan buttons.

The scan job starts.

OKI Scanner ==l
Mode: |Simple. ~| @ teb

Scan Buttons

Scan Photograph

Scan Magazine

Scan for OCR

Sean for Intemet

i

Customize

Settings

]

8. Click Quit.

9. When there is no continued page or the back side is not scanned, click Quit.

MEMO
The following five buttons are registered as default settings.

Scan Photograph
Scan Magazine
Scan for OCR
Scan for Internet

Customize

Changing Settings
You can adjust how the document is scanned by changing the driver setting.

The following explains the setting items.

Simple Mode
You can change the settings of five registered buttons.

1. Follow the procedure for "Starting a Scan Job (for Windows)" on page 43 through
step 6.

2. Select Simple from Mode.
3. Click Settings.

A window appears.

OKIScenner B
Mode: [Smple v @) e

Scan Buttons

Scan Photograph
Scan Magazine
Scan for OCR

Scan for Intemet

i

Settings

]
]

Abou
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4. Click the scan button to change the settings.
5. Click OK.
6. If you start a scan job, click the scan button.

If you want to finish the setting, click Quit.

Advanced Mode
You can adjust in detail how a document is scanned.

1. Follow the procedure for "Starting a Scan Job (for Windows)" on page 43 through
step 6.

2. Select Advanced from Mode.
Change the settings if necessary.
4. Click Scan to start scanning.
If you want to finish the setting, click Quit.

REFERENCE
For details on how to change each setting, refer to the online help.

Starting a Scan Job (for Mac 0S X (MC332dn, MC342dn, MC342dw, MC352dn, MC362dn,
MC362w, MC562dn, MC562w, MC562dw, ES3452 MFP, ES5462 MFP, ES5462dw MFP))

1. Place your document with text face up in the ADF or face down on the document glass.

NOTE
When the "PC Scan Mode" is set to Manual Scan Mode or Secure Scan Mode,
implement steps 2 and 3.

Press the SCAN key on the operator panel.

Press the ¥ to select Remote Scan and then press OK.
Start Adobe Photoshop CS3 on your computer.

Select Import from File and then select OKI MC5(3)x2_ES5(3)4x2 USB or OKI
MC5(3)x2_ES5(3)4x2 Network.

> When OKI MC5(3)x2_ES5(3)4x2 USB is selected, proceed to the step 9.

> When OKI MC5(3)x2_ES5(3)4x2 Network is selected, the network scan is the
second or later time, proceed to the step 9.
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6. For the first network scan, the dialog box indicating that the tool for selecting a
connection destination is started is displayed. Then, click OK.

7. On the dialog box of Scan Settings, select a connection destination to register host
information if necessary, and then click OK.

8. Select Import from File of Adobe Photoshop CS3 and select OKI MC5(3)x2_ES5(3)4x2
Network.

The windows appears.
9. Click the scan button.
Scanning starts.
10. Select Quit Photoshop from Photoshop.
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Starting a Scan Job (for Mac 0S X (MPS2731mc))

1.

L o o

10.

Place your document with text face up in the ADF or face down on the document glass.

NOTE
When the "PC Scan Mode" is set to Manual Scan Mode or Secure Scan Mode,
implement steps 2 and 3.

Press the SCAN key on the operator panel.

Press the ¥ to select Remote Scan and then press OK.
Start Adobe Photoshop CS3 on your computer.

Select Import from File and then select OKI MPS2731mc USB or OKI
MPS2731mc Network.

> When OKI MPS2731mc USB is selected, proceed to the step 9.

> When OKI MPS2731mc Network is selected, the network scan is the second or
later time, proceed to the step 9.

For the first network scan, the dialog box indicating that the tool for selecting a
connection destination is started is displayed. Then, click OK.

On the dialog box of Scan Settings, select a connection destination to register host
information if necessary, and then click OK.

Select Import from File of Adobe Photoshop CS3 and select OKI MPS2731mc
Network.

The windows appears.

Click the scan button.

Scanning starts.

Select Quit Photoshop from Photoshop.

Changing Settings (for Macintosh)

You can adjust how the document is scanned by changing the driver setting.

The following explains the setting items.

Simple Mode

You can change the settings of five registered buttons.

1.

Follow the procedure for "Starting a Scan Job (for Mac OS X (MC332dn, MC342dn,
MC342dw, MC352dn, MC362dn, MC362w, MC562dn, MC562w, MC562dw, ES3452
MFP, ES5462 MFP, ES5462dw MFP))" on page 45 through step 8.

Select Simple from Mode.

Click Settings.

A window appears.

Click the scan button to change the settings.
Click OK.

If you start a scan job, click the scan button.
If you want to finish the setting, click Quit.
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Advanced Mode
You can adjust in detail how a document is scanned.

1. Follow the procedure for "Starting a Scan Job (for Mac OS X (MC332dn, MC342dn,
MC342dw, MC352dn, MC362dn, MC362w, MC562dn, MC562w, MC562dw, ES3452
MFP, ES5462 MFP, ES5462dw MFP))" on page 45 through step 8.

2. Select Advanced from Mode.
3. Change the settings if necessary.
4. Click Scan to start scanning.

If you want to finish the setting, click Quit.

USING WIA DRIVER

The WIA driver does not support the network scan function. Connect the machine with the
computer via USB or WSD Scan.

The WIA driver does not support Mac OS X.

The WIA 2.0 driver supports Windows 8/ Windows Server 2012/ Windows 7/ Windows
Server 2008 R2.

The WIA 1.0 driver supports Windows Vista/ Windows Server 2008/ Windows XP/ Windows
Server 2003.

Starting a Scan Job

MEMO
The explanations in this section use PaperPort as an example, and may differ
from the description depending on your application.

1. Place your document with text face up in the ADF or face down on the document glass.

NOTE
When the "PC Scan Mode" is set to Manual Scan Mode or Secure Scan Mode,
implement steps 2 and 3.

Press the SCAN key.

Press the ¥ to select Remote Scan and then press OK.
Start PaperPort on your computer.

Click Select and then click WIA: MC5(3)x2/ES5(3)4x2 (MC332dn, MC342dn,
MC342dw, MC352dn, MC362dn, MC362w, MC562dn, MC562w, MC562dw, ES3452
MFP, ES5462 MFP, ES5462dw MFP) or WIA: MPS2731mc (for MPS2731mc).

Click Scan.
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6

7 Select a paper feeding method.

8. Select a document type.

9 Specify the area to be scanned.

10. Click Scan.

11. Click Cancel when scanning is finished.

12. When there is no continued page or the back side is not scanned, click Finish.

The scanned image is displayed in PaperPort.

Configuring the Scan to Computer and Remote Scan > 47



Using Windows FAX and Scan

“Windows FAX and Scan” is a function used in Windows Vista/ 7/ 8.

1. Place your document with text face up in the ADF or face down on the document glass.

NOTE
When the "PC Scan Mode" is set to Manual Scan Mode or Secure Scan Mode,
implement steps 2 and 3.

Press the SCAN key.

Press the ¥ to select Remote Scan and then press OK.
Click Start on your computer, and select All Programs > Windows FAX and Scan.
Click New Scan.

Select MC5(3)x2/ES5(3)4x2 (for MC332dn, MC342dn, MC342dw, MC352dn, MC362dn,
MC362w, MC562dn, MC562w, MC562dw, ES3452 MFP, ES5462 MFP, ES5462dw MFP) or
MPS2731mc (for MPS2731mc) and click OK.

7. Make additional setting if necessary.
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Scanner: MCS(3)2/ES5 (32 [ change..

Profile [photo (efaulty

- -1

Source Fiatbed

4

Color format: [ coler
Fil type [povpeimese -]

Resolution (DPD: 300

8. Click Scan.
9. Exit Windows FAX and Scan.

USING ICA DRIVER
The ICA driver is not compatible with the Windows OS.
The ICA driver supports the Mac OS X 10.6/10.7/10.8.

Start to read

NOTE
Some examples of image capture are used in the following procedure. The
steps and menus may differ depending on the application you use.

1. Place your document with text face up inthe ADF or face down on the document glass.

NOTE
When the "PC Scan Mode" is set to Manual Scan Mode or Secure Scan Mode,
implement steps 2 and 3.

2. Press the Scan key on the control panel.
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Press the ¥ to select Remote Scan and then press OK.

Start image capture on your computer.

Select the machine from the list at the left to the image capture screen.
Click the Scan.

Scanning will start.
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7. From the Image Capture, select Close Image Capture.

Change settings
You can adjust the document scan by changing the current driver settings.

The following explains each item to set.

Display the detailed information

You can adjust the document scanning in details.
1. Follow steps 1 to 5 of “Start to read” section.
2 Click on Display the detailed information.
3. Change the settings as required.
4

Click Scan to scan the document.

USING ACTKEY SOFTWARE

Using the ActKey, you can start a scan job in specified settings with a click a button.

MEMO
ActKey does not support Mac OS X.

When ActKey is installed, Network Configuration is also installed
simultaneously. For Network Configuration, refer to "Using Network
Configuration" on page 51.

REFERENCE
For details on how to start a scan job, refer to the User's Guide.

Installing the Software

1. Insert the “Software DVD-ROM” into your computer.
A window opens.

2. Select ActKey from Software.

3. Install the software as instructed.

4. Click Finish.

Starting the Software
1. Click Start to select All Programs > Okidata > ActKey > ActKey.

Starting ActKey when Scanning to a Computer

You can set ActKey to start when you select Computer on the machine.
1. Click Start to select Control Panel.

2. Enter View scanners and cameras in Search Control Panel.
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Click the View scanners and cameras under Devices and Printers.

Select MC5(3)x2/ES5(3)4x2 (for MC332dn, MC342dn, MC342dw, MC352dn, MC362dn,
MC362w, MC562dn, MC562w, MC562dw, ES3452 MFP, ES5462 MFP, ES5462dw MFP) or
MPS2731mc (for MPS2731mc) and click Properties.

If the User Account Control dialog box appears, click Yes.

Click the Events tab.

Select an event for Select an event.

Select the Start this program check box and then select ActKey.
Repeat steps 6 and 7 so that ActKey is set to all events.

Click OK.

Fax Transmission of Scanned Documents

Using the fax service of the Windows component, you can send a scanned document.

6.

NOTE
The direction to load the paper can not be changed after scanning the
documents.

This function uses the fax service of the Windows component.

MEMO
For PC-FAX function, the resolution is fixed to 200dpi and the color mode is
fixed to black and white.

Start ActKey on your computer.

NOTE
When the "PC Scan Mode" is set to Manual Scan Mode or Secure Scan Mode,
implement steps 2 and 3.

Press the SCAN key on the operator panel of the machine.

Press the ¥ to select Remote Scan and then press OK.

Place your document with text face up in the ADF or face down on the document
glass.

Click PC-Fax scan button of ActKey on your computer.
The Fax Setup starts.
Follow the on-screen instructions to send a fax.

Setting the Scan Button

You can change the settings of four scan buttons.

1.
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Start ActKey.

Select Button settings from Options menu.
Click a button you want to set.

Change the settings if necessary.

Click OK.
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Using Network Configuration

Network Configuration is a tool to set in advance when executing Scan To Computer. In
addition, if the information including the device and IP address of the computer, etc. is
changed when performing network scan, the setting value can be changed by this tool.

When installing ActKey, Network Configuration is also installed simultaneously.

Network Configuration will be automatically run when you log on windows if you select it in
task tray menu.

When starting Network Configuration, the scanner driver installed in the computer is
displayed.

f=] @ ==

fj MNetwork Configuration

File Scanner Help

Scanner Driver Name IF Address MAC Address |

( 3)x2/ES5(3)4x2 843333 192.168.0.2 008087843333 ',

> Method to add a new network scanner

To add a new network scanner, select Add Scanner from the Scanner menu, and
select scanner driver name of the added scanner.

> Method to change a scanner driver name

When a scanner driver name has been changed, select Edit Driver Name from
the Scanner menu and then change the scanner driver name.

> Method to change the setting information of the machine

When the IP address of the machine and port number of the machine have been
changed, start Network Configuration and then select Edit Scanner from the
Scanner menu.

ﬁ Metwork Cenfiguration EI =
Add 5 G
canner | IP Address MAC Address
Edit Driver Name (__wsso2 loososzsessss ]
Edit Scanner )
Refresh
Properties
¥

The setting value set in the current computer is displayed, and then change the IP
address and port number of the machine.

Scanner Properties

Driver Name:

OKI MC5(3)x2/ES5(3)4x2 843333

[l

Scanner IP:

Scanner Port:

192, 168.0.2

9967

Cancel
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Method to set Scan To Computer

To execute Scan To Computer, you need to register the computer name, IP address
and port number in the machine.

After installing the scanner driver, start Network Configuration and select the
driver to be used. Then, select Properties from the Scanner menu and select the
Register tab. As the computer information, the computer name, IP address and
port number are displayed. The computer name does not have to be set since the
computer's host name is automatically acquired.

Although the setting value of the computer is automatically displayed for the IP
address, if multiple network cards are installed in the computer, multiple IP
addresses are displayed. Select the IP address of the network card currently used.
Further more, for the port number, the current setting is displayed. If you need to
change, change the setting.

After all settings are complete. Click Register button to register the setting in the
machine.

If the machine is tuned off and cannot be connected, an error occurs when
registering. After registering, if the computer's name, IP address or port number
is changed, you need to register again with the above procedure.

Properties @

General | Register | Unregister

PC Information

Host Mame:

IF Address: Local Area Connection{192.168.0 ~

Port Number: 9958 -

Register your PC information to scanner.

Register
Close
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Method to delete network-connected PCs of the machine

If you registered several network-connected PCs in the machine, you can delete
them.

Select Properties from the Scanner menu and select Unregister tab. The
registered information is displayed. Select the registered information to be deleted
from the machine, and click Unregister button.

Properties @
Uneister

Registered PG Information

Host Mame IP Address Part Mumber

R T T

Unregister your PG information from scanner.
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USEFUL FUNCTIONS FOR SCAN TO COMPUTER AND REMOTE SCAN

This section explains useful functions for Scan to Computer and Remote Scan.

MEMO
To enter the Admin Setup menu, a password is necessary. The default
password is "aaaaaa".

SETTING PC ScaN MoODE

You can select either simple scan mode, manual scan mode or secure scan mode for Scan
to Computer function.

1. Press the SETTING key.

Press the ¥ to select Admin Setup and then press OK.
Enter the administrator password.

Select Enter and then press OK.
Press the V¥ to select Scanner Setup and then press OK.
Press the ¥ to select PC Scan Mode and then press OK.

Press the ¥ to select a mode and then press OK.
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Press the <« until the top screen appears.

ENABLING THE NETWORK TWAIN SETTINGS

Do the following procedure to use Scan to Computer and Remote Scan functions connecting
to network.

NOTE
If you select Disable on this function, you cannot use Scan to Computer and
Remote Scan via network.

Press the SETTING key.
Press the V¥ to select Admin Setup and then press OK.

Enter the administrator password.

Select Enter and then press OK.
Press the V¥ to select Scanner Setup and then press OK.

Press the ¥ to select TWAIN Setup and then press OK.
Check that Network TWAIN is selected and then press OK.

Press the ¥ to select ON and then press OK.
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Press the <« until the top screen appears.

ENABLING THE WSD ScaAN

To use both the Scan To Computer (WSD Scan) function and the Remote Scan (WSD Scan)
function via the WSD Scan connection, follow the steps below.

1. Press the SETTING key.

2. Press the ¥ to select Admin Setup and then press OK.
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Enter the administrator password.

Select Enter and press OK.
Press the V¥ to select Scanner Setup and then press OK.

Press the V¥ to select WSD Scan Setup and then press OK.
Check that WSD Scan is selected, and then press OK.

Press the V¥ to select ON and then press OK.
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Press the <« until the top screen appears.

SELECTING THE DUAL-SIDE SCAN OF WSD SCAN FUNCTION

To enable the Dual-Side Scan of the Scan To Computer (WSD Scan) function and Remote
Scan (WSD Scan) function, follow the steps below.

1. Press the SETTING key.

Press the ¥ to select Admin Setup and then press OK.
Enter the administrator password.

Select Enter and press OK.
Press the V¥ to select Scanner Setup and then press OK.
Press the V¥ to select WSD Scan Setup and then press OK.

Press the V¥ to select Binding and then press OK.
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Select Long Edge Bind or Short Edge Bind according to the scan document, and
press OK.

9. Press the <« until the top screen appears.

DELETING A SCANNER DRIVER

You can delete scanner drivers.

NOTE
You must be logged on as an administrator to complete this procedure.

For Windows
1. Click on Start, and then select Control Panel > Uninstall a program.

2. Select OKI MC5(3)x2/ES5(3)4x2 Scanner (for MC332dn, MC342dn, MC342dw, MC352dn,
MC362dn, MC362w, MC562dn, MC562w, MC562dw, ES3452 MFP, ES5462 MFP, ES5462dw MFP)
or OKI MPS2731mc Scanner (for MPS2731mc) and click on Uninstall.

If the User Account Control dialog box appears, click Yes.
3. If a confirmation message appears, click Yes.

4. Click Finish on the Uninstallation Complete screen.

For Mac OS X

1. From the hard disk, select Library > Image Capture > TWAIN Data Sources.

2. Depending on the method of connection of the machine, the following files will be
deleted.
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OKI MC5(3)x2_ES5(3)4x2 Network Driver.ds
OKI MPS2731mc Network.ds

OKI MC5(3)x2_ES5(3)4x2 USB Driver.ds
OKI MPS2731mc USB.ds

Close the TWAIN Data Sources dialog box.

From the hard disk, select Library > Image Capture > Devices.
Delete the OKI Scanner.

Close the Devices dialog box.

From the hard disk, select Applications > Okidata > Scanner.

Delete network scanner setup tool.
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Restart the computer.

UPDATING A SCANNER DRIVER

You can update scanner drivers.

NOTE
You must be logged on as an administrator to complete this procedure.

For Windows
1. Click on Start, right click Computer Select Properties.
2. Click Device Manager.
If the User Account Control dialog box appears, click Yes.

3. Right click the MC5(3)x2/ES5(3)4x2 (for MC332dn, MC342dn, MC342dw, MC352dn,
MC362dn, MC362w, MC562dn, MC562w, MC562dw, ES3452 MFP, ES5462 MFP, ES5462dw MFP)
or MPS2731mc (for MPS2731mc) icon on Imaging Device and click on Properties.

Check the version of the scanner driver on the Drivers.

5. Delete the scanner driver.

REFERENCE
"Deleting a Scanner Driver" on page 55.

6. Install a new scanner driver.

REFERENCE
For details on how to install a driver, refer to the User's Guide.

For Mac OS X

1. Delete the scanner driver.

REFERENCE
"Deleting a Scanner Driver" on page 55.

2. Install a new scanner driver.

REFERENCE
For details on how to install a driver, refer to the User's Guide.
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CONFIGURING THE FAX SETTINGS (MC342dn, MC342dw, MC362dn,
MC362w, MC562dn, MC562w, MC562dw, ES5462 MFP, ES5462dw
MFP AND MPS2731mc)

BASIC SETUP

Minimum configuration requirements; a PSTN telephone line connection.

If you wish to connect an external telephone or answering machine, refer to "Adding a
telephone handset" on page 60.

Your MFP has to be set up properly to allow faxing from the machine. The following
parameters must be set before using the fax function:

> Date and time
> Local fax number
> Sender ID

NOTE
If you ran the Oki driver installer program from the DVD-ROM you may have
already set the time zone, date and time via the Panel Language Setup utility.

There are other parameters that can be adjusted to suit your personal preferences later if
required, refer to fax set up table for details (See "Advanced set up" on page 58).

To set fax parameters:
1. Press the SETTING button on the control panel.
2. Using the Down arrow key, scroll to Easy Setup and press OK.

3. Using the arrow keys and on-screen keypad, enter the Administrator password.
Highlight Enter and press OK.

NOTE
The default password is "aaaaaa”.

4, Press the Right arrow key to select bate/Time Setting.
5. Using the arrow keys, select the correct time zone and press OK.
6. Using the arrow keys, select the correct daylight saving option and press OK.
7. Press OK to select Manual.
8. Using the arrow keys, enter today’s date.
NOTE
Use the Right and Left arrow keys to move between digits.
9. Press OK.

10. Using the arrow keys, enter the correct time.

NOTE
Use the Right and Left arrow keys to move between digits.

11. Press OK.
12. Using the Down arrow key and scroll to Fax Setting then press Right arrow key.

13. Press the Right arrow key to select Fax Number.
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14. Using the keypad and on screen options enter the fax number for this MFP.
15. Highlight Enter and press OK.
16. Press the Right arrow key to select sender 1ID.

17. Using the keypad or arrow keys and on screen keyboard, enter the sender ID.

NOTE
Maximum 22 characters.

18. Highlight Enter and press OK.
19. Press OK to complete.

20. Press the Left arrow key to exit the menu.

NOTE
By default the country code is set to International. If you need to change this,
refer to "Country Code" on page 135.

If required, set the dialling method for your region (Pulse or Tone). Refer to
"MF(Tone)/DP(Pulse)" on page 154.

If connecting the machine through a private branch exchange (PBX) line, you
must also specify a dial prefix to allow the machine to obtain an external line
before dialling. Refer to "Connecting to a PBX" on page 58.

ADVANCED SET UP

Your machine offers a multitude of features which reduce the time required for manual
operation and make fax communications more efficient.

CONNECTING TO A PBX

Private branch exchanges (PBXs) are private telephone systems used to route calls
internally, for example, in a company. When dialling a telephone number, if a prefix is
required to open an outside line, the line is connected to a PBX. If this MFP is going to be
connected to a PBX, please make the following changes to enable it to recognise the prefix
digits in the telephone numbers used to obtain access to the outside line. After dialling the
prefix digits, the MFP will wait until the outside line is available (secondary dial tone
detected) before dialling the rest of the number.

1. Press the SETTING button on the control panel.
2. Using the Down arrow key, scroll to Admin Setup and press OK.

3. Using the arrow keys and on-screen keypad, enter the Administrator password.
Highlight Enter and press OK.

Using the Down arrow key, scroll to Fax Setup and press OK.
Using the Down arrow key, scroll to other Settings and press OK.

Using the Down arrow key, scroll to prefix and press OK.
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Using the keypad, arrow keys and on screen options, enter the required prefix and
press OK.

8. Press the Left arrow key to exit the menu.
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AUTOMATIC REDIAL

You can set the fax to automatically redial if the initial fax transmission fails. The machine
will redial on:

> Line busy

> No answer

> Communication error

To set auto-redial:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Admin Setup and press OK.

3. Using the arrow keys and on-screen keypad, enter the Administrator password.
Highlight Enter and press OK.

Using the Down arrow key, scroll to Fax Setup and press OK.
Using the Down arrow key, scroll to other Settings and press OK.

Press OK to select the Redial Tries.
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Using the keypad, enter the required number of redial attempts (between 0 and 9),
then press OK to confirm.

®

Using the Down arrow key, scroll to Redial Interval and press OK.

0

Using the keypad, enter the required redial interval (between 1 and 5 minutes), then
press OK to confirm.

10. Press the Left arrow key to exit the menu.

RECEPTION MODE

You can change the way your MFP handles incoming fax transmissions and telephone calls
(if you have a telephone handset connected) depending on your office requirements.

Choose from:

> Fax Ready Mode

> Tel/Fax Ready Mode

> Ans/Fax Ready Mode

> Tel Ready Mode

> DRD

To change the reception mode:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Admin Setup and press OK.

3. Using the arrow keys and on-screen keypad, enter the Administrator password.
Highlight Enter and press OK.

Using the Down arrow key, scroll to User Install and press OK.

Using the Down arrow key, scroll to Reception Mode and press OK.
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Using the arrow keys, select the required reception mode and press OK.
7. Press the Left arrow key to exit the menu.

The machine behaviour differs depending on the specified reception mode, refer to the
User’s Guide for details.
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ADDING A TELEPHONE HANDSET

If you want to add a telephone handset to your MFP, connect the line to the Tel socket (in
certain countries it may be necessary to use a telephone plug adaptor).

You will also need to update the telephone settings to set the ring response:
1. Press the SETTING button on the control panel.
2. Using the Down arrow key, scroll to Admin Setup and press OK.

3. Using the arrow keys and on-screen keypad, enter the Administrator password.
Highlight Enter and press OK.

Using the Down arrow key, scroll to Fax Setup and press OK.
Using the Down arrow key, scroll to other Settings and press OK.

Using the Down arrow key, scroll to Ring Response and press OK.
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Using the arrow keys, select the required response setting (between 1 ring and 20
seconds) and press OK.

8. Press the Left arrow key to exit the menu.

NOTE
You must also set the reception mode to the appropriate setting. See
"Reception mode" on page 59.

NOTE
Dialling for speech purposes is not available using the MFP keypad or speed
dial keys.
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MANAGING THE PHONE BOOK

The following section describes how to add/remove/modify speed and group dial entries to/
from the Phone Book.

ADDING A SPEED DIAL ENTRY TO THE PHONE BOOK

The machine can hold up to 100 speed dial numbers in the phone book. To add a new speed
dial number to the phone book:

1. Press the SETTING button on the control panel.

Using the Down arrow key, scroll to Phone Book and press OK.

Press OK to select Speed Dial List.

Using the arrow keys, scroll to the required entry position and press OK.
Press OK to select Register.

Press the Right arrow key to select Name.
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Using the keypad or arrows keys and the on-screen keypad, type in the name.

NOTE
The maximum length of name is 24 characters.

8. Highlight Enter and press OK.
9. Using the Down arrow key, scroll to Fax Number and press the Right arrow key.

10. Using the keypad, type in the destination fax number.

NOTE
The maximum length of number is 40 digits.

If the destination fax number has an “extension number”, press the Pause
button between numbers. The machine will enter a pause when dialling.

If your MFP js connected to a PBX (private branch exchange), you will need to
add a Prefix in order to access to the outside line. Refer to "Connecting to a
PBX" on page 58.

If you need to change the dialling method for the region, press the Tone
button to change the call parameters for this particular number.

If you make a mistake while entering the number, press the Clear button to
delete the last digit.

11. Highlight Enter and press OK.

12. If required, use the arrow keys and scroll to Group No. then press the Right arrow
key.

13. Using the arrow keys, select the group number to assign the fax number to and
press OK.

The check box is selected. You can select multiple entries.

NOTE
Numbers registered to groups from the Speed Dial function are synchronized
with the numbers that are registered to groups using the Group No. function.

14. Press the Right arrow key to complete.
15. Press OK to confirm.

16. Press OK once more to add your entry to the phone book.
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17. Press the Left arrow key to exit the menu.

ADDING A GROUP ENTRY TO THE PHONE BOOK

The machine can hold up to 20 group dial settings. To add a new group dial number to the
phone book:

Press the SETTING button on the control panel.

Using the Down arrow key, scroll to Phone Book and press OK.

Using the Down arrow key, scroll to Group No. Book and press OK.
Using the arrow keys, scroll to the required entry position and press OK.
Press OK to select Register.

Press the Right arrow key to select Name.
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Using the keypad or arrows keys and the on-screen keypad, type in the name.

NOTE
The maximum length of name is 16 characters.

8. Highlight Enter and press OK.
9. Using the Down arrow key, scroll to speed Dial and press the Right arrow key.

10. Using the arrow keys, select the speed dial number you wish to assign to the group
and press OK.

The check box is selected. You can select multiple entries.
11. Press the Right arrow key to complete.
12. Press OK to confirm.
13. Press OK once more to add your entry to the phone book.

14. Press the Left arrow key to exit the menu.

DELETING A SPEED DIAL ENTRY FROM THE PHONE BOOK

To delete a speed dial entry from the phone book:

Press the SETTING button on the control panel.

Using the Down arrow key, scroll to Phone Book and press OK.

Press OK to select Speed Dial List.

Using the arrow keys, scroll to the required entry position and press OK.
Using the arrow keys, scroll to Delete and press OK.

At the prompt select vyes to continue or select No to cancel the operation.
Press OK.

Press the Left arrow key to exit the menu.

@ NO U R WM

DELETING A GROUP DIAL ENTRY FROM THE PHONE BOOK

To delete a group dial entry from the phone book:

1. Press the SETTING button on the control panel.

2 Using the Down arrow key, scroll to Phone Book and press OK.

3. Using the Down arrow key, scroll to Group No. Book and press OK.
4

Using the arrow keys, scroll to the required entry position and press OK.
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Using the arrow keys, scroll to Delete and press OK.
At the prompt select ves to continue or select No to cancel the operation.
Press OK.

Press the Left arrow key to exit the menu.
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MODIFYING A SPEED DIAL ENTRY

To modify a speed dial entry:

Press the SETTING button on the control panel.

Using the Down arrow key, scroll to Phone Book and press OK.

Press OK to select Speed Dial List.

Using the arrow keys, scroll to the required entry position and press OK.
Press OK to select Edit.

Modify the Name, Fax Number and/or Group No. details as required then press OK.
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Press the Left arrow key to exit the menu.

MODIFYING A GROUP DIAL ENTRY

To modify a group dial entry:

. Press the SETTING button on the control panel.

. Using the Down arrow key, scroll to Phone Book and press OK.

. Using the Down arrow key, scroll to Group No. Book and press OK.
Using the arrow keys, scroll to the required entry position and press OK.

Press OK to select Edit.

. Modify the Name, and/or Speed Dial details as required then press OK.
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Press the Left arrow key to exit the menu.

SORTING SPEED DIAL ENTRIES
To sort speed dial entry:
1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Phone Book and press OK to enter the phone
book.

3. Select speed Dial and press OK to enter speed dial list.
4. Press OK to show the operation menu.
5. Using the arrow keys, scroll to Sort By Name Or Sort By Number, and press OK.

Then the entries will be sorted depending on the selection.

SORTING GROUP DIAL ENTRIES
To sort group dial entries:
1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Phone Book and press OK to enter the phone
book.

3. Select Group No. and press OK to enter dial group list.
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4.
5.

Press OK to show the operation menu.
Using the arrow keys, scroll to Sort By Name Or Sort By Number, and press OK.

Then the groups will be sorted depending on the selection.

SEARCHING A SPEED DIAL ENTRY

To search a speed dial entry:

1.
2.
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Press the SETTING button on the control panel.

Using the Down arrow key, scroll to Phone Book and press OK to enter the phone
book.

Select speed Dial and press OK to enter speed dial list.

Press OK to show the operation menu.

Using the arrow keys, scroll to search, and press OK to enter the input window.
Using the on-screen keyboard to enter the key word for searching.

After key word inputing, select Enter and press OK.

The entries will be sort by name, and the matched entry will have focus.

SEARCHING A GROUP DIAL ENTRY

To search a group dial entry:

1.
2.
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Press the SETTING button on the control panel.

Using the Down arrow key, scroll to Phone Book and press OK to enter the phone
book.

Select Group No. and press OK to enter dial group list.

Press OK to show the operation menu.

Using the arrow keys, scroll to search, and press OK to enter the input window.
Using the on-screen keyboard to enter the key word for searching.

After key word inputing, select Enter and press OK.

The groups will be sort by name, and the matched entry will have focus.

REGISTERING AN ENTRY FROM RECEPTION OR TRANSMISSION HISTORY
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Press the Fax button on the control panel to prompt the Fax Mode screen.
Ensure rFax is highlighted, then press OK.
Using the Down arrow key, scroll to Fax History and press OK.

Using the arrow keys, highlight Tx History or Rx History as appropriate and press
OK.

Using the arrow keys, scroll to the required entry and press OK.

Check the entry contents and then press the Right arrow key.

Press OK to select Register To Speed Dial.

Using the arrow keys, scroll to the required entry position and press OK.

Continue the registration process as described in "Adding a speed dial entry to the
phone book" on page 61.

The fax number is automatically entered. You do not have to enter it manually.
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USER AUTHENTICATION AND ACCESS CONTROL

The user authentication and access control functions allow you to limit the functions
available to each user. These functions can help you save toner and paper.

Your machine has the following two methods of user authentication:
> PIN (personal identification number)
> User name and password

To control access to the machine, register a PIN or a user name and password for each user
in advance. The user must enter the PIN (or the user name and password) to log into the
machine or to print from a computer.

NOTE
You can register up to 100 PINs and 100 user name and password sets.

Access control can be applied to the following functions:
Copying (Color/Mono)

Printing (Color/Mono)

Printing from USB Memory

Scanning to E-mail

Scanning to Shared Folder

Scanning to USB memory

Faxing (MC342dn, MC342dw, MC362dn, MC362w, MC562dn, MC562w, MC562dw,
ES5462 MFP, ES5462dw MFP and MPS2731mc only)

Faxing via PC (MC342dn, MC342dw, MC362dn, MC362w, MC562dn, MC562w,
MC562dw, ES5462 MFP, ES5462dw MFP and MPS2731mc only)

> Internet Faxing (MC342dn, MC342dw, MC362dn, MC362w, MC562dn, MC562w,
MC562dw, ES5462 MFP, ES5462dw MFP and MPS2731mc only)

The following conditions are required to enable the user authentication and access control
functions:

V VV V V VYV

\%

> Your machine is connected to a network

> A computer on which Configuration Tool is installed is on the network
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PIN AUTHENTICATION

REGISTERING A PIN

Before enabling user authentication and access control, be sure to register a PIN for each
user. You must be the administrator to register PINs.

To register a PIN, launch PIN Manager from Configuration Tool.

NOTE
You can also register a PIN from the MFP web page.

ENABLING PIN AUTHENTICATION

You must be the logged on as the administrator to control access to the machine.

1.
2.
3.
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Press the SETTING button on the control panel.
Using the Down arrow key, scroll to Admin Setup and then press OK.

Using the arrow keys and on-screen keypad, enter the Administrator password.
Highlight Enter and press OK.

Using the Down arrow key, scroll to Management and press OK.
Using the Down arrow key, scroll to Ssystem Setup and press OK.
Make sure that Access Control is selected and press OK.

Using the arrow keys, scroll to pIN and press OK.

Press the BACK button to exit the menu.
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OPERATION WHEN PIN AUTHENTICATION IS ENABLED

Logging into the machine
For general users
1. Enter your PIN using the keypad on the control panel.
2. Press OK.

If authentication succeeds, the top screen displays.
For the Administrator
1. Enter "000000" using the keypad on the control panel.

NOTE
The Administrator PIN is "000000”. You cannot change this value.

2. Press OK.
When the password entry screen displays, enter the administrator password.
4. Using the arrow keys, highlight Enter and then press OK.

If authentication succeeds, the top screen displays.

Logging out of the machine

When you have finished operations, be sure to log out of the machine.

1. Press the BACK button or Left arrow key until the top screen displays.
2. Press the RESET/LOGOUT button on the control panel.

NOTE
After a certain period of time, the machine automatically logs out users.
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USER NAME AND PASSWORD AUTHENTICATION

REGISTERING A USER NAME AND PASSWORD

Before enabling user authentication and access control, be sure to register a user name and
a password for each user. You must be the administrator to register user names and
passwords.

To register a user name and password, launch PIN Manager from Configuration Tool.

NOTE
You can also register a user name and password from the MFP web page.

ENABLING USER NAME AND PASSWORD AUTHENTICATION

You must be the logged on as the administrator to control access to the machine.
1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Admin Setup and then press OK.

3. Using the arrow keys and on-screen keypad, enter the Administrator password.
Highlight Enter and press OK.

NOTE
The default password is “"aaaaaa”.

Using the Down arrow key, scroll to Management and press OK.

Using the Down arrow key, scroll to System Setup and press OK.

Make sure that Access Control is selected and press OK.

Using the arrow keys, scroll to User/pPassword and press OK.

Using the Down arrow key, scroll to User Authentication Method and press OK.
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Make sure that r.ocal is selected and press OK.

NOTE
When you select z0APor Secure Protocol, the server settings are
necessary. For details, refer to "Network Menu" on page 146.

10. Press the BACK button to exit the menu.
OPERATION WHEN USER NAME AND PASSWORD AUTHENTICATION IS ENABLED

Logging into the machine

. Make sure that user Name is selected and then press the Right arrow key.
. Enter your name.

. Using the arrow keys, highlight Enter and then press OK.

Make sure that password is selected and then press Right.

Enter your password.

Using the arrow keys, highlight Enter and then press OK.
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At the Login screen, press OK.

If authentication succeeds, the top screen displays.
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Logging out of the machine

When you have finished operations, be sure to log out of the machine.

1.
2.

Press the BACK button or Left arrow key until the top screen displays.
Press the RESET/LOGOUT button on the control panel.

NOTE
After a certain period of time, the machine automatically logs out users.

OPERATION FROM THE COMPUTER

NOTE
The authentication type specified on the computer overrides the one specified
on the machine.

Printing from Windows
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NOTE
You cannot use the PCL XPS printer driver for this function.

This procedure uses Windows 7 and NotePad as an example. The procedures
and menus may differ depending on the OS you use.

Open the file you want to print.

From the File menu, select Print.

Choose the printer driver you want in Select Printer and click Preferences.
Select the Job Options tab.

Click User Auth.

Select Use User Authentication.

Enter the user name in Username and the password in Password.

Clicking Use Windows Login automatically enters your login name on Windows.
Click OK.

Click OK and then click Print.

Printing from Mac

W N

o

NOTE
This procedure uses Mac OS X 10.6 as an example. The procedures and menus
may differ depending on the OS you use.

Open the file you want to print.
From the File menu, select Print.
Select your machine’s printer driver.

Select User Authentication from the panel menu under the Printer and Presets
menus.

Select Enable User Authentication.
Enter the user name in User Name and the password in Password.
Click Print.
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Faxing (Windows only)

NOTE
This procedure uses Windows 7 and NotePad as an example. The procedures
and menus may differ depending on the OS you use.

Open the file you want to fax.

From the File menu, select Print.

Select your machine (fax driver) in Select Printer and click Preferences.
On the Setup tab, click User Auth.

Select Use User Authentication.
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Enter the user name in Username and the password in Password.

Clicking Use Windows Login automatically enters your login name on Windows.
Click OK.

Click OK and then click Print.
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ADVANCED NETWORK SETTINGS

This chapter explains advanced network settings for your machine.

NETWORK SETTING ITEMS

This section explains the menus available for network settings.

You can check the current network settings by pressing the SETTING key and selecting
View Information then Network on the machine control panel. You can also print the
setting list.

NOTE

For details on how to print the network setting list, refer to "Network
Information" on page 120.

You can change the network settings from the machine’s web page, Configuration Tool,
TELNET, and Network Card Setup. For available menus on each utility, refer to the following

tables.

TCP/IP

TELNET

CONFIG.
TOOL
NETWORK
SETTING
PLUG-IN

NETWORK CARD

SETUP

(WIN.)

(MAC)

DEFAULT
VALUE

DESCRIPTION

IP 1P DHCP/ DHCP/ DHCP/ Auto Specifies whether to

Address Address BOOTP BOOTP BOOTP request the DHCP/BOOTP

Set Set server to assign an IP
address.

1P IP IP Address IP IP Address | XXX.XXX.XXX.X Sets an IP address.

Address Address Address XX

Subnet Subnet Subnet Mask | Subnet Subnet XXX XXX XXX X Sets a subnet mask.

Mask Mask Mask Mask XX

Gateway Gateway Default Default Default 0.0.0.0 Sets a gateway address.

Address Address Gateway Gateway Gateway

Address Address Address

DNS DNS - - - 0.0.0.0 Specifies the IP address of

Server Server the primary DNS server.

(Primary) | (Pri.) Be sure to specify this item
when you use a domain
name to specify the SMTP/
POP/LDAP server.

DNS DNS - - - 0.0.0.0 Specifies the IP address of

Server Server the secondary DNS server.

(Second- (Sec.) Be sure to specify this item

ary) when you use a domain
name to specify the SMTP/
POP/LDAP server.

Dynamic Dynamic - - - Disable Specifies whether to

DNS DNS register the information to

the DNS server when a
setting has been changed.
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TELNET

CONFIG.
TOOL
NETWORK
SETTING
PLUG-IN

DEFAULT
VALUE
NETWORK CARD
SETUP

(WIN.) (MAC)

DESCRIPTION

Domain Domain - - - (NULL) Sets the domain name the

Name Name machine belongs to.

WINS WINS - - - 0.0.0.0 Specifies the name or IP

Server Server address of the WINS server

(Primary) (Pri.) (for Windows only).

WINS WINS - - - 0.0.0.0 Specifies the name or IP

Server Server address of the WINS server

(Second- (Sec.) (for Windows only).

ary)

Scope ID Scope ID - - - (NULL) Specifies the Scope ID for
WINS. From 1 to 223
characters can be used.

Windows Windows - - - Disable Specifies whether to use
the auto-discovery function
of Windows.

Macintosh Macintosh | - - - Enable Specifies whether to use
the auto-discovery function
of Macintosh.

Device Printer - - - OKI-(machine | Specifies the rule of

Name Name name)-(last 6 displaying the machine

digits of MAC name when the auto-detect
address) function is enabled.

IPV6 IP Version | - - - Disable Specifies whether to use
IPV6.
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NETWARE

TELNET

CONFIG.
TOOL

NETWORK
SETTING
PLUG-IN

NETWORK CARD

DEFAULT
VALUE

DESCRIPTION

Print mode | - - Print Server | Specifies how to use the
machine, as a print
server, or as a remote
printer.

Connection | NetWare - NDS+ Specifies the NetWare

method Mode Bindery priority mode.

Communi- TCP or IPX - IPX Select IPX or TCP/IP to be

cation used on NetWare.

protocol

Print Print Server - OKI- Specifies the print server

Server Name (machine name up to 31

Name name)-(last | characters. This value

6 digits of must be identical to the
Ethernet one specified in the file
address)-PS | server.

Printer PrinterName | - OKI- Specifies the machine

Name (machine name when you use a

name)-(last remote printer. This value
6 digits of must be identical to the
Ethernet one specified in the file
address)-PR | server.

Frame Frame Type - Auto Specifies the frame type

Type the machine uses on
Netware.

Bindery - - Enable Specifies whether to use

Mode the bindery mode.

When you access Netware
3.12 or the bindery
network of NetWare 6.0,
5.0, or 4.1, enable the
bindery mode.

When you access NDS of
NetWare 6.0, 5.0, or 4.1,
disable the bindery mode.

File Server | File Server - (NULL) Specifies the name of the

Names Name file server up to 47

#1-8 characters. You can
specify up to 8 servers.

Password Password - (NULL) Sets a password to log in

for File to the file server up to 31

Servers characters.

You must specify this item
when you set a password
on the file server for the
machine.

Job Polling JobPolling - 4 (seconds) Sets the interval to

Rate Time (Sec.) access the queue for a
print job.
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DEFAULT DESCRIPTION
VALUE
TELNET CONFIG. NETWORK CARD
TOOL SETUP

NETWORK

SETTING (WIN.) (MAC)
PLUG-IN

Tree NDS Tree - - - (NULL) Specifies the NDS tree
name up to 31
characters. Specify the
tree name to which the
file server belongs.

Context NDS Context | - - - (NULL) Specifies the NDS context
name up to 77
characters. Specify the
context name to which
the print server belongs.

Job Job Timeout | - - - 10 Specifies when to free a
Timeout (Sec.) (seconds) port after the last print
job has been accepted.
Print Print Sever - - - (NULL) Specifies the name of the
Server Name print server to access up
Names #1-8 to 47 characters. You can

specify up to 8 servers.

ETHERTALK

DEFAULT DESCRIPTION

VALUE
TELNET CONFIG. NETWORK CARD

TOOL SETUP

NETWORK

SETTING (WIN.) (MAC)

PLUG-IN
Zone Zone - - - * Specifies the EtherTalk zone
Name Name name up to 32 characters.
Printer Printer - - - (machine Specifies the Ethertalk printer
Name Name name) name up to 31 characters.
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NBT/NEeTBEUI

DEFAULT DESCRIPTION

VALUE
TELNET CONFIG. NETWORK CARD
TOOL SETUP
NETWORK
SETTING (WIN.) (MAC)
PLUG-IN
Short Short - - - (machine Sets the rule of specifying
Device Device name)- the name to be identified on
Name Name (last 6 NetBIOS over TCP/NetBEUI
digits of up to 15 characters.
Ethernet It is displayed on the
address) PrintServer group in
Network Computer on
Windows.
Workgroup | Work - - - PrintServer | Specifies the work group
Name group name to be displayed on
Name Windows network
computers up to 15
characters.
Master Master - - - Enable Specifies whether to use
Browser Browser master browser.
Setting Setting
Comment Comment | - - - Ethernet- Sets a comment up to 48
Board characters.
OKIiLAN It is displayed when
8500e Windows Explorer is in the
detailed view.

E-MAIL SEND

DEFAUL DESCRIPTION

T VALUE
TELNET CONFIG. NETWORK CARD
TOOL SETUP
NETWORK
SETTING (WIN.) (MAC)
PLUG-IN
SMTP Send SMTP - - - Enable Specifies whether to use SMTP
Send (E-mail).
SMTP SMTP - - - (NULL) Specifies the SMTP server
Server Server name. Specify the domain
Name name or IP address.

Be sure to configure DNS
settings when you enter a
domain name.

Device Device - - - (NULL) Specifies the E-mail address of
E-mail Email the machine.
Address Address
Authenticat | SMTP - - - None Specifies whether to perform
ion Method Auth- SMTP authentication.

Method

Advanced network settings > 75



DEFAUL DESCRIPTION
T VALUE
TELNET CONFIG. NETWORK CARD
TOOL SETUP
NETWORK
SETTING (WIN.) (MAC)
PLUG-IN
SMTP Port SMTP Port | - - - 25 Specifies the SMTP port
Number Number number.
SMTP SMTP - - - (NULL) Sets a user ID for SMTP
UserlID Server authentication method.
User ID
SMTP SMTP - - - (NULL) Sets a password for SMTP
Password Server authentication.
Password
SMTP SMTP - - - None Specifies the method for
Encryption Encryption encrypting the SMTP (E-mail)
Algorithm send protocol.
POP UserID | POP - - - (NULL) Sets a user ID to access the
Server POP server.
UserID
POP POP - - - (NULL) Sets a password to access the
Password Server POP server.
Password
POP POP - - - None Specifies the method to
Encryption Encryption encrypt POP communication.
Algorithm
Attached Attached - - - Enable Specifies whether to list the
Information | Info machine model name on an
Device Device alert E-mail.
Model Model
Attached Attached - - - Enable Specifies whether to list the
Information | Info network interface name on an
Network Network alert E-mail.
Interface Interface
Attached Attached - - - Enable Specifies whether to list the
Information | Info Serial machine serial number on an
Serial Number alert E-mail.
Number
Attached Attached - - - Disable Specifies whether to list the
Information | Info Asset machine asset number on an
Asset Number alert E-mail.
Number
Attached Attached - - - Disable Specifies whether to list the
Information | Info machine SystemName on an
Device Device alert E-mail.
Name Name
Attached Attached - - - Disable Specifies whether to list the
Information | Info machine SystemLocation on an
Location Location alert E-mail.
Attached Attached - - - Enable Specifies whether to list the
Information | Info IP machine IP address on an alert
IP Address Address E-mail.
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TELNET

CONFIG.
TOOL

NETWORK
SETTING
PLUG-IN

NETWORK CARD

DEFAUL
T VALUE

DESCRIPTION

Attached Attached - Disable Specifies whether to list the

Information | Info MAC machine MAC address on an

MAC Address alert E-mail.

Address

Attached Attached - Disable Specifies whether to list the

Information | Info Short short product name of the

Short Device machine on an alert E-mail.

Device Name

Name

Attached Attached - Disable Specifies whether to list the

Information | Info machine URL on an alert E-

Device URL | Device mail.

URL
Comment Comment - (NULL) Sets a comment to add to an
Line 1-4 alert E-mail. You can enter a

maximum of 63 characters in a
line. Up to 4 lines can be
specified.

Reply-To- Reply-To - (NULL) Specifies the E-mail address

Address Address used to reply to E-mails.

Specify the E-mail address of
the network administrator.

E-MAIL RECEIVE

TELNET

CONFIG.
TOOL

NETWORK
SETTING
PLUG-IN

NETWORK CARD

DEFAUL
T VALUE

DESCRIPTION

Use POP or - Disable Specifies whether to use E-mail
Protocol SMTP reception function. Select the
protocol to use.

POP POP - 0.0.0.0 Specifies the POP server name.
Server Server Enter the domain name or IP
Name address.
POP User POP - (NULL) Sets a user ID to access the
ID Server POP server.

UserID
POP POP - (NULL) Sets a password to access the
Password Server POP server.

Password
APOP Use APOP - Disable Specifies whether to use APOP.
Support
POP Port POP Port - 110 Specifies the port number to
Number Number access the POP server.

Advanced network settings > 77




TELNET

CONFIG.
TOOL

NETWORK
SETTING
PLUG-IN

NETWORK CARD

DEFAUL
T VALUE

DESCRIPTION

POP POP - None Specifies the method to encrypt
Encryption Encryption POP communication.
Algorithm
POP MailPolling - 5 (mins) Specifies the interval to access
Receive Time (min) the POP server to receive E-
Interval mails.
Domain Domain - Disable Specifies whether to use
Filter filter domain filtering.
Email from | Filter - Accept Specifies whether to accept or
the Policy block E-mails from the specified
following domain.
listed
domains
Domain Domain - (NULL) Specifies a domain to apply
1-5 1-5 domain filtering.
SMTP Port - 25 Specifies the port number to
Receive Number access the machine via SMTP.
Port
Number
E-MAIL ALERT
DEFAULT DESCRIPTION
VALUE
TELNET CONFIG. NETWORK CARD
TOOL
NETWORK
SETTING
PLUG-IN
Address 1-5 | Email - (NULL) Specifies the destination E-
Address 1-5 mail addresses. You can
specify up to 5 destinations.
Way of E- Notify Mode | - Upon Specifies when to notify you
mail 1-5 occurrence | of an error.
Alerting of an event
E-mail Alert | Email Alert - 24 (Hours) Specifies the interval of the E-
Interval Interval mail alert. Valid only when the
(Hours) 1-5 periodical alert is specified.
Consumable | Consumable | - Immediate Specifies whether to notify
Warning Warning you of a warning on
Event 1-5 consumables. Valid only when
the alert in the event of an
error is selected.
Consumable | Consumable | - Enable Specifies whether to notify
Warning Warning you of a warning on
Period 1-5 consumables. Valid only when
the periodical alert is
selected.
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DEFAULT DESCRIPTION
VALUE
TELNET CONFIG. NETWORK CARD
TOOL
NETWORK
SETTING
PLUG-IN
Consumable | Consumable | - Immediate Specifies whether to notify
Error Error Event you of an error on
1-5 consumables. Valid only when
the alert in the event of an
error is selected.
Consumable | Consumable | - Enable Specifies whether to notify
Error Error Period you of an error on
1-5 consumables. Valid only when
the periodical alert is
selected.
Mainten- Mainten- - 2HOM Specifies whether to notify
ance Unit ance Unit you of a warning on the
Warning Warning maintenance unit. Valid only
Event 1-5 when the alert in the event of
an error is selected.
Mainten- Mainten- - Enable Specifies whether to notify
ance Unit ance Unit you of a warning on the
Warning Warning maintenance unit. Valid only
Period 1-5 when the periodical alert is
selected.
Mainten- Mainten- - Immediate Specifies whether to notify
ance Unit ance Unit you of an error on the
Error Error Event maintenance unit. Valid only
1-5 when the alert in the event of
an error is selected.
Mainten- Maintenance | - Enable Specifies whether to notify
ance Unit Unit Error you of an error on the
Error Period 1-5 maintenance unit. Valid only
when the periodical alert is
selected.
Paper Paper - OH15M Specifies whether to notify
Supply Supply you of a warning on paper.
Warning Warning Valid only when the alert in
Event 1-5 the event of an error is
selected.
Paper Paper - Enable Specifies whether to notify
Supply Supply you of a warning on paper.
Warning Warning Valid only when the periodical
Period 1-5 alert is selected.
Paper Paper - Immediate Specifies whether to notify
Supply Supply you of an error on paper. Valid
Error Error Event only when the alert in the
1-5 event of an error is selected.
Paper Paper - Enable Specifies whether to notify
Supply Supply you of an error on paper. Valid
Error Error Period only when the periodical alert
1-5 is selected.
Printing Printing - Disable Specifies whether to notify
Paper Paper you of a warning on paper
Warning Warning feed. Valid only when the alert
Event 1-5 in the event of an error is
selected.
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DEFAULT DESCRIPTION
VALUE
TELNET CONFIG. NETWORK CARD
TOOL SETUP
NETWORK
SETTING (WIN.) (MAC)
PLUG-IN
Printing Printing - - - Disable Specifies whether to notify
Paper Paper you of a warning on paper
Warning Warning feed. Valid only when the
Period 1-5 periodical alert is selected.
Printing Printing - - - 2HOM Specifies whether to notify
Paper Error Paper Error you of an error on paper feed.
Event 1-5 Valid only when the alert in
the event of an error is
selected.
Printing Printing - - - Enable Specifies whether to notify
Paper Error Paper Error you of an error on paper feed.
Period 1-5 Valid only when the periodical
alert is selected.
Storage Storage - - - Disable Specifies whether to notify
Device Device you of an error on the storage
Warning Event 1-5 device. Valid only when the
alert in the event of an error
is selected.
Storage Storage - - - Enable Specifies whether to notify
Device Device you of an error on the storage
Warning Period 1-5 device. Valid only when the
periodical alert is selected.
Print Result Print Result - - - Disable Specifies whether to notify
Warning Warning you of a warning on an error
Event 1-5 affecting print results. Valid
only when the alert in the
event of an error is selected.
Print Result Print Result - - - Enable Specifies whether to notify
Warning Warning you of a warning on an error
Period 1-5 affecting print results. Valid
only when the periodical alert
is selected.
Print Result Print Result - - - 2HOM Specifies whether to notify
Error Error Event you of an error affecting print
1-5 results. Valid only when the
alert in the event of an error
is selected.
Print Result Print Result - - - Enable Specifies whether to notify
Error Error Period you of an error affecting print
1-5 results. Valid only when the
periodical alert is selected.
Interface Interface - - - Disable Specifies whether to notify
Warning Warning you of a warning on the
Event 1-5 interface. Valid only when the
alert in the event of an error
is selected.
Interface Interface - - - Disable Specifies whether to notify
Warning Warning you of a warning on the
Period 1-5 interface. Valid only when the
periodical alert is selected.
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TELNET

CONFIG.
TOOL
NETWORK
SETTING
PLUG-IN

NETWORK CARD

SETUP

(WIN.)

DEFAULT
VALUE

DESCRIPTION

Interface Interface - - 2HOM Specifies whether to notify
Error Error Event you of an error on the
1-5 interface. Valid only when the
alert in the event of an error
is selected.
Interface Interface - - Enable Specifies whether to notify
Error Error Period you of an error on the
1-5 interface. Valid only when the
periodical alert is selected.
Security Security - - Disable Specifies whether to notify
Warning Warning you of a warning on the
Event 1-5 security function. Valid only
when the alert in the event of
an error is selected.
Security Security - - Disable Specifies whether to notify
Warning Warning you of a warning on the
Period 1-5 security function. Valid only
when the periodical alert is
selected.
Scanner Scanner - - Disable Specifies whether to notify
Warning Warning you of a warning on the
Event 1-5 scanner. Valid only when the
alert in the event of an error
is selected.
Scanner Scanner - - Disable Specifies whether to notify
Warning Warning you of a warning on the
Period 1-5 scanner. Valid only when the
periodical alert is selected.
Scanner Scanner - - Disable Specifies whether to notify
Error Error Event you of an error on the
1-5 scanner. Valid only when the
alert in the event of an error
is selected.
Scanner Scanner - - Disable Specifies whether to notify
Error Error Period you of an error on the
1-5 scanner. Valid only when the
periodical alert is selected.
Fax FAX - - Disable Specifies whether to notify
Warning?® Warning you of a warning on the fax
Event 1-5 function. Valid only when the
alert in the event of an error
is selected.
Fax FAX - - Disable Specifies whether to notify
Warning? Warning you of a warning on the fax
Period 1-5 function. Valid only when the
periodical alert is selected.
Fax Errord FAX Error - - Disable Specifies whether to notify
Event 1-5 you of an error on the fax

function. Valid only when the
alert in the event of an error
is selected.
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Fax Error@

TELNET

FAX Error
Period 1-5

CONFIG.
TOOL

NETWORK
SETTING
PLUG-IN

NETWORK CARD

DEFAULT
VALUE

Disable

DESCRIPTION

Specifies whether to notify
you of an error on the fax
function. Valid only when the
periodical alert is selected.

Other Error

Other Error
Event 1-5

2HOM

Specifies whether to notify
you of other errors. Valid only
when the alert in the event of
an error is selected.

Other Error

Other Error
Period 1-5

Enable

Specifies whether to notify
you of other errors. Valid only
when the periodical alert is
selected.

a. MC342dn, MC342dw, MC362dn, MC362w, MC562dn, MC562w, MC562dw, ES5462 MFP, ES5462dw MFP and
MPS2731mc only.

SNMP

TELNET

CONFIG.
NETWORK
SETTING
PLUG-IN

NETWORK CARD

DEFAULT
VALUE

DESCRIPTION

Contact to Contact to - (NULL) Specifies the contact
Administra | Admin information of the system
tor administrator up to 225
characters.

Printer Printer - OKI- Sets the machine name up to
Name Name (machine 31 characters.

name)-(last

6 digits of

MAC

address)
Printer Printer - (NULL) Sets the machine location up
Location Location to 255 characters.
Printer Printer - (NULL) Sets the arbitrary number to
Number Asset manage your machine up to 8

Number characters.
SNMP SNMP - SNMPv3+v1l | Specifies the SNMP version.
Mode Version
User Name | User Name | - root Sets the user name in SNMPv3
up to 32 characters.

Authentica | Auth Pass- - (NULL) Sets the password to create an
tion phrase authentication key for SNMPv3
Settings Packet Authentication. From 8
Pass- to 32 characters can be used.
phrase
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VALUE

NETWORK CARD
SETUP

(WIN.)

(MAC)

DESCRIPTION

- Auth Key - - - (NULL) Sets the authentication key for
SNMPv3 packet authentication
in HEX code. Maximum
number of characters differs
depending on the algorithm
you select.

Authentica | Auth - - - MD5 Specifies the algorithm for

tion Algorithm SNMPv3 packet

Settings authentication.

Algorithm

Privacy Privacy - - - (NULL) Sets the password to create a

Settings Pass- privacy key for SNMPv3 packet

Pass- phrase encryption. From 8 to 32

phrase characters can be used.

- Privacy Key | - - - (NULL) Sets the authentication key for
SNMPv3 packet encryption in
HEX code. 16 octets (HEX code
32 characters) can be used.

Privacy Privacy - - - DES Specifies the algorithm for

Settings Algorithm SNMPv3 packet encryption.

Algorithm You cannot change the value.

New SNMP | Read - - - public Sets the read community for

Read Community SNMPv1 up to 15 characters.

Commun-

ity

New SNMP | Write - - - public Sets the write community for

Write Community SNMPv1 up to 15 characters.

Commun-

ity

PRINTER TRAP

TELNET

CONFIG.
TOOL
NETWORK
SETTING
PLUG-IN

DEFAULT

VALUE
NETWORK CARD
SETUP

(WIN.)

(MAC)

DESCRIPTION

Printer Prn-Trap - - - public Sets a community name for a

Trap Commun- printer trap up to 31 characters.

Commun- ity

ity Name

Address TCP #1-5 - - - 0.0.0.0 Specifies a trap destination in

1-5 Trap TCP/IP. You can specify up to 5
Address destinations.

Trap TCP #1-5 - - - Disable Specifies whether to use a

Enable 1-5 | Trap printer trap in TCP #1-5.
Enable
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DEFAULT DESCRIPTION

VALUE
TELNET CONFIG. NETWORK CARD
TOOL SETUP
NETWORK
SETTING (WIN.) (MAC)
PLUG-IN
Printer TCP #1-5 - - - Disable Specifies whether to send an
Reboot 1-5 | Printer SNMP message when the
Reboot machine has rebooted.
Trap
Receive TCP #1-5 - - - Disable Specifies whether to use a trap
Illegal Receive when a community name other
Packet 1-5 Illegal Trap than the one set in Printer Trap

Community Name is used to
access the machine.

Online 1-5 | TCP #1-5 - - - Disable Specifies whether to send an
Online SNMP message every time the
Trap machine comes online.
Offline 1-5 | TCP #1-5 - - - Disable Specifies whether to send an
Offline SNMP message every time the
Trap machine goes offline.
Paper Out TCP #1-5 - - - Disable Specifies whether to send an
1-5 Paper Out SNMP message when the
Trap machine runs out of paper.
Paper Jam TCP #1-5 - - - Disable Specifies whether to send an
1-5 Paper Jam SNMP message when the paper
Trap jams.
Cover TCP #1-5 - - - Disable Specifies whether to send an
Open 1-5 Cover SNMP message every time the
Open Trap machine’s cover opens.
Printer TCP #1-5 - - - Disable Specifies whether to send an
Error 1-5 Printer SNMP message when an error
Error Trap occurs.
IPX IPX Trap - - - 000000000 | Specifies a trap destination in
Address/ 000; IPX. Specify the value as
Net 00000000 “(network address):(node

address)”. You can specify only
one address.

IPX Trap IPX Trap - - - Disable Specifies whether to use a

Enable Enable printer trap in IPX.

IPX Printer | - - - - Disable Specifies whether to send an

Reboot SNMP message when the
machine has rebooted.

IPX - - - - Disable Specifies whether to use a trap

Receive when a community name other

Illegal than the one set in Printer Trap

Packet Community Name is used to

access the machine.

IPX Online IPX Online - - - Disable Specifies whether to send an
Trap SNMP message every time the
machine comes online.
IPX Offline | IPX Offline | - - - Disable Specifies whether to send an
Trap SNMP message every time the

machine goes offline.
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SETUP

(WIN.)

(MAC)

DEFAULT
VALUE

DESCRIPTION

IPX Paper IPX Paper - - - Disable Specifies whether to send an

Out Out Trap SNMP message when the
machine runs out of paper.

IPX Paper IPX Paper - - - Disable Specifies whether to send an

Jam Jam Trap SNMP message when the paper
jams.

IPX Cover IPX Cover - - - Disable Specifies whether to send an

Open Open Trap SNMP message every time the
machine’s cover opens.

IPX Printer | IPX Printer | - - - Disable Specifies whether to send an

Error Error Trap SNMP message when an error
occurs.

IPP

TELNET

CONFIG.
TOOL
NETWORK
SETTING
PLUG-IN

NETWORK CARD

SETUP

(WIN.)

(MAC)

DEFAULT
VALUE

DESCRIPTION

1PP - - - - Disable Specifies whether to use IPP.

Message - - - - (NULL) Enter a message according to

from the language selected in

admin- Charset and Language.
istrator

Charset - - - - UTF-8 Specifies a character set to use
when submitting settings to the
machine.

Language - - - - EN-US Specifies the language used in
the settings containing text
strings.

Authentic - - - - NONE Specifies whether to use

ation authentication when performing
IPP printing.

User - - - - (NULL) If you select BASIC in

Name Authentication, specify a user

1-50 name up to 63 characters.

Password - - - - (NULL) If you select BASIC in

1-50 Authentication, specify a

password up to 16 characters.
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WINDOWS RALLY

DEFAULT DESCRIPTION
VALUE
TELNET CONFIG.T NETWORK CARD
OOL SETUP
NETWORK
SETTING (WIN.) (MAC)
PLUG-IN
WSD Print | WSD Print | - - - Enable Specifies whether to use WSD
Print.
WSD Scan | WSD Scan | - - - Enable Specifies whether to use WSD
Scan.
LLTD LLTD - - - Enable Specifies whether to use LLTD.
IEEE802.1X
DEFAULT DESCRIPTION
VALUE
TELNET CONFIG. NETWORK CARD
TOOL SETUP
NETWORK
SETTING (WIN.) (MACQC)
PLUG-IN

IEEE802.1X | 802.1X - - - Disable Specifies whether to use
IEEE802.1X.

EAP Type EAP Type - - - EAP-TLS Specifies the EAP method.

EAP User EAP User - - - (NULL) Specifies the user name to be
used for EAP up to 64
characters.

EAP EAP - - - (NULL) Specifies the password to be

Password Password used for an EAP user up to 64
characters. Valid only when
PEAP is selected in EAP
Type.

Client Use SSL. - - - NO Specifies whether to use an

Certificate Certificate SSL/TLS certificate to

Setting IEEE802.1X authentication.
It is unavailable when no
SSL/TLS certificate is
installed. Valid only when
EAP-TLS is selected.

CA Authentica | - - - YES Specifies whether to

Certification | te Server authenticate a certificate

Setting from the RADIUS server by a
CA certificate.

- EAP retry - - - 3 Specifies the number of
retries of IEEE802.1X
authentication.

- EAP - - - 40 Specifies the timeout value to

timeout wait for the server response
during IEEE802.1X
authentication.
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SECURE PROTOCOL SERVER (KERBEROS)

DEFAULT DESCRIPTION
VALUE

TELNET CONFIG. NETWORK CARD

TOOL SETUP

NETWORK

SETTING (WIN.) (MAC)
PLUG-IN

Domain Domain - - - (NULL) Specifies the realm name for
Name Kerberos authentication.

LDAP

DEFAULT DESCRIPTION
VALUE
TELNET CONFIG. NETWORK CARD

TOOL SETUP

NETWORK

SETTING (WIN.) (MAC)

PLUG-IN

LDAP LDAP - (NULL) Specifies the LDAP server
Server Server name. Enter the domain name
or IP address.
Port LDAP Port - 389 Specifies the port number of
Number Number the LDAP server.
Timeout LDAP - 30 Specifies the timeout value to
Timeout wait for the LDAP server
response.
Max. Max Entry - 100 Specifies the maximum search
Entries results.
Search Search - (NULL) Specifies where to search
Root Root (BaseDN) in LDAP search.
UserName | UserName | - cn Specifies the attribute name
1 1 searched for as the user name.
UserName | UserName | - sn
2 2
UserName | UserName | - givenName
3 3
Mail Mail - mail Specifies the attribute name
Address Address searched for as the E-mail
address.
Additional Additional - (NULL) Specifies additional filters for
Filter Filter LDAP search.
Method Authentica | - Anonymous | Specifies the authentication
tion method for LDAP server.
Method
User ID Authentica | - (NULL) Sets a user ID to access the
tion User LDAP server.
D
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TOOL
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PLUG-IN

DEFAULT
VALUE
NETWORK CARD
SETUP

(WIN.) (MAC)

DESCRIPTION

Password Authentica | - - - (NULL) Sets a password to access the
tion User LDAP server.
Password

Encryption | Encryption | - - - None Specifies the method to encrypt
Algorithm LDAP communication.

MAIL SERVER

TELNET

CONFIG.
TOOL
NETWORK
SETTING
PLUG-IN

DEFAULT
VALUE
NETWORK CARD
SETUP

(WIN.)

(MAC)

DESCRIPTION

SMTP SMTP - - - (NULL) Specifies the SMTP server name.
Server Server Specify the domain name or IP
Name address.
Be sure to configure DNS settings
when you enter a domain name.
SMTP Port SMTP Port - - - 25 Specifies the SMTP port number.
Number Number
SMTP SMTP - - - None Specifies the method for
Encryption | Encryption encrypting the SMTP (E-mail)
Algorithm send protocol.
POP3 POP3 - - - (NULL) Specifies the POP server name.
Server Server Enter the domain name or IP
address.
POP3 Port POP port - - - 110 Specifies the port number to
number access the POP server.
POP POP - - - None Specifies the method to encrypt
Encryption Encryption POP communication.
Algorithm
Authentica | SMTP Auth | - - - None Specifies whether to perform
tion SMTP authentication.
method
SMTP User ID - - - (NULL) Sets a user ID for SMTP
UserID authentication method.
SMTP User - - - (NULL) Sets a password for SMTP
Password Password authentication.
POP POP3 - - - (NULL) Sets a user ID to access the POP
UserID Server server.
UserID
POP POP3 - - - (NULL) Sets a password to access the
Password Server POP server.
Password
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SECURITY

TELNET

CONFIG.
TOOL
NETWORK
SETTING
PLUG-IN

NETWORK CARD

SETUP

(WIN.)

(MAC)

DEFAUL
T VALUE

DESCRIPTION

- TCP/IP - - - Enable Specifies whether to use TCP/IP.
NetBEUI NetBEUI - - - Disable Specifies whether to use
NetBEUI.
NetBIOS NetBIOS - - - Enable Specifies whether to use
over TCP over TCP NetBIOS over TCP.
NetWare NetWare - - - Disable Specifies whether to use
NetWare.
EtherTalk EtherTalk - - - Disable Specifies whether to use
EtherTalk.
Web (Port Web Device Printer Web Page Enable Specifies whether to use the web
No.: 80) (Default Settings Web Page Settings page to access the machine.
Port 80) (Web)- -Enable
Enable
Web Web (IPP) - - - 80 Specifies the port number to
access the web page of the
machine.
IPP (Port IPP - - - Disable Specifies whether to use IPP.
No.: 631) (Default
Port 631)
Telnet Telnet - - - Disable Specifies whether to use TELNET
to access the machine.
FTP FTP - - - Disable Specifies whether to use FTP to
access the machine.
SNMP SNMP - - - Enable Specifies whether to use SNMP
to access the machine.
POP POP (E- - - - Disable Specifies whether to use POP3.
mail)
POP POP - - - 110 Specifies the port number for
POP3.
SNTP SNTP - - - Disable Specifies whether to use SNTP.
Local Ports | Local Ports | - - - Enable Specifies whether to use a
unique protocol.
- SMTP - - - Enable Specifies whether to use SMTP
(E-mail) send.
SMTP SMTP - - - 25 Specifies the port number for
Send Port Send SMTP send.
Number
SMTP SMTP - - - 25 Specifies the port number for
Receive Receive SMTP receive.
Port
Number

Advanced network settings > 89




TELNET

CONFIG.
TOOL
NETWORK
SETTING
PLUG-IN
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SETUP

(WIN.)

(MAC)

DEFAUL
T VALUE

DESCRIPTION

Network
Password
Configur-
ation

Password

Change
Password

Change
Password

Change
Password

Last 6
digits of
MAC
address

Sets a new administrator
password up to 15 characters.
The password is case-sensitive.
This password is used only when
you change settings from the
utilities. The administrator
password set in the machine
cannot be changed from this
item.

IP FILTERING

TELNET

CONFIG.
TOOL
NETWORK
SETTING
PLUG-IN

NETWORK CARD

SETUP

(WIN.)

(MAC)

DEFAULT
VALUE

DESCRIPTION

IP Filtering | IP Filtering | - - - Disable Specifies whether to use IP filtering.
Be sure to configure the following
settings of this category when you
enable IP filtering.

If you do not, you cannot access the
machine via TCP/IP at all.

Start Start - - - 0.0.0.0 Specifies IP addresses which are

Address Address allowed to access the machine. You

1-10 #1-10 can specify an individual address or
an address range.

End End - - - 0.0.0.0

Address Address

1-10 #1-10

Printing IP Address | - - - Disable Specifies whether to allow print jobs

1-10 Range #1- from specified IP addresses.

10 Print
Config IP Address | - - - Disable Specifies whether to allow the
1-10 Range #1- configuration from specified IP
10 addresses.
Configur-
ation

Administra | Admin IP - - - 0.0.0.0 Specifies the administrator IP

tor’s IP Address address automatically. Only this

Address address can always access the

setting machine.

When the administrator accesses
the machine via a proxy server, all
access via the proxy server is
allowed.
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MAC ADDRESS FILTERING

DEFAULT DESCRIPTION
VALUE
TELNET CONFIG. NETWORK CARD
TOOL SETUP
NETWORK
SETTING (WIN.) (MAC)
PLUG-IN
MAC MAC - - Disable Specifies whether to use MAC
Address Address address filtering. This function uses
Filtering Filtering Ethernet addresses for filtering. Be
sure to configure the following
settings of this category when you
enable MAC address filtering.
If not, you cannot access the
machine via a network at all.
Communic | MAC - - Accept Specifies whether to accept or
ation from Address block the access from specified
the Access MAC addresses.
following
MAC
Addresses
MAC MAC - - 00:00:00:0 | Specifies MAC addresses to which
Address Address 0:00:00 the filtering is applied.
1-50 #1-50
Administra | Admin - - 00:00:00:0 | Specifies the administrator MAC
tor’'s MAC MAC 0:00:00 address automatically. Only this
Address Address address can always access the
setting machine.
When the administrator accesses
the machine via a proxy server, all
access via the proxy server is
allowed.
SSL/TLS
DEFAULT DESCRIPTION
VALUE
TELNET CONFIG. NETWORK CARD
TOOL SETUP
NETWORK
SETTING (WIN.) (MACQC)
PLUG-IN
SSL/TLS Cipher - - - OFF Specifies whether to encrypt
(SSL/TLS) SSL/TLS communication.
Cipher - - - - Standard Specifies the strength of the
Level encryption.
HTTP/IPP HTTP/IPP - - - OFF Specifies whether to encrypt
reception via HTTP/IPP.
HTTP/IPP HTTP/IPP - - - Standard Specifies the strength of the
Cipher Cipher encryption of reception via
Level Strength HTTP/IPP.
Setting
FTP FTP - - - Disable Specifies whether to encrypt
Receive Receive reception via FTP.
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NETWORK

SETTING
PLUG-IN

(WIN.) (MAC)

DESCRIPTION

FTP FTP - - - Standard Specifies the strength of the

Receive Receive encryption of reception via

Cipher Cipher FTP.

Level Strength

Setting

SMTP SMTP - - - OFF Specifies whether to encrypt

Receive Receive reception via SMTP.

SMTP SMTP - - - Standard Specifies the strength of the

Receive Receive encryption of reception via

Cipher Cipher SMTP.

Level Strength

Setting

Certificate - - - - Using self- Creates a self-signed

Type signed certificate. And also creates a

Certificate CSR to send to a certificate

authority and installs a
certificate issued by it.

Common - - - - (Machine’s The machine’s IP address is

Name IP Address) | specified when you create a
self-signed certificate.

Organizati - - - - (NULL) Specifies the official

on organization name you belong
to up to 64 characters.

Organizati - - - - (NULL) Specifies the sub-group name

onal Unit such as a branch you belong
to up to 64 characters.

Locality - - - - (NULL) Specifies the country or
region name you are in up to
128 characters.

State/ - - - - (NULL) Specifies the state or province

Province name you are in up to 128
characters.

Country/ - - - - (NULL) Specifies the country or

Region region code in 2 characters.

Key - - - - RSA Specifies the key method for

Exchange encrypted communication.

method

Key size - - - - 1024bit Specifies the key size for

encrypted communication.
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IPSEC

CONFIG.
TOOL

NETWORK
SETTING
PLUG-IN

NETWORK CARD

DEFAULT
VALUE

DESCRIPTION

IPSec - Disable Specifies whether to use IPSec.

IP Address - 0.0.0.0 Specifies the host allowed to

1-50 communicate in IPSec.

IKE - 3DES-CBC Specifies the IKE encryption

Encryption method.

Algorithm

IKE Hash - SHA-1 Specifies the IKE Hash method.

Algorithm

Diffie- - Group2 Specifies the Diffie-Hellman

Hellman group for “Phrase 1 Proposal”.

Group

LifeTime - 28800 Specifies the life time for

(seconds) “ISAKMP SA”.

Pre- - (NULL) Specifies the pre-shared key.

Shared

Key

Key PFS - NOPFS Specifies whether to use Key
PFS (Perfect Forward Secrecy).

Key PFS - None Specifies the Diffie-Hellman

Diffie- group for Key PFS.

Hellman

Group

ESP - Enable Specifies whether to use ESP
(Encapsulating Security
Payload).

ESP - 3DES-CBC Specifies the encryption

Encryption algorithm for ESP.

Algorithm

ESP - SHA-1 Specifies the authentication

Authentica algorithm for ESP.

tion

Algorithm

AH - Enable Specifies whether to use AH
(Authentication Header).

AH - SHA-1 Specifies the authentication

Authentica algorithm for AH.

tion

Algorithm

LifeTime - 3600 Specifies the life time for

(seconds) “IPSec SA".
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MAINTENANCE

TELNET

CONFIG.

TOOL
NETWORK
SETTING
PLUG-IN

NETWORK CARD

DEFAULT
VALUE

DESCRIPTION

Reset Reset - No Select to reset Network Card.

Network Network

Card Card

Reset Restore - No Select to restore the factory

Network Network default settings.

Card to Card to

Factory Factory

Defaults Defaults

Network LAN Scale - Normal Use the default value. SMALL

Scale Setting is recommended only when
you use a small LAN to which a
few computers are connected.

Network - - RAW Specifies the format of

PS- PostScript data for the

Protocol network port.

HEX Dump | HEXDump | - NO Specifies whether to show the

Mode received print data in

hexadecimal number.
Restarting the machine
disables this mode.

HUB Link HUB Link - AUTO Specifies the speed and

Setting Setting NEGOTIAT- method of communication

ION between the hub and the

machine.

TCP ACK - - Typel Normally do not change the

settings.

TIME SETUP (SNTP SETTINGS)

DEFAULT DESCRIPTION
VALUE
TELNET CONFIG. NETWORK CARD
TOOL SETUP
NETWORK
SETTING (WIN.) (MAC)
PLUG-IN
Time - - - - Manual Specifies how to set date and
Setup time, manually or
automatically.
SNTP NTP - - - (NULL) Specifies the IP address of the
Server Server primary NTP server to get the
(Primary) (Pri.) current time.
SNTP NTP - - - (NULL) Specifies the IP address of the
Server Server secondary NTP server to get
(Second- (Sec.) the current time.
ary)
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TELNET

CONFIG.
TOOL
NETWORK
SETTING
PLUG-IN

DEFAULT
VALUE

NETWORK CARD
SETUP

(WIN.) (MAC)

DESCRIPTION

Time Zone | Local Time | - - - 00:00 Sets the time lag between GMT
Zone and your local time.

Set Daylight - - - OFF Sets daylight saving time.

Daylight Saving

Saving

WEB PRINTING

DEFAULT DESCRIPTION
VALUE
TELNET CONFIG. NETWORK CARD
TOOL SETUP
NETWORK
SETTING (WIN.) (MACQ)
PLUG-IN
Paper tray - - - - Tray 1 Specifies the tray to be used for
print jobs.
Copies - - - - 1 Specifies the number of copies.
Collate - - - - Disable Specifies whether to collate the
output.
Fit to page | - - - - Enable Specifies whether to fit the
document size to the paper size.
Duplex - - - - None Specifies whether to and how to
printing bind a duplex job.
Page - - - - Disable Specifies the pages to be
Select printed.
PDF - - - - Disable Select this item and enter the
Password password necessary when you
print an encrypted PDF file.
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CONFIGURING THE WIRELESS LAN FROM THE WEB PAGE (MC342dw, MC362w,
MC562w, MC562dw, ES5462dw MFP, MPS2731mc ONLY)

This section explains how to set the wireless LAN settings change the network settings from
the machine's web page.

To access the machine's web page, your computer must meet the following conditions:
e TCP/IP is enabled.

e Microsoft Internet Explorer 6.0 or later, Safari 3.0 or later, or Firefox 3.0 or later is
installed.

MEMO
> Ensure that the security setting of the web browser is set to a middle level,
or that cookies are allowed.

> To enter the Admin Setup menu, it is necessary to log in as the
administrator. The factory default administrator password is "aaaaaa".

REFERENCE
Some of the following settings can be performed on other utilities. For
details, refer to "Network setting items" on page 71.

In order to configure from the Web, it is necessary to have completed the settings for wired
or wireless network connection.

NOTE
If WPA-EAP or WPA2-EAP is set for the security method, the settings from the
IEEE802.1x menu need to be set beforehand.

IEEE802.1X SETTINGS
1. Access the machine's web page and log in as the administrator.
The user name is "root", and the default password is "aaaaaa".
2. Click the IEEE802.1X tab.
Using EAP-TLS:
a) Select Disable for IEEES802.1X.
b) Select EAP-TLS for the EAP Type.
c) Enter a user name in EAP User.

d) Select Do not use SSL/TLS Certificate for EAP authentication and then click
Import.

e) Enter the file name of the certificate. Only a PKCS#12 file can be imported.
f) Enter the password of the certificate and then click OK.

g) Select Authenticate Server and then click Import.

h) Enter the file name of the CA certificate and then click OK.

i) Specify the certificate issued by the certificate authority, which is the certificate
authority from which the RADIUS server obtained the certificate. A PEM, DER, and
PKCS#7 file can be imported.

j) Click Send.

k) When the main unit comes online, proceed to "Wireless LAN settings".
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NOTE
When WPA-EAP or WPA2-EAP is set for the security method and EAP-TLS is
selected as the EAP Type, Not authenticate Server cannot be selected.

Using PEAP:

a) Select Disable for IEEES802.1X.

b) Select PEAP for the EAP Type.

c) Enter a user name in EAP User.

d) Enter the password in EAP Password.

e) Select Authenticate Server and then click Import.

f) Enter the file name of the CA certificate and then click OK.

g) Specify the certificate issued by the certificate authority, which is the certificate
authority from which the RADIUS server obtained the certificate. A PEM, DER, and
PKCS#7 file can be imported.

h) Click Send.
i) When the main unit comes online, proceed to "Wireless LAN settings".

WIRELESS LAN SETTINGS

h WM

Log in as the administrator.

Click the Network Manager tab.

Click the Wireless LAN Settings menu.

In the Basic Settings field under Network Connection, select Wireless.

Basic Settings
Network Connection

SSID

MEMO
The default is "Disabled".

Enter the SSID name of the wireless AP that you want to connect to in SSID.

Basic Settings

Network Connection Wireless |+

SSID ( ]_-32 characters)

MEMO
"default" is set as the default.

In the Security method, select the same security setting as the wireless AP that
you want to connect to.

Depending on the selected security method, configure one of the settings from (1)
to (3) below.

When Disable is selected, press the Send button at the bottom left of the Web
screen. (Not recommended for security reasons.)

Security Settings

Security

W
WPA-PSK
WPRAZ-PSK
WPA-EAP
WPA2-EAP
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MEMO
The default is "Disable”.

(1) When WEP is selected:

a) When WEP is selected, WEP KEY is displayed.
Enter the same KEY as the WEP KEY set for the wireless AP that you want to
connect to.

Security WEP i

WEP Key ( ]

NOTE
There is not setting for the WEP KEY index. The WEP KEY index
communications with the wireless AP as 1.

MEMO
After entering the KEY, the key is displayed as "*" symbols for security reasons.

(2) When WPA-PSK or WPA2-PSK is selected:

a) When WPA-PSK or WPA2-PSK is selected, Encryption type and Pre Shared
Key are displayed.

b) In Encryption type, select the encryption type (TKIP or AES) set in the wireless
AP that you want to connect to.

Security Settings

Security WPA-PSK ||
WPA Encryption Type AES v
TKIP
WPA Pre-shared Key AES
MEMO

The default is "TKIP".
Depending on the model of wireless AP, the mixed TKIP/AES may be
supported. In this case, we recommend using AES.

¢) In Pre Shared Key, enter the same KEY as the Pre Shared KEY set for the
wireless AP that you want to connect to.

Security Settings

Security WPA-PSK |v|

WPA Encryption Type TKIP ||

WPA Pre-shared Key ( ]

MEMO
After entering the KEY, the key is displayed as "*" symbols for security reasons.

(3) When WPA-EAP or WPA2-EAP is selected:
a) When WPA-EAP or WPA2-EAP is selected, Encryption type is displayed.
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b) In Encryption type, select the encryption type (TKIP or AES) set in the wireless
AP that you want to connect to.

Security WPA-EAP [v]

WPA Encryption Type

When all of the settings for basic settings and security settings are completed, press
the Send button at the bottom left of the Web screen, and the settings are reflected.
It may take up to a minute to connect to the wireless AP. If the connection fails, either
reconfigure the wireless settings from the operation panel, or switch to wired LAN
from the operation panel, and reconfigure the wireless settings from the Web.
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CHANGING NETWORK SETTINGS FROM THE WEB PAGE

This section explains how to change the network settings from the machine’s web page.
This function is available on Windows and Mac.

To access the machine’s web page, your computer must meet the following conditions:
> TCP/IP is enabled

> Microsoft Internet Explorer 6 or later, Safari 3.0 or later, or Firefox 3.0 or later is
installed

> Be sure that the security setting for a web browser is set to the middle level or
cookies are allowed.

> To enter the Admin Setup menu, the administrator password is necessary. The
default password is “aaaaaa”.

NOTE
Some of the following settings can be performed on other utilities. For details,
"Network setting items" on page 71.

ENCRYPTING COMMUNICATION BY SSL/TLS
You can encrypt the communication between your computer and the machine.

The communication is encrypted by SSL/TLS when you change the machine settings from
the web page, perform the IPP printing, direct print, or LDAP search, and print data
received via SMTP or FTP.

Creating a certificate
You can create a certificate on the web page. The following two certificates are available:

> A self-signed certificate

> A certificate created by a certificate authority

NOTE

If you change the machine IP address after you create a certificate, the
certificate becomes invalid. Be sure not to change the machine’s IP address
after creating a certificate.

1. Access the machine’s web page and log in as the administrator.
2. Select Admin Setup.
3. Select Network > Security > SSL/TLS.
4, Follow the on-screen instructions to specify the detailed settings.
NOTE
The machine’s IP address is set to Common Name.
5. Click OK.

6. Check the settings and click OK.

7. If you are creating a self-signed certificate, go to "Enabling encryption" on page 101
to enable encryption.
If you are getting a certificate created by a certificate authority, go to step 8.

8. Follow the on-screen instructions to send a CSR to a certificate authority.
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10.

11.
12,
13.

Click Export Certificate.

Perform steps 1 to 3 in "Creating a certificate" on page 100 to enter the encryption
screen.

Follow the on-screen instructions to install a certificate from the certificate authority.
Click Submit.

Go to "Enabling encryption” on page 101 to enable encryption.

Enabling encryption

After you creating a certificate, perform the following procedure to enable encryption.

When you enable encryption, the communication is encrypted the next time you change
the settings from the web page.

Access the machine’s web page and log in as the administrator.
Select Admin Setup.

Select Network > Security > Protocol ON/OFF.

Select Enable for the desired protocol.

Click Submit.

Launching the web page

1.
2.

Launch a web browser.

Type the IP address of the MFP in the URL field of your browser and then press
Enter. For example http://10.18.207.102

2 MC562 - Microsoft Internet Explorer. [BEES
Fie Edt View Favorites Took Hep i

O - O NRAG P oo @3- 2B LE 3B

adres: | ] hetp:J}192.168.10.18) R

View Info | Direct Print | Links
view Information

o) 200
Device Name OKI-MC562-D2DB49 N — )
| —
8 Counter IP Address 102.168.10.18 oy €0
e T e
O Supplies Life MAC Address 00:80:87:D2:08: 49
Network Location [r—— Enabled
Doystem Serial Number AK18041089 e )
Lot Number e @
Asset Number 1234567890123456789 == e
Administrator Login Gontact Name PP
- Administrator ©
Netware
@®
P i PServer
Netware
MP Tra a4
; v i RPrinter o
Duplex Installe
P EtherTalk @]
SD Memory Card Installed
NetBEUI O
Memory 256 Me
Setting Service Enabled
version Information
SAMP ¢}
cu 02.26
WEB @
U 40.07.03
Telnet @]
Network Firmware 0004
NetBEUI @
Web Remote 00.02
Web Language 00.03
Copuright ©2011 Ol Data Corporation. All fights reserved
& pane

aes | EIRIT-5
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IPP PRINTING

IPP printing allows you to transmit your print job data from your computer to the machine
via the Internet.

NOTE

The following OSs are supported; Windows 8, Windows Server 2012, Windows
7, Windows Server 2008 R2, Windows Server 2008, Windows Vista, Windows
Server 2003, and Windows XP.

This procedure uses Windows 7 as an example. The procedures and menus
may differ depending on the OS you use.

Enabling IPP Printing

IPP printing is disabled by factory default. To perform IPP printing, enable IPP first.
1. Access the machine’s web page and log in as the administrator.

Select Admin Setup.

Select Network > IPP.

Select Enable.

Click Submit.

ui kW

Setting up your machine as an IPP printer (for Windows Only)
Add your machine as an IPP printer to your computer.
1. Click Start and select Devices and Printers > Add a printer.

2. Select Add a network, wireless or Bluetooth printer on the Add Printer wizard.

3. In the list of available printers, select The printer that I want isn't listed.

4. Choose Select a shared printer by name.

5. Enter “https://your machine IP address/ipp” or “https://your machine IP
address/ipp/Ip" and then click Next.

6. Click Have Disk.

7. Insert the DVD that was supplied with your machine into the DVD-ROM drive.

8. Enter the following value in Copy from:
> For PCL driver, “"D:\Drivers\_PCL".
> For PS driver, "D:\Drivers\PS".
> For PCL XPS driver, “"D:\Drivers\XPS".

NOTE
The values above are the example of when the DVD-ROM drive is set to the
D drive.

9. Click OK.

10. Select the desired printer and click OK.

11. Select Yes in Use this printer as default and click Next.

12. If the Share this printer wizard appears, select Do not share and then click Next.
13. Select No in Print test page? and click Next.

14. Click Finish.
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15. On the Hardware Install screen, click Continue.

16. When the installation finishes, print a test page.

Setting up your machine as an IPP printer (for Mac OS X Only)

Add your machine to your computer as an IPP printer.

OO NOWmAEWUNRE

[y
©

11.

Insert the software DVD-ROM into the computer and install the driver.
Select System Preferences from the Apple menu.

Click Print and Fax.

Click +.

Click the IP tab.

From Protocol, select IPP (Internet Printing Protocol).

Enter the machine's IP address in Address.

Enter "ipp/Ip" in Queue.

Click Add.

Click Continue.

Confirm that the machine is registered in Print and Fax.

Performing IPP printing

NOTE
The following procedure is explained using NotePad as an example. The
procedures and menus may differ depending on the application you use.

Open an application file.
From the File menu, select Print.

From Select Printer, select the created IPP printer and then click Print.
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ENCRYPTING COMMUNICATION BY IPSEC
You can encrypt the communication between your computer and the machine.

The communication is encrypted by IPSec. When IPSec is enabled, encryption is applied to
all the applications using the IP protocols.

You can specify up to 50 hosts by their IP addresses. When a host that is not registered
tries to access the machine, it is rejected. When you try to access a host that is not
registered, it is invalid.

You must have a pre-shared key in advance.

Configuring your machine

Be sure to configure your machine first from the web page to enable IPSec.

NOTE
> When you enable IPSec, the communication to and from a host that is not
specified in this procedure is rejected.

> Be sure to memorize the values specified in this procedure. They are
necessary when you configure the IPSec setting on your computer.

Access the machine’s web page and log in as the administrator.
Select Admin Setup.
Select Network > Security > IPSec.

h WM

Follow the on-screen instructions to specify the detailed settings.

NOTE
Either ESP or AH must be enabled in the configuration for "Phase2 Proposal”.

5. Click Submit.

The network system reboots to enable the new settings.

NOTE

If you fail to set up IPSec due to the mismatch of the specified parameter, you
cannot access the web page. In this case, disable IPSec from the control panel
of the machine or initialize the network settings.

Configuring your computer

Be sure to configure your machine in advance before configuring your computer.

NOTE
This procedure uses Windows 7 as an example. The procedures and menus
may differ depending on the OS you use.

1. Click Start and select Control Panel > Administrative Tools.
2. Double-click Local Security Policy.

3. On the Local Security Policy window, click IP Security Policies on Local
Computer.

4. From the Action menu, select Create IP Security Policy.
5. On the IP Security Policy Wizard, click Next.
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10.
11.

12,
13.
14.

15.
16.
17.
18.
19.
20.
21.

22,

23.
24.
25.
26.
27.
28.
29.
30.
31.
32.

33.

Enter a Name and a Description and then click Next.

Clear the Activate the default response rule (earlier versions of Windows
only). check box and then click Next.

Select Edit properties and then click Finish.
On the IP security policy properties window, select the General tab.
Click Settings.

On the Key Exchange Settings window, enter the value (minutes) in
Authenticate and generate a new key after every.

NOTE

Specify the same value as Life time specified in the configuration for "Phasel
Proposal” in "Configuring your machine" on page 104. Although Life time is
specified by seconds, enter a value by minutes in this step.

Click Methods.
On the Key Exchange Security Methods window, click Add.

Specify Integrity algorithm, Encryption algorithm, and Diffie-Hellman group.

NOTE

Select the same value specified in IKE Encryption Algorithm, IKE Hash
Algorithm, and Diffie-Hellman group in the configuration for "Phasel
Proposal” in "Configuring your machine" on page 104.

Click OK.

On the Key Exchange Security Methods window, click OK.

On the Key Exchange Settings window, click OK.

On the IP security policy properties window, select the Rules tab.
Click Add.

On the Security Rule Wizard, click Next.

On the Tunnel Endpoint screen, make sure that This rule does not specify a
tunnel is selected and then click Next.

On the Network Type screen, make sure that All network connections is
selected and then click Next.

On the IP Filter List screen, click Add.

On the IP Filter List window, click Add.

On the IP Filter Wizard, click Next.

On the IP Filter Description and Mirrored Property screen, click Next.
On the IP Traffic Source screen, click Next.

On the IP Traffic Destination screen, click Next.

On the IP Protocol Type screen, click Next.

Click Finish.

On the IP Filter List wizard, click OK.

On the Security Rule Wizard, select the new IP filter from the list and then click
Next.

On the Filter Action screen, click Add.
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34.
35.

36.

37.

38.
39.

40.
41.
42.

43.

44.
45.
46.

47.
48.
49.
50.
51.
52.

On the Filter Action Wizard, click Next.

On the Filter Action Name screen, enter a Name and a Description and then click
Next.

On the Filter Action General Options screen, make sure that Negotiate security
is selected and then click Next.

On the Communicating with computers that do not support IPsec screen,
make sure that Do not allow unsecured communication. is selected and then
click Next.

On the IP Traffic Security screen, select Custom and then click Settings.

On the Custom Security Method Settings window, configure the settings and
then click OK.

NOTE
Select the same values specified in the configuration for "Phase2 Proposal” in
"Configuring your machine" on page 104.

On the IP Traffic Security screen, click Next.
Select Edit properties and then click Finish.

On the filter action properties window, select Use session key perfect forward
secrecy (PFS) if you want to enable Key PFS.

Select Accept unsecured communication, but always respond using IPsec if
you perform IPSec communication by the IPv6 global address.

Click OK.
Select the new filter action and then click Next.

On the Authentication Method screen, select the value you want and then click
Next.

Click Finish.

On the IP security policy properties window, click OK.

On the Local Security Policy window, select the new IP security policy.

From the Action menu, select Assign.

Make sure that Policy Assigned for the new IP security policy is displayed as Yes.
Click X on the Local Security Policy screen.

Advanced network settings > 106



CONTROLLING ACCESS USING IP ADDRESS (IP FILTERING)

You can control access to the machine using the IP address. You can set whether to allow
configuration or printing from the specified IP addresses. By factory default, IP filtering is
disabled.

NOTE
Be sure to specify the correct IP address. If you specify a wrong IP address,
you cannot access the machine using the IP protocol.

When you enable IP filtering, the access to and from a host that is not specified
in this procedure is rejected.

You can use only IPv4 for IP filtering.

Access the machine’s web page and log in as the administrator.
Select Admin Setup.
Select Network > Security > IP Filtering.

h WM

Follow the on-screen instructions to specify the detailed settings.

NOTE
If nothing is registered in Administrator’s IP Address setting, you may not
be able to access the machine depending on the specified IP address range.

Your Current Local Host/Proxy IP Address and the IP address of your
host may not match if you use a proxy server.

5. Click Submit.

The network system reboots to enable the new settings.

CONTROLLING ACCESS USING MAC ADDRESS (MAC ADDRESS FILTERING)

You can control access to the machine using the MAC address. You can allow or reject the
access from the specified MAC addresses.

NOTE
Be sure to specify the correct MAC address. If you specify the wrong MAC
address, you cannot access the machine via a network.

You cannot individually specify acceptance or rejection for each address.

Access the machine’s web page and log in as the administrator.
Select Admin Setup.
Select Network > Security > MAC Address Filtering.

W N

Follow the on-screen instructions to specify the detailed settings.

NOTE
If nothing is registered in Administrator’s MAC Address setting, you may
not be able to access the machine depending on the specified MAC address.

Your Current Local Host/Proxy MAC Address and the MAC address of
your host may not match if you use a proxy server.

5. Click Submit.

The network system reboots to enable the new settings.
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ERROR NOTIFICATION BY E-MAIL (E-MAIL ALERT)

You can set the machine to send an error notification E-mail when an error happens. You
can set when to be notified:

> On a regular basis

> Only when an error occurs

Configuring your machine

You can configure the settings for E-mail alert using the web page.

NOTE
When you specify a domain name in SMTP Server, configure the DNS server
in the TCP/IP setting.

You need to set the mail server to allow the machine to send an E-mail. For
details on the mail server setting, refer to your network administrator.

When you use Internet Explorer 7, select Tools > Internet Options, click
Custom level on the Security tab, and then select Enable in Allow
websites to prompt for information using scripted windows to send a
test E-mail.

Access the machine’s web page and log in as the administrator.
Select Admin Setup.

Select Network > E-mail > Send Settings.

Follow the on-screen instructions to specify the detailed settings.
Select Set detail of the SMTP Protocol..

If necessary, you can configure Security settings, Configure attached
information, and Others.

7. Click Submit.

The network system reboots to enable the new settings.

ok whNRH

Regular alert

1. Access the machine’s web page and log in as the administrator.
. Select Admin Setup.

. Select Network > E-mail > Alert Settings.

Enter an E-mail address to receive the alerts.

U A W N

Click Setting for the specified address.

Copy is useful when you want to apply the alert conditions to another address.

o

Follow the on-screen instructions to specify the detailed settings.
Click OK.

8. C(Click View a summary of current configuration to check the current settings,
and then click X to close the window.

You can also check the current settings of up to two addresses on the main window.
Select the desired addresses from the list box.

9. Click Submit.
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The network system reboots to enable the new settings.

NOTE
If there is no error specified, the alert E-mail in not sent.

Alert when an error occurs

1. Perform steps 1 to 6 in “Regular alert”.

2. Specify the time lag between when an error occurs and when the alert is sent.
If you specify a longer time, only continuing errors are notified.

3. Click OK.

4. Click View a summary of current configuration to check the current settings,
and then click X to close the window.

You can also check the current settings of up to two addresses on the main window.
Select the desired addresses from the list box.

5. Click Submit.

The network system reboots to enable the new settings.

USING SNMPv3

The SNMPv3 manager supporting SNMPv3 encrypts the management of the machine by
SNMP.

1. Access the machine’s web page and log in as the administrator.
Select Admin Setup.

Select Network > SNMP > Setting.

Follow the on-screen instructions to specify the detailed settings.
Click Submit.

The network system reboots to enable the new settings.

wi s wN

NOTE

Your machine has an SNMP agent. You can check and change the machine
settings by a commercially available SNMP agent. For the MIB of the machine,
refer to the DVD supplied with your machine and check "Readme.text” in the
MISC > Mib folder.
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UsING IPvV6

Your machine supports IPv6. The machine gets an IPv6 address automatically. You cannot
set the IPv6 address manually.

The machine supports the following protocols:
> For Printing:

> LPR

> IPP

> RAW (Port9100)

> FTP
> For Configuration:

> HTTP

> SNMPv1/v3

> Telnet

NOTE
To enter the Admin Setup menu, the administrator password is necessary.
The default password is "aaaaaa”.

The table below shows the protocols that are supported:

PROTOCOL APPLICATION LIMITATIONS

LPD Windows 8 LPR (Command Prompt) *1,2,3
Windows 7
Windows Vista

Windows XP

FTP Windows 8 FTP (Command Prompt) *1,2,3
Windows 7
Windows Vista

Windows XP

Mac 0OS X FTP (Terminal) *1,2,3

HTTP Windows 8 Internet Explorer 6.0/7.0 *1,2,3
Windows 7
Windows Vista

Windows XP

Mac OS X Safari (2.0-v412.2) *1,2,3,4

Telnet Windows 8 Telnet (Command Prompt) | *1, 2, 3
Windows 7
Windows Vista

Windows XP

e Mac OS X FTP (Terminal) *1,2,3

*1) To specify a host name, edit the hosts file or access via the DNS server.
*2) You cannot specify a host name by the DNS server when you enable only IPv6 on Telnet.
*3) You cannot specify a host name when you use a link local address to access.

*4) Enter an IPv6 address enclosed with brackets.

NOTE
To use IPv6 on Windows XP, install IPv6.
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ENABLING IPV6

1. Access the machine’s web page and log in as the administrator.
Select Admin Setup.

Select Network > TCP/IP.

Select Enable for IPv6.

Click Submit.

The network system reboots to enable the new settings.
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CHECKING IPV6 ADDRESS

The IPv6 address is automatically assigned.
1. Select View Info.

2. Select Network > TCP/IP.

NOTE
When the global address is displayed with only “0”, it may be an error due to
the router you use.

You can also check the IPv6 address in the network report from the machine
by pressing the SETTING key and then selecting Reports > System >
Network Information.

UsINnG IEEE802.1X
Your machine supports the IEEE802.1X authentication.

Be sure to set up your machine and computer in advance before performing the following
procedure.

NOTE
For details on the initial setup and the IP address, refer to "Configuring the
network settings" on page 9.

CONFIGURING YOUR MACHINE FOR IEEE802.1X

Using PEAP

Access the machine’s web page and log in as the administrator.
Select Admin Setup.

Select Network > IEEE802.1X.

Select Enable for IEEE802.1X.

Select PEAP for EAP Type.

Enter a user name in EAP User.

Enter a password in EAP Password.

Select Authenticate Server and then click Import.

Enter the file name of the CA certificate and then click OK.

WO NOWmREWNPRE

Specify the certificate issued by the certificate authority from which the RADIUS
server got it. A PEM, DER, and PKCS#?7 file can be imported.
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10. Click Submit.
The network system reboots to enable the new settings.
11. When the standby screen appears on the machine, turn off the machine.

12. Go to "Connecting your machine to authentication switch" on page 112.

Using EAP-TLS

Access the machine’s web page and log in as the administrator.
Select Admin Setup.

Select Network > IEEE802.1X.

Select Enable for IEEE802.1X.

Select EAP-TLS for EAP Type.

Enter a user name in EAP User.

Select Not use SSL/TLS Certificate for EAP authentication and then click
Import.

NouhwhNRe

8. Enter the file name of the certificate.
Only a PKCS#12 file can be imported.
9. Enter the password of the certificate and then click OK.
10. Select Authenticate Server and then click Import.
11. Enter the file name of the CA certificate and then click OK.

Specify the certificate issued by the certificate authority from which the RADIUS
server got it. A PEM, DER, and PKCS#?7 file can be imported.

12. Click Submit.
The network system reboots to enable the new settings.
13. When the standby screen appears on the machine, turn off the machine.

14. Go to "Connecting your machine to authentication switch" on page 112.

CONNECTING YOUR MACHINE TO AUTHENTICATION SWITCH

1. Make sure that the machine is turned off.

2. Connect an Ethernet cable to the network interface port.
3. Connect the Ethernet cable to the authentication port of an authentication switch.
4. Turn on the machine.
5. Set up the machine.
NOTE
l;g; glegt.ails on the initial setup, refer to "Configuring the network settings" on
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CONFIGURING LDAP SERVER

OO NW AR UWNRH

11.
12,

13.

14.
15.

NOTE
For details on the LDAP server and encryption settings to be specified, refer to
your network administrator.

Access the machine’s web page and log in as the administrator.

Select Admin Setup.

Select Network > LDAP.

Enter the domain name or IP address of the LDAP server in LDAP Server.
Enter the port humber of the LDAP server in Port Number.

Specify a value for time-out to wait for the search results in Timeout.
Specify a value for the maximum entry of the search results in Max. Entries.
Specify a BaseDN to access the LDAP server in Search Root.

Enter attribute names to be searched for as the user name in User Name.
Be sure to specify a value for Name 1.

Enter an E-mail address to be searched for in Mail Address.

If necessary, specify a search condition in Additional Filter.

Select the authentication method you want in Method.

> When you select Anonymous or Simple, user authentication using LDAP fails.

You need to select Digest-MD5 or Secure Protocol if you configure the LDAP
server for user authentication.

> When you select Digest-MD5, you need to configure the DNS server setting.

> When you select Secure Protocol, you need to configure the DNS server and the
secure protocol server settings.

If you do not select Anonymous in step 12, specify the user ID and password to log
in to the LDAP server.

Select a value in Encryption.
Click Submit.

The network system reboots to enable the new settings.

CONFIGURING SECURE PROTOCOLS

Authentication using the Kerberos server is available when you access the LDAP server. Be
sure to complete the SNTP and DNS server settings to use the secure protocol.

1.
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Access the machine’s web page and log in as the administrator.
Select Admin Setup.

Select Network > Secure Protocol Server.

Enter a realm name in Domain.

Click Submit.

The network system reboots to enable the new settings.
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PRINTING WITHOUT PRINTER DRIVER (DIRECT PRINTING)

PRINTING PDFs

You can print PDFs without a printer driver. Specify the file you want to print on the web
page and submit it to the machine.

NOTE
> [t may be necessary to install additional RAM in order to print some PDF
files.

> If you have problems printing a PDF file, open the file in Adobe Reader
and print it.

Access the machine’s web page and log in as the administrator.
Select Direct Print.

Select Web Printing.

Follow the on-screen instructions to specify the detailed settings.
Check the settings and then click OK.

Click Print.
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CONFIGURING SERVER TO PRINT FILES ATTACHED TO E-MAILS

You can print attached files when the machine receives an E-mail.

NOTE
> When you have performed the initial setup described in "Configuring the
network settings" on page 9, the server settings are finished.

> Up to 10 files and a maximum of 8 MB for each file can be printed.
PDF, JPEG, and TIFF files can be printed.

> It may be necessary to install additional RAM in order to print some PDF
files.

> If you have problems printing a PDF file, open the file in Adobe Reader
and print it.

\'

Configuration for POP

1. Access the machine’s web page and log in as the administrator.

. Select Admin Setup.

. Select Network > E-mail > Receive Settings.

Select POP3 and then click To STEP2.

Follow the on-screen instructions to specify the detailed settings.

U A W N

NOTE

Be sure to specify the correct value for your mail server. If you enable APOP
when your mail server does not support the APOP protocol, E-mails may not
be correctly received.

When you specify a domain name for the mail server, configure the DNS
server in the TCP/IP setting.
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6.

Click Submit.

NOTE
When the POP server does not support the SSL encryption, E-mails may not
be correctly received.

Configuration for SMTP

1. Access the machine’s web page and log in as the administrator.
2. Select Admin Setup.

3. Select Network > E-mail > Receive Settings.

4. Select SMTP and then click To STEP2.

5. Follow the on-screen instructions to specify the detailed settings.
6. Click Submit.

CHANGING SETTINGS ON ETHERTALK (MAC ONLY)

CHANGING ETHERTALK MACHINE NAME

1.
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Access the machine’s web page and log in as the administrator.
Select Admin Setup.

Select Network > EtherTalk.

Enter a new name in EtherTalk Printer Name.

Click Submit.

CHANGING ETHERTALK ZONE

ui kW

Access the machine’s web page and log in as the administrator.
Select Admin Setup.

Select Network > EtherTalk.

Enter a new zone name in EtherTalk Zone Name.

Click Submit.

NOTE
Be sure to specify a zone in the same segment.
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OTHER OPERATIONS

This section explains how to initialize the network settings and how to setup your machine
and computer to use DHCP.

INITIALIZING NETWORK SETTINGS

NOTE
This procedure initializes all the network settings.

Press the SETTING key.

Using the Down arrow key, scroll to Admin Setup and then press OK.

Enter the administrator password.

Select Enter and then press OK.

Using the arrow keys, scroll to Network Menu and then press OK.

Make sure that Network Setup is selected and then press OK.

Using the arrow keys, scroll to select Factory Defaults and then press OK.
Press OK.

Using the arrow keys, highlight ves to continue or No to exit and then press OK.

OO NWREWUNR

The machine restarts to enable the new settings.

UsiNnG DHCP

You can get an IP address from the DHCP server.

NOTE
> You must be authorized as the administrator.

> If you enter a wrong IP address, the network system may go down.
> You can also get an IP address from the BOOTP server.

CONFIGURING DHCP SERVER
DHCP assigns an IP address to each host on the TCP/IP network.

NOTE

The machine must have a static IP address if you want to print via a network.
For details on how to assign a static IP address, refer to the manual of your
DHCP server.

The following OSs are supported; Windows Server 2008 R2, Windows Server
2008, and Windows Server 2003

The following procedure uses Windows Server 2008 as an example. The
procedures and menus may differ depending on the OS you use.

1. Click Start > Server Manager.

If DHCP Server is already displayed, go to step 8.
2. Select Add Roles on the Roles Summary area.
3. On the Add Roles Wizard, click Next.
4. Select DHCP Server and click Next.
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10.
11.

12,
13.
14.
15.
16.
17.

Follow the on-screen instructions and configure the settings as necessary.

On the Confirm Installation Selections screen, check the settings and click
Install.

When the installation finishes, click Close.

Click Start and select All Programs > Administrative Tools > DHCP to launch
the DHCP wizard.

On the DHCP list, select a server to use.
From the Action menu, select New Scope.

On the New Scope Wizard, follow the on-screen instructions and configure the
settings as necessary.

> Be sure to configure the default gateway settings.

> On the Activate Scope screen, select Yes, I want to activate this scope now.
Click Finish.

Select the new scope from the DHCP list and then select Reservations.

From the Action menu, select New Reservation.

Configure the settings.

Click Add.

Click X to close the DHCP wizard.

CONFIGURING YOUR MACHINE

The following explains how to configure your machine to use DHCP/BOOTP. By factory
default, the DHCP/BOOTP protocol is enabled, so you do not have to perform this

procedure.
NOTE
The following procedure is explained using Network Card Setup and Windows
7 as an example. The procedures and menus may differ depending on the OS
you use.

1. Turn on the machine.
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Turn on your computer.
Insert the Software DVD-ROM into the DVD drive.

The Setup Utility starts automatically. if it does not start, double-click setup.exe (in
the root directory) on the DVD-ROM.

Choose your language.

Select your model and then click Next.

Read the license agreement and click I Agree.

Select Device Configuration > Network Card Setup.
Select your machine from the list.

From the Setting menu, select Setting Printer.

Enter the IP address and then click OK.
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11.

12,

13.

Enter the password for Password and then click OK.

NOTE
The initial password is the last six digits of the Ethernet address.

The password is case-sensitive.

Click OK on the confirmation window.

The machine restarts to enable the new settings. During the restart, the machine
status icon changes to red. When the machine has restarted and the new settings
have been enabled, the status icon changes to green.

From the File menu, select Exit to close Network Card Setup.
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APPENDIX A - MENU SYSTEM

The top-level function menus are:
Reports

Paper setup

Address book

Phone book

Profile

Network scan destination
Store document settings
View information

Easy setup

Admin setup

AirPrint

Wireless Setting (MC342dw, MC362w, MC562w, MC562dw, ES5462dw MFP,
MPS2731mc only)

> Enabling Wired Communications (MC342dw, MC362w, MC562w, MC562dw,
ES5462dw MFP, MPS2731mc only. Only when wireless is enabled.)

The menu trees are given to the lowest menu item level. Typically, this can be a parameter
that can be set by selecting from a range of values provided or a command that can be
executed to display or print a status or setting value.

V VVV VYV VYV VYV YV YV
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REPORTS

ITEM OPTION OPTION/DESCRIPTION
Configuration Yes, No Prints out a report of the machine’s
configuration
System File List Yes, No Prints out a file list
Demo Page 01:DEMO1 Yes, No Prints a
Demonstration page
Error Log Yes, No Prints out an error log
Scan To Log Enter the Admin Yes, No Print the execution
Password result of ScanToE-
mail,
ScanToNetworkPC or
ScanToUSBMemory.
MFP Usage Yes, No Prints a full report of the machine usage.
Network Yes, No Prints out a report of the Network
Information configuration
Fax@ Speed Dial List Enter the Admin Yes, No Prints the list of fax
Password numbers registered
for speed dials.
Group List Enter the Admin Yes, No Prints the list of fax
Password numbers registered
under groups.
Fax Tx/Rx Log Enter the Admin Yes, No Prints the list of the
Password communication
results for the latest
100 fax jobs
received or sent.
Fcode Box List Yes, No Prints the list of fcode boxes.

E-mail/Internet Fax | Journal Report Enter the Admin Yes, No Prints the results of
Password the latest 50
Internet Fax jobs.
Address Book Enter the Admin Yes, No Prints the registered
Password address list.
Print PCL Font List Yes, No Prints the list of PCL font samples.
PSE Font List Yes, No Prints the list of PostScript font samples.
PPR Font List Yes, No Prints the list of IBM PPR font samples.
FX Font List Yes, No Prints the list of EPSON FX font samples.
Color Tuning Yes, No Prints a color tuning pattern for adjusting
Pattern gradation characteristics.
Color Profile List Yes, No Prints the list of color profiles.

a. MC342dn, MC342dw, MC362dn, MC362w, MC562dn, MC562w, MC562dw, ES5462 MFP, ES5462dw
MFP and MPS2731mc only.
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PAPER SETUP

ITEM OPTION OPTION/DESCRIPTION
Tray 1 Paper Size A4/A5/A6/B5/ Sets paper in Tray 1.
Letter/Legall3/
Legal13.5/Legall14/
Executive/
16K(184x260mm)/
16K(195x270mm)/
16K(197x273mm)/
Hagaki/Custom
Custom Width: Enter paper width and length.
100~210~216mm
Length:
148~297~356mm
Media Type Plain/Letter Head/ Select the type of media loaded in this tray.
Bond/Recycled/ This will help the MFP to adjust its internal
Card Stock/Rough/ operating parameters, such as engine
Glossy/User Typel/ speed and fusing temperature, to better
User Type2/User accommodate the media to be fed. For
Type3/User Type4/ example, letterhead may benefit from a
User Type5 slightly lower fusing temperature to ensure
that its ink does not offset.
Media Weight Light/Medium Light/ | Adjusts the MFP for the weight of paper
Medium/Heavy/ stock loaded in this tray.
Ultra Heavy1
Tray od Paper Size A4/A5/B5/Letter/ Sets paper in Tray 2.
Legall3/Legall13.5/
Legal14/Executive/
16K(184x260mm)/
16K(195x270mm)/
16K(197x273mm)/
Custom
Custom Width: Enter paper width and length.
148~210~216mm
Length:
210~297~356mm
Media Type Plain/Letter Head/ Select the type of media loaded in this tray.
Bond/Recycled/ This will help the MFP to adjust its internal
Card Stock/Rough/ operating parameters, such as engine
Glossy/User Typel/ speed and fusing temperature, to better
User Type2/User accommodate the media to be fed. For
Type3/User Type4d/ example, letterhead may benefit from a
User Type5 slightly lower fusing temperature to ensure
that its ink does not offset.
Media Weight Light/Medium Light/ | Adjusts the MFP for the weight of paper

Medium/Heavy/
Ultra Heavy1l

stock loaded in this tray.

d. MC352dn and MC362dn and MC362w and MC562dn and MC562w and MC562dw and ES5462 MFP and
ES5462dw MFP and MPS2731mc only.
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ITEM

MP Tray

OPTION

Paper Size

A4/A5/A6/B5/
Letter/Legall13/
Legal13.5/Legall14/
Executive/
16K(184x260mm)/
16K(195x270mm)/
16K(197x273mm)/
Custom/COM-9
Envelope/COM-10
Envelope/Monarch
Envelope/DL
Envelope/C5
Envelope/Hagaki/
Oufukuhagaki/
Nagagata #3/
Nagagata #4/
Yougata #3/

Futo A4/Index Card

OPTION/DESCRIPTION

Select the size of paper to be fed from the
multi purpose tray.

Custom

Width:
64~210~216mm

Length:
127~297~1321mm

Enter paper width and length.

Media Type

Plain/Letter Head/
Labels/Bond/
Recycled/Card
Stock/Rough/
Glossy/User Typel/
User Type2/User
Type3/User Type4/
User Type5

Select the type of media to be fed from the
multi purpose tray so that the MFP can
adjust its internal parameters to better
accommodate the selected type of media.

Media Weight

Light/Medium Light/
Medium/Heavy/
Ultra Heavy1/Ultra
Heavy2

Select the media weight to be fed from the
multi purpose tray.

Select Tray

Fax@

Tray 1:

ON/OFF/ON(Prior) Fax: Set tray for

Tray 29:

received Fax.

ON/OFF/ON(Prior) Tray usage, priority

MP Tray:

given to trays set to
ON(Prior), then ON.
If tray is set to OFF,
it will not be used.

ON/OFF/ON(Prior)

Copy

Tray 1:

ON/OFF/ON(Prior) | Copy: Set tray for

Tray 29

copy jobs.

ON/OFF/ON(Prior) | 1¢ 1oy Selection is

MP Tray:

set to “Auto”: Tray
usage, priority
given to trays set to
ON, then ON(Prior).
If tray is set to OFF,
it will not be used.

ON/OFF/ON(Prior)

Duplex Last Page

Always Print/Skip Blank Page

When the last page is only one side, Setting
whether to print on both sides.

Always Print: Always print on both sides.

Skip Blank Page: Printed on one side of the
page to the last page odd job.

a. MC342dn, MC342dw, MC362dn, MC362w, MC562dn, MC562w, MC562dw, ES5462 MFP, ES5462dw MFP
and MPS2731mc only.
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ADDRESS BOOK

ITEM

E-mail Address

OPTION

OPTION/DESCRIPTION

Select an address number.
Max. 100 entries.

Register

Name

user defined

Enter a name for the E-mail address entry.
Max. 16 characters.

E-mail
Address

user defined

Enter the E-mail address.
Max. 80 characters.

Group No.

Add to a registered group.

Edit

Edit settings. Refer to options above for
details.

Delete

Yes, No

Delete entry.

Sort By Name

Sort list of entries by name.

Sort By Number

Sort list of entries by number.

Search

E-mail Group

Select a group number.
Max. 20 group entries.

Register

Name

user defined

Enter a name for the E-mail group entry.
Max. 16 characters.

Address No.

Select and assign addresses from resultant
list.

Max. 100 entries can be register to a
group.

Edit

Edit settings. Refer to options above for
details.

Delete

Yes, No

Delete entry.

Sort By Name

Sort list of entries by name.

Sort By Number

Sort list of entries by number.

Search
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PHONE BOOK

NOTE

MC342dn, MC342dw, MC362dn, MC362w, MC562dn, MC562w, MC562dw,
ES5462 MFP, ES5462dw MFP and MPS2731mc only.

ITEM

Speed Dial

OPTION

OPTION/DESCRIPTION

Select a speed dial number.
Max. 100 speed dial entries.

Register

Name

user defined

Enter a name for the speed dial entry.
Max. 24 characters.

Fax
Number

user defined

Enter the fax number for the speed dial
entry.

Max. 40 digits.

Group No.

Add to a registered group.

Edit

Edit settings. Refer to options above for
details.

Delete

Yes, No

Delete entry.

Sort By Name

Sort list of entries by name.

Sort By Number

Sort list of entries by number.

Search

Group No.

Select a group number.
Max. 20 group entries.

Register

Name

user defined

Enter a name for the group dial entry.
Max. 16 characters.

Speed Dial

Select and assign speed dial entries from
resultant list.

Max. 100 entries can be register to a
group.

Edit

Edit settings. Refer to options above for
details.

Delete

Yes, No

Delete entry.

Sort By Name

Sort list of entries by name.

Sort By Number

Sort list of entries by number.

Search
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PROFILE

ITEM OPTION VALUE/DESCRIPTION
No. Select a profile number.
Register | Profile Name user defined Sets a profile name.

Max. 16 characters.

Protocol CIFS, FTP, HTTP Selects a protocol to use for storing files.

Target URL user defined Sets a server address and a directory to store the
scanned data.
Max. 144 characters.

Port No. 1 ~ 445 ~65535 Sets a port number.

PASV Mode ON, OFF Sets whether to use the FTP Passive mode.
Display condition: Protocol set to FTP.

User Name user defined Sets a user name to use for logging onto the
server.
Max. 32 characters.

Password user defined Sets a password to use when logging onto the

server.
Max. 32 characters.

CIFS Character
Set

UTF-16, Shift-JIS

Sets a character set to use in CIFS.

Display condition: CIFS

is set as a protocol.

Encode
Communication

None

Selects an encryption method for communication.
Not available when using CIFS protocol. Choices
vary depending on the protocol selected.

Scan Size

A4, A5, A6, B5,
Letter, Legal 13,
Legal 13.5, Legal 14,
Executive

Selects a scan size.
Note: A6 duplex scan is

not supported.

Image Settings

Density

3~0~+3

Sets the density of
images.

Document Type

Text, Text&Photo,
Photo, Photo
(Glossy)

Sets the image quality.

Background Removal

OFF, 1,2,3,4,5,6

Sets the default setup of
the background removal.

Resolution 75dpi, 100dpi, Selects a resolution.
150dpi, 200dpi,
300dpi, 400dpi,
600dpi
Contrast -3~0~+3 Sets the contrast.
Hue -3~0~+3 Sets the red-green color
balance.
Saturation -3~0n~+3 Sets the color saturation.
RGB R:-3~ 0~ 43 Sets the RGB contrast.
G:-:3~0~ +3
B:-3~ 0~ +3

R:[0], G:[0], B:[0]
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ITEM OPTION VALUE/DESCRIPTION
Register | File Name user defined Sets a file name. Max. 64 characters.
(cont.) The following options can be set as the default file
name:
#n: adding a serial number from 00000 to 99999
#d: adding the date of a file creation
(yymmddhhmmss)
Greyscale OFF, ON Select ON to print in grayscale.
File Format Color PDF, TIFF, JPEG, XPS | Sets a file format for
scanning.
Mono (Greyscale) PDF, TIFF, JPEG, XPS
Mono (Binary) PDF, TIFF, XPS
Encrypted PDF Not Encrypt Encryption disabled.
Encrypt Low, Medium, High Set encryption level.
Also enable/disable
document open and
permissions passwords.
Compression Rate | Color High, Medium, Low Sets a compression rate
for scanning.
Mono (Greyscale) High, Medium, Low
Mono (Binary) High, Medium, Raw
Edge Erase OFF Sets whether to erase the
edge shadow created in
the surrounding of 2-page
spread documents.
ON Width: Sets an erasing width.
5 mm Range: 5 to 50 mm.
Edit Edit profile settings. Refer to options above for
details.
Delete | Yes, No Delete profile.
Sort By Sort list of entries by name.
Name
Sort By Sort list of entries by number.
Number
Search
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NETWORK SCAN DESTINATION

ITEM OPTION OPTION/DESCRIPTION
No. Select a destination number.
Register | Destination user defined Sets a destination name.
Max. 16 characters.
Destination user defined Sets a destination address.
Address Max. 64 characters.
Port No. 9968 Sets a port number.
Available range: 1 to 65535.

Edit | Destination

Edit destination name.

Destination Address

Edit destination address.

Port No.

Edit port no.

Delete | Yes, No

Deletes destination.

Sort By Name

Sort list of entries by name.

Sort By Number

Sort list of entries by number.

Search

STORE DOCUMENT SETTINGS

OPTION OPTION/DESCRIPTION
Store Fcode Bulletin Over Write Stores documents in a bulletin box.
Board
Delete Fcode Bulletin Board Deletes accumulated documents.
Print Fcode Box Prints accumulated documents.
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VIEW INFORMATION

ITEM

System Information

OPTION

Serial No.
Asset No.

Lot No.

CU Version

PU Version
Scanner Version
Panel Version
Total Memory
Flash Memory

SD Memory Card?

OPTION/DESCRIPTION

Displays system information

Network

IPv4 AddressP
Subnet MaskP

Gateway AddressP
MAC Address

NIC Program Version
IPv6 Address (Local)®

IPv6 Address (Global)©

Displays network information

Network Network
(MC342dw, MC362w, | Information
MC562w, MC562dw,
ES5462dw MFP,
MPS2731mc only)

Network Connection

IPv4 Address

Subnet Mask

Gateway Address

MAC Address

NIC Program Version

IPv6 Address (Local)

IPv6 Address (Global)

Displays network information

Wireless
Information

Firmware Version

Serial No.

SSID

Security

State

Band

Channel

RSSI

Displays wireless information

[State]: Not appear when [Network
Connection] = [Wired].

[Band]: Not appear when [State] =
[Connected].

[RSSI]: Not appear when [State] =
[Connected].

a. MC562dn, MC562w, MC562dw, ES5462 MFP, ES5462dw MFP and MPS2731mc only.

b. Appears only when the “TCP/IP” setting is "Enable” and the “IP Version” setting is “IPv4”.

c. Appears only when the “TCP/IP” setting is "Enable” and the “IP Version” setting is “IPv6".
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EASY SETUP

NOTE

The Easy Setup menu is blocked by the Admin password.

ITEM

Date/Time Setting

OPTION

user defined

OPTION/DESCRIPTION

Using the arrow keys, select your time zone,
in relation to GMT, from the list. Press OK to
continue.

Not Summer
Time
Now Summer
Time

Manual Day Using the keypad
Month and arrow keys,
v enter the correct

€ar date and time.

Hour
Minute
Second

Server Set Address of SNTP | user defined

Server (Primary)

Set SNTP Server
(Secondary)

Fax Setting®

Fax Number

user defined

Using the keypad and on screen options,
enter the fax number of this machine.

Sender ID user defined Using the arrow keys and on screen
keyboard, enter the sender ID.
Network Setting Manual IP Address Specifies whether IP address allocation is
Auto automatic (DHCP) or manually assigned.

Display condition: TCP/IP protocol must be
enabled.

Subnet Mask

Current assigned subnet mask.

To change, enter the address using the
keypad. Press OK to register new address.
Display condition: TCP/IP protocol must be
enabled.

Default Gateway

Current assigned gateway address.
To change, proceed as above.

Display condition: TCP/IP protocol must be
enabled.

DNS Server Current assigned DNS server (primary).
(Primary)

DNS Server Current assigned DNS server (secondary).
(Secondary)

WINS Server
(Primary)

Current assigned WINS server (primary).

WINS Server
(Secondary)

Current assigned WINS server (secondary).
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ITEM OPTION OPTION/DESCRIPTION

E-mail Setting Set IP Address of | user defined Enter the IP address of the mail server.
Mail Server
From user defined Enter the sender’s address

Receive Settings POP3/SMTP/

Disable
No Authentication Set the
authentication
SMTP Auth User Name method.
Password

POP Before SMTP | Set Address of User Name
POP3 Server

Password

a. MC342dn, MC342dw, MC362dn, MC362w, MC562dn, MC562w, MC562dw, ES5462 MFP, ES5462dw
MFP and MPS2731mc only.
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ADMIN SETUP

NOTE

The Admin Setup option is blocked by a password.

ITEM OPTION
Copy Setup | Default
Settings

VALUE/DESCRIPTION

Scan size A4, A5, A6, B5, Allows you to select
Letter, Legal 13, the document size.
Legal 13.5, Legal 14,
Executive

Duplex Copy OFF(Simplex), Turns the duplex (2-
Simplex -> Duplex LE, | sided) function off or
Simplex -> Duplex SE, | on.
Duplex -> Duplex, Note: A6 duplex copy
Duplex LE -> Simplex, | s not supported.
Duplex SE -> Simplex

Zoom Auto, 100%, Allows you to scale the
Zoom (25-400%), copy using the presets
A4->A5(70%), values or by scaling in
Legl14->Let(78%), 1% increments up to
Leg13.5->Let(81%), | 400% and down to O
Leg13->Let(84%), by entering the value
A4->B5(86%), using the keypad.
A4->Let(94%),
Let->A4(97%),
Fit to page(98%),
B5->A4(115%),
A5->A4(141%)

Sort ON, OFF ON prints 1 entire
copy/set of the
multiple copy
document at a time
(e.g. pages
1,2,3,1,2,3,1,2,3,...)
OFF batch prints the
multiple copy
document page by
page (e.g. pages
1,1,1,2,2,2,3,3,3,..)

Image Density -3~0n~ 43 Allows you to edit the

Settings image settings.

Document Text, Text&Photo,

Type Photo, Photo
(Glossy)

Scan Normal, Extra Fine

Resolution

Background OFF, 1,2,3,4,5,6

Removal

Contrast -3~0n~+3

Hue -3~0n~+3

Saturation -3~0n~+3

RGB -3~0n~+3
R:0/G:0/B:0

Direction Portrait, Landscape Selects the default

page orientation.
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ITEM

Copy Setup
(cont.)

OPTION

Default
Settings
(cont.)

ID Card Copy

VALUE/DESCRIPTION

ON, OFF

Allows you to set ID
card copying as the
default copy mode.

Note: place the ID
card 5mm from the
edge of the scanner
flatbed.

Continuous Scan

ON, OFF

Allows you to continue
scanning more
documents. Allows you
to construct a single
scan job from multiple
individual sheets or
originals.

Mixed Size

ON, OFF

Allows you to load
originals of same

width but different
length in the ADF.

The following
document sizes can be
set concurrently; A3
and A4 LEF, B4 and B5
LEF, A4SEF and A5
LEF.

When enabled, the
tray setting is
automatic, you cannot
specify a tray
manually.

Margin

ON, OFF

Allows you to change
the document top and
left margin areas.

Input range: -25 to
+25mm.

Edge Erase

ON, OFF

Allows you to block out
the peripheral areas of
the document where
spurious shadows and
borders may arise
when copying with the
document cover open
(such as with books
and magazines) or for
other purposes.

Input range: 5 to
50mm.
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ITEM

Fax Setup?

OPTION

Default
Settings

Resolution

VALUE/DESCRIPTION

Normal, Fine,

Extra-Fine, Photo

Allows you to specify
the type of images on
the document.

Density

3~0~+3

Adjust density

Darker: Keep color
intensity and darker
image.

Lighter: Reduce color
intensity and gives
lighter image.

Scan Size

A4, Letter, Legal 13,
Legal 13.5, Legal 14

Allows you to select the
paper size to match the
document size.

Continuous Scan (ADF)

ON, OFF

Allows you to continue
scanning more
documents. Allows you
to construct a single
fax job from multiple
individual sheets or
originals.

Continuous Scan
(Document glass)

ON, OFF

Allows you to continue
scanning more
documents. Allows you
to construct a single
scan job from multiple
individual sheets or
originals.

TTI

ON, OFF

Prints the sender
name on the header of
the transmitted fax.
By default, the name
you specified in
Sender ID is printed.

Transmit Confirmation Report

ON, OFF

Select ON to print a
fax confirmation after
transmission.

Memory Tx

ON, OFF

Select OFF to enable
real time transmission,
i.e. fax transmission
synchronisation with
scanning.

Fcode Box

Register

Confidential Box
Box Name
Sub-Address
Hold Time
I.D.Code

user defined
user defined
00 ~ 31

user defined

Confidential Box:
received data cannot be
printed without entering
ID code (for secret
documents).

You can also enter a Box
Name, Password and
specify the hold time for
your secure box.

Range: 00 - 31

Bulletin Box
Box Name
Sub-Address

user defined
user defined

Bulletin Box: Enable to
transmit/receive
documents to/from
Bulletin.

Edit

Edit settings. Refer to options above for details.

Delete

Yes, No

Delete entry.
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ITEM

Fax Setup?
(cont.)

OPTION

Security
Function

ID Check Tx

VALUE/DESCRIPTION

ON, OFF

Check and match the
last four digits of the
destination fax
numbers with those
registered in the
target. If ON, the MFP
will send only when
they match.

Broadcast Destination

ON, OFF

Fax number
confirmation screen
displays before
sending the fax.

Confirm Dial

ON, OFF

When ON, you will be
asked to re-enter the
destination fax number.

The fax will only be
sent when the two
numbers match.

Other
Settings

Redial Tries

0~ 2~ 9time(s)

Set the number of
redial attempts.

Range: 0 - 9 time(s)

Redial Interval

1 ~ 5 minute(s)

Set the time between
redial attempts.

Range: 1 - 5 minute(s)

Ring Response

1 Ring, 5 seconds,
10 seconds,
15 seconds,

Enter the number of
rings required before
receiving an incoming

20 seconds fax.
Dialling Pause Duration 0~2~10 Enter the pause
second(s) duration required.

Range: 0 - 10 second(s)

Rx Reduc. Rate

Auto, 100%

Select the Rx
reduction rate.

Reduc. Margin

0~ 24 ~ 100 mm

Select the reduction
margin.

Range: 0 - 100 mm

ECM Mode

ON, OFF

Error correction mode
(ECM) automatically
detects and corrects
errors in the fax
transmission process that
are sometimes caused by
telephone line noise.

Prefix

user defined

Enter the require
dialling prefix (if you are
connected via a PBX
then you need to enter
a prefix to obtain an
outside line connection).

Received Time Stamp ON, OFF Set to ON if you want
the time stamp printed
on incoming faxes.

Print Check Message ON, OFF If enabled, when a

transmission error
occurs the error
content is reported.

Appendix A - menu system > 134




ITEM

Fax Setup?
(cont.)

OPTION

Fax Setting

Service Bit

VALUE/DESCRIPTION

ON, OFF

Country Code

International

Select the country in
which the MFP is
situated.

A/R Full Print

ON

Tone For Echo (For
Transmission)

Enable, Disable

It only shows, when
ServiceBit = ON.

Tone For Echo (For Reception)

Enable, Disable

It only shows, when
ServiceBit = ON.

H/Modem Rate (For Tx)

33.6 Kbps,
28.8 Kbps, 14.4 Kbps,
9.6 Kbps, 4.8 Kbps

H/Modem Rate (For Rx)

33.6 Kbps,
28.8 Kbps, 14.4 Kbps,
9.6 Kbps, 4.8 Kbps

Specify modem rate.

Note: If you are using
an IP phone line and
fax Tx/Rx fails, change
the modem rate to
14.4kbps or less.

Attenuator

0~15dB

It only shows, when
ServiceBit = ON.

(The default value is
different for each
country.)

MF Attenuator

0~15dB

It only shows, when
ServiceBit = ON.

(The default value is
different for each
country.)

Pulse Make Ratio

33%, 39%, 40%

Sets the make rate of
DP (10 pps) during call.

It only shows, when
ServiceBit = ON and
Tone/Pulse setting =
PULSE.

(The default value is
different for each
country.)

Pulse Dial Type

N, 10-N, N+1

It only shows, when
ServiceBit = ON.
(The default value is
different for each
country.)

MF(Tone) Duration

75, 85, 100 mseconds

It only shows, when
ServiceBit = ON and
Tone/Pulse setting =
TONE.

(The default value is
different for each
country.)
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ITEM OPTION VALUE/DESCRIPTION
Fax Setup® | Fax Setting | Calling Timer 1~255 second(s) Sets the call connection
(cont.) (cont.) wait time (TO timer).
When the setting value
is 0", the MFP runs at
the initial value of each
country. When any
value other than “0” is
set, the call connection
wait time (TO timer)
can be selected in the
range of 1 to 255 mm.
It only shows, when
ServiceBit = ON.
(The default value is
different for each
country.)
PBX Line ON, OFF
Forwarding Setting ON, OFF
TAD Mode Type 1, Type 2, Type 3 | Specify TAD mode type.
Tel Priority Mode ON, OFF
CNG Detection ON, OFF
T/F Timer Programming 20 seconds,
35 seconds
Soft Ringer Volume OFF, Low, Middle, Select volume level.
High
Remote Receive Number OFF, 000, 111, 222, The left digits can be
333, 444, 555, 666, set.
777, 888, 999
Internet Default Scan Size A4, Letter, Legal 13, Allows you to select the
Fax Setup Settings Legal 13.5, Legal 14 paper size to match the
document size.
Density -3~0~+3 Adjust density
Darker: Keep color
intensity and darker
image.
Lighter: Reduce color
intensity and gives
lighter image.
Resolution Normal, Fine, Allows you to specify

Extra-Fine, Photo

the type of images on
the document.

Background Removal

OFF, 1,2, 3,4,5,6

Allows you to block out
the color background of
the image (assuming
document has a color
background) - such
that the background
color is not printed.

Continuous Scan

ON, OFF

Allows you to continue
scanning more
documents. Allows you to
construct a single fax job
from multiple individual
sheets or originals.

Compression Rate

High, Medium, Low

Select the appropriate
compression level.
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ITEM

Scanner
Setup

OPTION

Default
Settings

Scan Size

VALUE/DESCRIPTION

A4, A5, A6, B5,
Letter, Legal 13,
Legal 13.5, Legal 14,
Executive

Allows you to select
the scan size.

Note: A6 is only
simplex scanning.

Image Settings

Density :

Document Type :

Background Removal :

-3~ 0~ +3

Text, Text&Photo,
Photo, Photo
(Glossy)

OFF, 1,2, 3,4,5,6

Allows you to adjust
image settings.

Resolution : | 75dpi, 100dpi,
150dpi, 200dpi,
300dpi, 400dpi,
600dpi
Contrast: | -3 ~0~ +3
Hue: | -3~0~ +3
Saturation: | -3~ 0~ +3
RGB: | -3~0~ +3
R:0/G:0/B:0
Continuous Scan ON, OFF Allows you to continue
scanning more
documents. Allows you
to construct a single
scan job from multiple
individual sheets or
originals.
Greyscale ON, OFF Select ON to print in
grayscale.
File Format Select the appropriate
Color: | PDF, TIFF, JPEG, xps | file format.
Greyscale: | PDF, TIFF, JPEG, XPS
Mono: | PDF, TIFF, XPS

Encrypted PDF Setting

Document Open Password:
Permissions Password:
Display Default Password:

user defined
user defined
Disable, Enable

Set the encryption
passwords and display
option.

Compression Rate

Color:
Greyscale:
Mono:

High, Medium, Low
High, Medium, Low
High, Medium, Raw

Select the appropriate
compression level.

Edge Erase

ON, OFF

Input range: 5 to
50mm.
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ITEM

Scanner
Setup
(cont.)

OPTION VALUE/DESCRIPTION
E-mail Setup
File Name user defined
Template | Edit Subject Select template from list
Edit Body
From/ | From: user defined
Reply To
Email Sender ID: user defined
Reply To: Select E-mail address
Address Book from the address book.
Direct Input Enter E-mail address
using the on-screen
keyboard.
LDAP | Simple Search Use the on-screen
keyboard to enter a
search value.
Advanced Search Use Advanced Search
Search Method | to search the LDAP
U N address book by user
ser Name | name and/or E-mail
E-mail Address | address.
Broadcast ON, OFF
Destination
MDN ON, OFF
Response
A/R Full ON, OFF
Print
MCF Report ON, OFF Select ON to print a
fax confirmation after
transmission.
Timeout of OFF, 5 minutes,
MCF Report 15 minutes,
30 minutes,
90 minutes,
150 minutes
Print Check ON, OFF If enabled, when a
Message transmission error
occurs the error
content is reported.
usB File Name user defined Max. 64 characters.
Memory #n:Assigns a
Setup consecutive number as

the file name.
#d:Assigns a created
date and time
(YYMMDDHHMMSS
format) as the file name.

TWAIN Setup

Network TWAIN

ON, OFF

Port No. 1~ 9967 ~ 65535 Range: 1 - 65535
WSD Scan WSD Scan Enable/Disable
Setup
Binding Long Edge Bind,
Short Edge Bind
PC Scan Simple Scan Mode,
Mode Manual Scan Mode,
Secure Scan Mode
Scanner Execute Yes, No
Calibration
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ITEM OPTION VALUE/DESCRIPTION

Print From Default Paper Feed Tray 1(A4), Selects the default

USBMemory | Settings Tray 2(A4)9, tray for paper feed,

Setup MP Tray(A4) Tray 1 (upper), Tray 2
(lower, if installed) or
MP Tray (multi purpose
tray).

Copies 1-999 Enter the number of
copies of a document
to be printed.

Duplex ON, OFF Switches the Duplex
(2 sided) function ON/
OFF.

Binding Long Edge Bind, Display condition:

Short Edge Bind duplex setting is
enabled.

Fit ON, OFF Sets the printing mode
that can fit print data
in the printable area.

Print Setup Print Menu Tray Configuration Adjust tray

Paper Feed:

Auto Tray Switch:

Tray Sequence:

Tray 1, Tray 29,
MP Tray

ON, OFF

Down, Up, Paper

configuration settings.

Feed Tray
MP Tray Usage: | When Mismatching,
Do Not Use
Media Check: | Enable, Disable
Print Setup Adjust print setup.
Copies: | 1 -999
Duplex: | ON, OFF
Binding: | Long Edge Bind,
Short Edge Bind
Resolution: | 600dpi,

Toner Save Mode:

Mono-Print Speed:

Orientation:

Lines Per Page:

600x1200dpi,
600dpi M-LEVEL

OFF, Low, Middle,
High

Auto, Color Print
Speed, Normal print
Speed

Portrait, Landscape

5 ~ 64 ~ 128 Line(s)
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ITEM

Print Setup
(cont.)

OPTION

Print Menu
(cont.)

Edit Size:

Width:

Length:

VALUE/DESCRIPTION

Cassette Size, A4,
A5, A6, B5, Letter,
Legal 13, Legal 13.5,
Legal 14, Executive,
16K(184x260mm),
16K(195x270mm),
16K(197x273mm),
Custom,

COM-9 Envelope,
COM-10 Envelope,
Monarch Envelope,
DL Envelope,

C5 Envelope, Hagaki,
Oufukuhagaki,
Nagagata #3,
Nagagata #4,
Yougata #4,

Futo A4,

Index Card

64 ~ 210 ~ 216 mm

127 ~ 297 ~ 1321 mm

Printer Adjust
Manual Timout:

Wait Timeout:

Print Mode Without Color
Toner:

Jam Recovery:

Disable, 30 seconds,
60 seconds

Disable, 5 seconds,
10 seconds,
20 seconds,
30 seconds,
40 seconds,
50 seconds,
60 seconds,
90 seconds,
120 seconds,
150 seconds,
180 seconds,
210 seconds,
240 seconds,
270 seconds,
300 seconds

Alarm, Cancel

Enable, Disable

Adjust general printer
settings.

Paper Black Setting: | -2 ~ 0 ~ +2
Paper Color Setting: | -2 ~ 0 ~ +2
SMR Setting: | -3 ~0~ +3
BG Setting: | -3 ~0~ +3
Print Position Adjust Range: -2.00 to
Front X Adjust: | 0.00 mm +2.00 mm
Front Y Adjust: | 0.00 mm
Back X Adjust: | 0.00 mm
Back Y Adjust: | 0.00 mm
Drum Cleaning ON, OFF Set to produce idling of
a drum before printing
in order to reduce
horizontal white lines.
This shortens image
drum life.
Hex Dump ON, OFF Prints out the data

received from the host
PC in hexidecimal code.
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ITEM

Print Setup
(cont.)

OPTION

Color Menu

Density Control

VALUE/DESCRIPTION

Auto, Manual

If set to Auto, image
density will be
automatically adjusted
at power on, when a
new image drum or
toner cartridge is
installed, and at
intervals of 100, 300
and 500 drum counts.
If a 500 drum count
interval occurs during
a print job it will occur
at the end of that job,
and will take up to 55
seconds. If set to
manual, this
adjustment will only
be performed when
initiated by the next

menu item.

Adjust Density Execute Selecting this will
perform the auto
density set up
immediately.

Color Tuning/Print Pattern Execute Selecting this item
prints the color tuning
pattern to help you
adjust the color
balance.

Cyan Highlight -3~0~+3 Adjusts image density

- for each color

Cyan Mid-Tone -3~0~+3 component (cyan,
magenta, yellow and

Cyan Dark 3~0~+3 black). Normal setting

Magenta Highlight -3~0~+3 is 0.

Magenta Mid-Tone -3~0~+3

Magenta Dark -3~0~+3

Yellow Highlight -3~0~+3

Yellow Mid-Tone -3~0~+3

Yellow Dark -3~0~+3

Black Highlight -3~0~+3

Black Mid-Tone -3~0~ 43

Black Dark -3~0~+43

Cyan Darkness -3~0~+3 Adjusts darkness of
each color (cyan,

Magenta Darkness -3~0~ +3 magenta, ye”ow and
black). N | setti

Yellow Darkness -3~0~+43 isaoc )- Normal setting

Black Darkness -3~0~+43
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ITEM

Print Setup
(cont.)

OPTION

Color Menu
(cont.)

Adjust Registration

VALUE/DESCRIPTION

Execute

Performs automatic
color registration
adjustment. Normally
this is done on power
on and when the top
cover is opened and
then closed. This
process accurately
aligns the cyan,
magenta and yellow
images to the black
image.

Cyan Reg Fine Adj

3~0~+3

Magenta Reg Fine Adj

-3~0~+3

Yellow Reg Fine Adj

-3~0~+3

Performs fine
adjustment of image
timing in relation to
the black image
component.

Ink Simulation

OFF, SWOP,
EUROSCALE, JAPAN

Selects from a range
of industry standard
color swatches.

UCR

Low, Medium, High

Selects the limitation
of the toner layer
thickness.

If paper curl occurs in
dark printing, selecting
Medium or Low
sometimes helps
reduce curl.

CMY100% Density

Enable, Disable

When enabled, black
areas are produced
using 100% C, M, and
Y instead of black. This
results in a glossier
finish.

CMYK Conversion

ON, OFF

Setting to OFF will
simplify the conversion
process of CMYK data,
which will reduce
process time.

This setting is ignored
when Ink Simulation
function is used.

System
Configuration
Menu

Personality

Auto Emulation,
PCL, IBM PPR,
EPSON FX,

PS3 Emulation

This item selects which
industry standard
emulation your MFP
should use. When set
to Auto, incoming data
is examined and the
correct emulation is
automatically selected
each time a print job is
received.

Alarm Release

Manual, Auto

When Manual, non-
critical warnings, such
as requests for a
different paper size, can
be cleared by pressing
the RESET button.
When set to Auto, they
are cleared when the
print job resumes.
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ITEM

Print Setup
(cont.)

OPTION VALUE/DESCRIPTION

System Auto Continue ON, OFF Determines whether or

Configuration not the MFP will

Menu automatically recover

(cont.) from a memory
overflow condition.

Error Report ON, OFF If ON, the MFP will

print error details
when a PostScript
emulation error
occurs.

PCL Setup Font Source Resident, Resident2 | Specifies the location

of the PCL default font.

Font No.

I0 ~ I90

Sets the PCL font
number.

Font Pitch

0.44~10.00~
99.99 CPI

Sets the width of the
PCL default font.

Font Height

4.00~12.00~
999.75 point(s)

Sets the height of the
PCL default font.

Symbol Set

PC-8

PCL symbol set. If the
font source and
number are changed
to one which does not
support the selected
symbol set, this must
be changed to an
available symbol set
for that font.

A4 Print Width

78 Column,
80 Column

Sets the number of
columns subject to
Auto LF with A4 paper
in PCL. This is the
value when Auto CR/
LF Mode is set to OFF
with the 10CPI
character.

White Page Skip

ON, OFF

Selects whether blank
pages are printed or
not.

CR Function

CR, CR+LF

Selects whether a
received carriage
return character (0Dh)
also causes a line
feed.

LF Function

LF, CR+LF

Selects whether a
received line feed
character (0OAh) also
causes a carriage
return.

Print Margin

Normal,
1/5 inch, 1/6 inch

Sets the non-printable
page area. Normal is
PCL compatible.

True Black

ON, OFF

Selects whether black
image data is printed
using black toner (True
Black ON) or 100%
CMY. (Valid in PCL
emulation mode only.)
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ITEM

Print Setup
(cont.)

OPTION

PCL Setup
(cont.)

Pen Width Adjust

VALUE/DESCRIPTION

ON, OFF

The thinnest line width
in PCL, a 1-dot line,
may look broken.

ON: when the thinnest
line width is specified,
line width is
emphasized to look
wider.

OFF: the line appears
as specified.

Tray ID#

Tray 2 :
MP Tray :

1~5n~59
1~4n~59

Sets the number to
specify Tray 2 and MP
Tray for the paper feed
destination command
in PCL5e emulation.

PS Setup

L1 Tray

Type 1, Type 2

Switches between
Postscript types.

SIDM Setup

SIDM Manual ID#

0~2~9

Set up Pn specified in

MANUAL by MANUAL-1
ID No.FX/PPR Emu in

CSF control command
(ESC EM Pn).

SIDM Manual2 ID#

0~3~9

Set up Pn specified
MANUAL by MANUAL-2
ID No.FX/PPR Emu in
CSF control
command(ESC EM Pn).

SIDM MP Tray ID#

0O~a4n~9

Set up Pn specified
TRAYO(MP Tray) by MP
Tray ID No.FX/PPR
Emu in CSF control
command(ESC EM Pn).

SIDM Trayl ID#

0~1~9

Set up Pn specified
TRAY 1by Tray 1 ID
No.FX/PPR Emu in CSF
control command(ESC
EM Pn).

SIDM Tray2 ID#

0~5~9

Set up Pn specified TRAY
2 by Tray 2 ID No.FX/

PPR Emu in CSF control
command (ESC EM Pn).

IBM PPR
Setup

Character Pitch

10 CPI, 12 CPI,
17 CPI, 20 CPI,
Proportional

Specifies character
pitch in IBM PPR
emulation.

Font Condense

12CPI to 20CPI,
12CPI to 12CPI

Specifies 12CPI pitch
for Condense Mode.

Character Set

SET-1, SET-2

Specifies a character set.

Symbol Set

IBM-437

Specifies a symbol set.

Letter O Style

Enable, Disable

Specifies the style that
replaces 9BH with letter
0 and 9DH with a zero

Zero Character

Normal, Slashed

Sets the zero to be
slashed or unslashed.

Line Pitch

6 LPI, 8 LPI

Specifies the line
spacing.
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ITEM

Print Setup
(cont.)

OPTION

IBM PPR
Setup
(cont.)

White Page Skip

VALUE/DESCRIPTION

ON, OFF

Selects whether blank
pages are printed or
not.

CR Function

CR, CR+LF

Selects whether a
received carriage
return character (0Dh)
also causes a line
feed.

LF Function

LF, LF+CR

Selects whether a
received line feed
character (0Ah) also
causes a carriage
return.

Line Length

80 Column,
136 Column

Specifies the number
of characters per line.

Form Length

11 inch, 11.7 inch,

12 inch

Specifies the length of
paper.

TOF Position

0.0 ~ 1.0 inch

Specifies the distance
of print from the top
edge of the paper.

Left Margin

0.0 ~ 1.0 inch

Specifies the distance
of print from the left
hand edge of the
paper.

Fit To Letter

Enable, Disable

Sets the printing mode
that can fit print data,
equivalent to 11 inches
(66 lines), in the LETTER-
size printable area.

Text Height

Same, Diff

Sets the height of a
character.

SAME: Regardless of
CPI, same height

DIFF: As CPI,
character heights vary.

EPSON FX
Setup

Character Pitch

10 CPI, 12 CPI,
17 CPI, 20 CPI,

Specifies character
pitch in this emulation.

Proportional
Character Set SET-1, SET-2 Specifies a character set.
Symbol Set IBM-437 Specifies a symbol set.

Letter O Style

Enable, Disable

Specifies the style that
replaces 9BH with letter
o and 9DH with a zero

Zero Character

Normal, Slashed

Sets the zero to be
slashed or unslashed.

Line Pitch 6 LPI, 8 LPI Specifies the line
spacing.

White Page Skip ON, OFF Selects whether blank
pages are printed or not.

CR Function CR, CR+LF Selects whether a

received carriage
return character (ODh)
also causes a line feed.
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ITEM

Print Setup
(cont.)

OPTION

EPSON FX
Setup
(cont.)

Line Length

VALUE/DESCRIPTION

80 Column,
136 Column

Specifies the number
of characters per line.

Form Length

11 inch, 11.7 inch,
12 inch

Specifies the length of
paper.

TOF Position

0.0 ~ 1.0 inch

Specifies the distance
of print from the top
edge of the paper.

Left Margin

0.0 ~ 1.0 inch

Specifies the distance
of print from the left
hand edge of the
paper.

Fit To Letter

Enable, Disable

Sets the printing mode
that can fit print data,
equivalent to 11
inches (66 lines), in
the LETTER-size
printable area.

Text Height

Same, Diff

Sets the height of a
character.

SAME: Regardless of
CPI, same height

DIFF: As CPI,
character heights vary.

Network
Menu

Network
Setup

Network TCP/IP
Setting

Enable, Disable

Enables or disables
this network protocol.

IP Version

IPv4, IPv4+IPv6

Set up the IP version.

Display condition:
TCP/IP protocol must
be enabled.

NetBEUI

Enable, Disable

Enables or disables
this network protocol.

NetBIOS Over
TCP

Enable, Disable

Enables or disables
this network protocol.
Display condition:
TCP/IP protocol must
be enabled.

NetWare

Enable, Disable

Enables or disables
this network protocol.

EtherTalk

Enable, Disable

Enables or disables
this network protocol.

Frame Type

Auto, 802.2, 802.3,
ETHERNET II, SNAP

Selects the Ethernet
MAC layer frame type.
Display condition:
Netware must be
enabled.

IP Address
Set

Auto, Manual

Specifies whether IP
address allocation is
automatic (DHCP) or
manually assigned.
Display condition:
TCP/IP protocol must
be enabled.
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ITEM

Network
Menu
(cont.)

OPTION

Network
Setup
(cont.)

Network
Setting
(cont.)

IPv4 Address

VALUE/DESCRIPTION

XXX XXX XXX XXX

Current assigned IP
address.

To change, enter the
address using the
numerical keypad.
Press Enter to register
new address.

Display condition:
TCP/IP protocol must
be enabled.

Subnet Mask

XXX XXX XXX XXX

Current assigned
subnet mask. To
change, proceed as
above.

Display condition:
TCP/IP protocol must

be enabled.
Gateway OO XXX XXX XXX Current assigned
Address gateway address. To
change, proceed as
above.
Display condition:
TCP/IP protocol must
be enabled.
DNS Server 0.0.0.0 The IP address of your
(Primary) DNS server (primary).
DNS Server 0.0.0.0 The IP address of your
(Secondary) DNS server (secondary).
WINS Server 0.0.0.0 The IP address of your
(Primary) WINS server (primary).
WINS Server 0.0.0.0 The IP address of your

(Secondary)

WINS server
(secondary).

Web

Enable, Disable

Enables or disables
web config. facility.
Display condition:
TCP/IP protocol must
be enabled.

Telnet

Enable, Disable

Enables or disables
Telnet config. facility.
Display condition:
TCP/IP protocol must
be enabled.

FTP

Enable, Disable

Enables or disables
communication via FTP.
Display condition:
TCP/IP protocol must
be enabled.

IPSec

Enable, Disable

Enable via the web page
or Configuration Tool.

SNMP

Enable, Disable

Enables or disables
SNMP of FTP (TCP/IP
or NetWare).

Display condition:
TCP/IP protocol must
be enabled.
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ITEM

Network
Menu
(cont.)

OPTION

Network
Setup
(cont.)

Network
Setting
(cont.)

Network Scale

VALUE/DESCRIPTION

Normal, Small

Normal: Can work
effectively even when
connected to a HUB
that has a spanning
tree feature. However,
printer start up time
gets longer when
computers are
connected to two or
three small LANSs.

Small: Computers can
cover from two or
three small LANs to a
large LAN, but it may
not work effectively
when it is connected to
a HUB with a spanning
tree feature.

HUB Link Auto Negotiate, Sets the hub linking
Setting 100BASE-TX FULL, method.

100BASE-TX HALF,

10BASE-T FULL,

10BASE-T HALF
TCP ACK Typel, Type2
Network PS- ASCII, RAW Select PostScript data
Protocol format for the network

port.
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ITEM OPTION VALUE/DESCRIPTION

Network Network Wireless Automatic WPS-PBC WPS-PBC is executed.

Menu Setup Setting setup (WPS)
(cont.) (cont.) WPS-PIN WPS-PIN is executed.

(MC342dw, Wireless List of the names of the
MC362w, Network access points found in
MC562w, Selection the search.

MC562dw,
ES5462dw Manual | SSID Input SSID.

MFP, Setup
MPS2731mc Security The security of the

only) wireless LAN function.

WPA-EAP can set only
in Web.

WEP Key Input WEP Key.

This item appears
when the [WEP] is
selected in the
[Security].

WPA WPA-PSK coding
Encryption method

Type This item appears
when the [WPA] or
[WPA2] is selected in
the [Security].

WPA Input Pre Shared Key.

Pre-shared This item appears
Key when the [WPA] or
[WPA2] is selected in
the [Security].

Wireless reconnection Wireless reconnection
is executed.

Enabling Wired Communications This item appears

(MC342dw/MC362w/MC562w/MC562dw/ES5462dw when the Wireless is
MFP/MPS2731mc only) enable.

Factory Defaults Execute Select Yes to reload
the settings present
when the unit was
setup by the
manufacturer.
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ITEM

Network
Menu
(cont.)

OPTION VALUE/DESCRIPTION
Mail Server SMTP Server user defined Set the host name for
Setup the SMTP server.
SMTP Port 1 ~ 25 ~ 65535 Set the port number.
SMTP Encryption None, SMTPS, Select encryption
STARTTLS method.
Receive Setting POP3, SMTP, Disable
POP3 Server user defined Set the IP address or
host name for the
POP3 server.
POP3 Port 1 ~110 ~ 65535 Set the port number.
POP Encryption None, POP3S, Select encryption
STARTTLS method.
Authentication Method None, SMTP, POP Set the authentication
method.
SMTP User ID user defined Set a user ID for the
SMTP server.
SMTP Password user defined Set a password for the
SMTP server.
POP User ID user defined Set a user ID for the
POP3 server.
POP Password user defined Set a password for the
POP3 server.
LDAP Server Setting Edit the LDAP server
Server LDAP Server: | user defined settings.
Setting Port No.: | 1 ~ 389 ~ 65535
Timeout: | 10 ~ 30 ~ 120second(s)
Max. Entries: | 5 - 100 Entries
Search Root: | user defined
Attribute Edit the LDAP search
Name1l: ch attribute if required.
Name2: | sn
Name3: | givenName
E-mail Address: | mail
Additional Filter: | user defined
Authentication Set the authentication
Method: | Anonymous, method for LDAP.
Simple, Digest-MD5,
Secure Protocol
User ID: | user defined Set a user ID and
password for the LDAP
Password: | user defined server.
Displays when
authentication method
is set.
Encryption None, LDAPS, Set the encryption
STARTTLS method.
Secure Domain user defined Domain must be
Protocol registered in the DNS
Server server.
Setting )
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ITEM

Management

OPTION

Default Mode

VALUE/DESCRIPTION

Copy, Scan, Print, Fax*

* MC342dn, MC342dw,
MC362dn, MC362w,
MC562dn, MC562w,
MC562dw, ES5462
MFP, ES5462dw MFP
and MPS2731mc only.

Operation Operation Timeout After 1 ~3~ 10 minutes
Clear
Clear After Job ON, OFF
Sound Key Touch Tone Volume OFF, Low, Middle, High | Select key touch
Control volume level.
Fax Buzzer Volume OFF, Low, Middle, High | Select volume level.
Local USB Menu Default settings listed,
Interface Soft Reset: | Enable, Disable these can be changed
Speed: | 480Mbps, 12 Mbps | I required.
USB PS_Protocol: | ASCII, RAW
Offline Receive: | Enable, Disable
Serial Number: | Enable, Disable
System Access Control PIN, User/Password, Enable access control
Setup Disable to restrict usage to

authorised user only.

User Authentication Method

Local, LDAP,
Secure Protocol

Unit Of Measure

Inch, Millimeter

Select unit of measure.

Date Format

mm/dd/yyyy,
dd/mm/yyyy,
yyyy/mm/dd

Select desired date
format.

Allow All Reports To Print

Enable, Disable

Enable/disable report
printing.

Near Life LED

Enable, Disable

Enable/disable near
life LED.

Near Life Status

Enable, Disable

Enable: Display a
near-life warning.
Disable: Do not
display a near-life
warning.

Address Information Lock
Time Out

1~30~60
minute(s)

Enter time-out
duration.

USB Memory Interface

Enable, Disable

Select disable to turn
off scan to USB
function.

Panel Contrast

-10~0 ~ +10

Adjust the LCD panel
contrast.
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ITEM

Management
(cont.)

OPTION VALUE/DESCRIPTION
Power Save Power Save Time 1 minute, 2 minutes, | Select desired time

3 minutes, interval before
4 minutes, machine enters power
5 minutes, save mode.
10 minutes,
15 minutes,
30 minutes,
60 minutes,
120 minutes

Sleep Time 1 minute, 2 minutes, Select desired time
3 minutes, interval before
4 minutes, machine enters sleep
5 minutes, mode.
10 minutes,
15 minutes,
30 minutes,
60 minutes,
120 minutes

Auto Power Off Time 1 hour, 2 hours, Select desired time
3 hours, 4 hours, interval to turn off the
8 hours, 12 hours, machine's power
18 hours, 24 hours automatically.

Silent Mode ON, OFF Enable/disable silent
mode.

ECO Mode ON, OFF When ON, if the
machine is in power
save mode and you
send a small print job
(1 or 2 pages), the
machine will print the
job without warming
the fuser to the
“normal” operating
temperature
beforehand.

Memory Receive Buffer Size Auto, 0.5 MB, 1 MB, | Specify the size of the
Setup 2 MB, 4 MB, 8 MB buffer you want to use
to receive data.

Resource Save Auto, OFF, 0.5 MB, Specify the size of the

1 MB, 2 MB, 4 MB, buffer you want to use
8 MB for resource saving.
Flash Initialize Execute
Memory
Setup
SD Memory | Initialize Execute
Card Setup
Format Partition PCL
Common
PS
Storage Check File System Execute Making changes will
Maintenance automatically restart
Setup the system.
Erase SD Memory Card Execute Deletion of all data

stored in the SD Card.
Data cannot be
recovered.
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ITEM OPTION VALUE/DESCRIPTION
Management | Storage Initial Lock Enable, Disable Enable/disable initial
(cont.) Maintenance lock.

Setup(cont.)

Encryption Job Limitation Disable, Enable/disable

Setup Encrypted Job Only limitation setting.

Language Initialize Execute Making changes will

Maint Setup automatically restart
the system.

Admin New Password user defined Enter new password.

Password

Enter Password (Verify) user defined Retype your password
when prompted to
verify.

Note: password must
be six characters or
more.

Reset Settings Execute Continuing will
automatically restart
the system.

Job Log Save Job Log Enable, Disable

Setup

Clear Job Log Execute

Print Supplies Report Enable, Disable Indication of frequency

Statistics of consumable
exchange/non
indication is set.

Reset Main Counter Execute Zeros the counter.

Reset Supplies Counter Execute

User Install | Time Zone 00:00 Range: -12:00 to
+12:00 minutes in 15
minute increments.

Set Daylight Saving ON, OFF Enable/disable daylight

saving setting.

Time Setup Auto Setup Set todays date and
SNTP Server (Primary): | user defined time automatically.
SNTP Server (Secondary): | user defined

Manual Setup Enter todays date and
user defined time using the keypad.
defined Use the arrow keys to

user define move between digits.

Power Save Power Save Enable ON, OFF Enable/disable power

save mode.
Sleep ON, OFF Enable/disable sleep

mode.

Auto Power Off

Enable, Auto
Config, Disable

Sets the behavior of
automatic power off.

High Humid Mode

ON, OFF

If moistened paper is
curled significantly
after printing, change
the setting to ON.
Note: Moistened paper
means paper that has
been left in a high-
humidity environment.
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ITEM OPTION

User Install | MF(Tone)/DP(Pulse)
(cont.)

VALUE/DESCRIPTION

Tone, Pulse

Select the appropriate
dialling method for the
region you are in.

Reception Mode

Fax Ready Mode,

Tel/Fax Ready Mode,
Ans/Fax Ready Mode,
Tel Ready Mode, DRD

Specify the reception
mode.

DRD Type

Type 1, Type 2,
Type 3, Type 4

Allows the machine to
detect a distinctive
ring if it has been
enabled on the phone
line.

Dial Tone Detection ON, OFF Enable/disable dial
tone detection.
Busy Tone Detection ON, OFF Enable/disable busy

tone detection.

Monitor Control

OFF, Typel, Type2

OFF=Not to monitor.
Typel=Monitor up to
DIS. Type2=Execute
monitoring during
communication.

Monitor Volume

OFF, Low, Middle,
High

Select Volume OFF,
Low, Middle, High.

TTI TTI1:
Register/ TTI 2:
Edit

! T 3:

user defined

Register/Edit transmit
terminal identification
(TTI) settings.

Standard TTI

TTI1, TTI2, TTI 3

Select default TTI from
the registered list.

TTI Number user defined Enter your fax number.
TTI Calendar Type yyyy/mm/dd, Specify the TTI
mm/dd/yyyy, calendar date format.
dd/mm/yyyy
Super G3° ON, OFF OFF=G3,
ON=SuperG3
Erase Privacy Data Execute Continuing will delete

all settings and
registered data.

a. MC342dn, MC342dw, MC362dn, MC362w, MC562dn, MC562w, MC562dw, ES5462 MFP, ES5462dw MFP and

MPS2731mc only.
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AirPrint & WIRELESS SETTING

ITEM OPTION OPTION/DESCRIPTION
AirPrint Enable/Disable
[Disable] appears when the AirPrint is
disable.
Wireless Automatic WPS-PBC WPS-PBC is executed.
Setting setup
(MC342dw/ (WPS) WPS-PIN WPS-PIN is executed.
MC362w/
MC562w/ Wireless List of the names of the
MC562dw/ Network access points found in
ES5462dw Selection the search.
MFP,
MPS/2731mc Manual SSID Input SSID.
only) Setup . . ) )
Security The security of the wireless LAN function.
WPA-EAP can set only in Web.
WEP Key Input WEP Key.
This item appears when the [WEP] is
selected in the [Security].
WPA WPA-PSK coding method.
Encryption | This item appears when the [WPA] or
Type [WPA2] is selected in the [Security].
WPA Input Pre Shared Key.
Pre-shared | Thijs item appears when the [WPA] or
Key [WPA2] is selected in the [Security].

Wireless reconnection

Wireless reconnection is executed.

Enabling Wired Communications
(MC342dw/MC362w/MC562w/MC562dw/ES5462dw
MFP/MPS2731mc only)

This item appears when the Wireless is
enable.
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